Learn Excel 2019

Table of Contents
Module 1 – Intro to Excel
Intro to Excel........................................................................................................................7
What’s New in Excel 2019 ..................................................................................................8
Course Overview ...............................................................................................................11
Overview of the Excel Window .........................................................................................12
Mouse Features ..................................................................................................................15
Backstage View .................................................................................................................17
Module 2 – Creating Workbooks
Entering Text and Numbers ...............................................................................................18
Creating Basic Formulas ....................................................................................................20
Relative References ...........................................................................................................23
Order of Operations ...........................................................................................................24
Working with Ranges ........................................................................................................26
Module 2 – Practice Exercise ............................................................................................28
Module 3 – Saving Workbooks
Working with the Save and Save As Commands ..............................................................29
File Extensions, Share, Export & Publish Files .................................................................31
Module 3 – Practice Exercise ............................................................................................33
Module 4 – Navigating Workbooks
Opening a File ....................................................................................................................34
Working with Larger Files .................................................................................................36
Freeze Panes Option ..........................................................................................................38
Split Screen Option ............................................................................................................40

Module 4 – Practice Exercise ............................................................................................42
Module 5 – Page Setup & Print Options
Headers and Footers ...........................................................................................................44
Print Tiles ...........................................................................................................................47
Comments ..........................................................................................................................48
Page Setup Options ............................................................................................................50
Fit to Print on One Page .....................................................................................................53
Printing Workbooks ...........................................................................................................55
Module 5 – Practice Exercise ............................................................................................57
Module 6 – Working with Rows, Columns and Cells
Adding and Deleting Rows, Columns and Cells ...............................................................58
Changing Column and Row Widths ..................................................................................61
Module 6 – Practice Exercise ............................................................................................63
Module 7 – Moving Data
Cut, Copy and Paste ...........................................................................................................64
Copying Formulas..............................................................................................................67
Module 7 – Practice Exercise ............................................................................................69
Module 8 – Formulas & Functions
Overview of Formulas .......................................................................................................70
Create Formulas Using Functions – Part 1 ........................................................................71
Create Formulas Using Functions – Part 2 ........................................................................75
Absolute Values .................................................................................................................77
Module 8 – Practice Exercise ............................................................................................79
Module 9 – Working with Sheets
Adding, Deleting and Renaming Sheets ............................................................................80

Additional Sheet Tab Options............................................................................................82
3-Dimensional Formulas ....................................................................................................84
Module 9 – Practice Exercise ............................................................................................86
Module 10 – Formatting Worksheets
Formatting Cells – Part 1 ...................................................................................................97
Formatting Cells – Part 2 ...................................................................................................91
Formatting Numbers ..........................................................................................................93
Borders and Shading ..........................................................................................................97
Format as Table................................................................................................................100
Using Styles .....................................................................................................................102
Using Format Painter .......................................................................................................104
Protecting Sheets ..............................................................................................................106
Fill Handle and Custom Lists ..........................................................................................109
Module 10 – Practice Exercise ........................................................................................112
Module 11 – Charts
Creating Charts ................................................................................................................113
Types of Charts ................................................................................................................117
Editing Charts – Part 1 .....................................................................................................119
Editing Charts – Part 2 .....................................................................................................123
Using Graphics to Enhance Charts ..................................................................................124
Linking Chart Titles .........................................................................................................126
Module 11 – Practice Exercise ........................................................................................127
Module 12 – Working with Names
Creating Range Names ....................................................................................................128
Managing Names .............................................................................................................131

Using Names in Formulas ................................................................................................133
Module 12 – Practice Exercise ........................................................................................135
Module 13 – Sorting and Filtering
Remove Duplicates ..........................................................................................................136
Sort Data ..........................................................................................................................139
Filter Data ........................................................................................................................143
Advanced Filters ..............................................................................................................146
Module 13 – Practice Exercise ........................................................................................148
Module 14 – Outlining and Subtotaling
Creating and Outline ........................................................................................................149
Subtotals...........................................................................................................................151
Module 14 – Practice Exercise ........................................................................................154
Module 15 – Working with Views
Arranging Files ................................................................................................................155
New Window Option .......................................................................................................157
Custom Views ..................................................................................................................158
Module 15 – Practice Exercise ........................................................................................160
Module 16 – Linking Files
Creating Formulas Between Files ...................................................................................161
Working with Links .........................................................................................................164
Consolidating Data...........................................................................................................166
Module 16 – Practice Exercise ........................................................................................168
Module 17 – Advanced Formula Creation
If Statements ....................................................................................................................169
VLOOKUPs .....................................................................................................................172

Data Validation ................................................................................................................175
Formula Auditing .............................................................................................................178
Module 17 – Practice Exercise ........................................................................................180
Module 18 – Pivot Tables
Pivot Tables .....................................................................................................................181
Pivot Charts......................................................................................................................184
Module 18 – Practice Exercise ........................................................................................186
Module 19 – Additional Excel Features
Slicers...............................................................................................................................187
Goal Seeker ......................................................................................................................189
Text to Columns...............................................................................................................190
Watch Window ................................................................................................................191
Customizing Ribbons and Tabs .......................................................................................192
Module 19 – Practice Exercise ........................................................................................194
Module 20 – Shortcuts
Excel Shortcuts Every User Should Know ......................................................................195
Module 21 – Closing
Closing Video ..................................................................................................................199

Learn Excel 2019

Chapter 1 – Intro to Excel
Video: Intro to Excel
Cindy: Hi there. Welcome to Excel 2019. My name is Cindy and I’m going to be your instructor
and help walk you through this series of videos. I wanted to take a few moments and let you
know a little bit about myself and what to expect as you walk through this course.
I’ve actually been teaching Excel for quite a number of years now, over 15, and I teach
everything from the basics all the way to advanced features. So hopefully we’ll be able to get a
lot of this information over to you quickly so that you can get started working on some of your
projects.
If you’re brand new to Excel make sure you watch these in order. If you try to watch them out of
order it may not make much sense to you. And go ahead and watch them again and again if you
need to. I want you to have the concepts down before you move on to the next video.
If you’ve been using Excel for a while hopefully you’ll get some tips, tricks, easier ways to do
things.
Well let’s go ahead and get started and we’re going to go into section two and talk about what’s
new in Excel 2019.
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Video: What’s New in Excel 2019
Cindy: Hey there. Welcome back. We are still in module one where I’m giving you an overview
or an intro to Excel. I want to go ahead in section two here and just talk real quick about what’s
new in Excel 2019. There’s some changes you’ll want to be aware of, especially if you’ve
worked in older versions. The basics always work the same but let’s jump right in and I’ll show
you some of the new features.
Let’s start with one of the newest features in Excel and that has to do with selecting. Now
selecting has always been around but there’s a little twist to it now. Before if we wanted to select
a range we would go ahead and do that, we’d hold Control and maybe get another range, we
could click over here, we can click over here, wherever we want. But if we wanted to, for
example, deselect this one we’d have to click away from it and then start all over again. What
they’ve done now is you have the ability to deselect some of the cells you’ve already selected
without having to start over. So let’s say again I just select this and I hold Control and come over
here and maybe I get this and maybe over here. And now I say I really don’t want these selected.
As long as I’m holding Control I can click and drag through those and they are gone and the
other cells are still selected. That’s a really helpful little feature.
The next feature I want to talk about is the new Accessibility Checker. For people who maybe
can’t see very well or disabled sometimes they can’t see when there are little things that might be
wrong in their spreadsheet and Excel will try to help them out by letting them know where some
of those things are and what to do about them. Let me show you how the Accessibility Checker
works.
For those people that are disabled or possibly visually impaired sometimes if there are weird
things going on on your screen you may not be able to see it very well. Excel has this feature
called the Accessibility Checker which will help look for those things for you and then give you
a real quick one click way to go ahead and fix those things.
One of the things that you’ll see in a moment is if you look at this word Months this is actually in
a combination cells A and B. They’ve merged them together. And someone that’s visually
impaired may not notice that right away. Let’s go ahead and look at the Accessibility Checker.
You will find that under the Review tab and then right here it says Check Accessibility.
It’ll pop up on the righthand side and it’s found a couple of things. Let’s click on the first one
and you’ll see it sees those merged cells we mentioned and it tells me which cells they’re in. now
I could come over here and actually fix it but notice that I can actually the down arrow and then I
can go ahead and unmerge it right from here. So that’s one thing I can do. Now I would have to
go back at this point and actually move it over here if I wanted it to look right.
Now Excel also found something else. Notice it says Default Sheet Names. It doesn’t like the
fact that Sheet 1 is names Sheet 1. For someone who’s visually impaired they might not be able
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to read that very well because it’s small. We can go down and rename this and I can do it right
here and I can call it My Sales Report and that way it’d be much easier for someone to actually
see what’s on that particular sheet. And that’s how the Accessibility Checker works.
Another feature that’s new to Excel 2019 is the Translate feature. The Translate feature enables
you to take selected text and translate it to a different language.
Whichever cell or range of cells I have selected Excel will go ahead and translate it into another
language for me. Let’s say I’d like to know what the word Months looks like in Spanish. As long
as I have that cell selected I can go up to the Review tab, choose the Translate option and you’ll
see the Translator appear on the right. The very first time you do this it will take a minute to load
the translator but then after that it pops up just like this.
Now here’s the word Months I have selected and down here I can pick the language I’d like to
see Months translated into. So you can see that if I wanted Spanish for example I can choose it
right there. You can also do it in reverse. If you happen to have Spanish text out here
somewhere, see how I can flip this and it tells me this word is the Spanish word and this is the
English word. And that’s pretty cool when you want to work with translations and see what
words look like in another language.
Another new feature that Excel has is a new function called Concat. We used to have one called
Concatenate and that would actually merge two cells together in the same cell and that is still
there but it’s going away so I want to show you how this works because it’ll be the same with a
couple of additional new features.
We used to have a feature called Concatenate and what Concatenate would do was take two
cells, like maybe Sara Kling here and merge them together in the same cell. There are times
when you want to do that. Keep in mind if you’re going to sort and filter you do want to keep
these in separate columns, but let’s go ahead and do this.
I’m going to right click on column D and insert a new column there so that we can put our
merged cells in. Now I’m going start with an equal sign because I am writing a formula. I’m
going to put CON and that brings up all the functions that have CON in them. Now here’s the old
one, Concatenate right here. You can see it has a yellow what we call a Yield sign. That means
that that particular function is getting ready to go away soon. This new Concat has actually
replaced it.
What I’m going to do is double click on Concat to stick it in there and the first thing it wants to
know is what’s the first piece of text I want to merge. That would be Sara. I’m going to put my
comma and then it wants to know what the second piece of text is and that would Kling in this
case. And that’s all I want. I’ll go ahead and hit the Enter key and there’s Sara Kling. It’s merged
those two pieces of information together.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019
Now you’ll notice there’s no space in there. In order to get the space I just double clicked so that
we can edit our formula. You want to click after that comma and before the C because you’re
going to add an open quote, a comma, a space, a close quote, and then a comma. That tells Excel
there’s another piece of data in there and the space in there is what I’m looking for. I’ll go ahead
and hit the Enter key and now you can see it’s got the space. I can copy this down and have all of
these.
Now let me go ahead and delete this. The Concat function also has an additional that it will do.
Let’s say that you want to take all of these for example and merge those into one cell. All we’d
have to do is come over here and start with our equal sign. We’ll put our Concat in again and
now what we’ll do is select all of these and hit the Enter key and now you’ll see that it’s actually
put those all in one cell. Now there’s no way you can go back and put the spaces in unless you
manually do it but you’ll see this goes on and on and on forever, especially if you had a long list
like this. So that’s what the Concat feature will do for you.
Those are just a few of the new features that are in Excel 2019. As we go through this series of
videos I’m going to point out some of the other new features and we’ll see how to use those as
well. Let’s go ahead now and jump into section three where I can give you a course overview
and that way you know what to expect as you go through this course.
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Video: Course Overview
Cindy: Hey, this is Cindy. I just wanted to give you a quick overview of what we’re going to be
covering throughout this set of videos.
We’re going to start at the very beginning. I’m not going to assume you know anything. We’re
going to go over the screen itself, get you familiar with terminology, what are some of those
pieces and parts, how those buttons work, and then we’ll jump right in and start creating what we
call an Excel workbook. Sometimes people will call these Excel Sheets and they’re really not
sheets because the sheets are actually in the workbook. The file itself is called the Workbook.
That’s the terminology we’re going to be using.
We’re going to go all the way through. I’m going to show you how to set up a workbook from
scratch, we’re going to talk about how to work with those different sheets, we’ll go through all
the formatting options, how do you print those borders. We’re going to go all the way through
and create some formulas as well. A formula is basically a mathematical calculation that you can
have Excel do and that’s the beauty of working with any kind of spreadsheet or workbook is
being able to do those mathematical calculations.
Let’s go ahead and just jump right in. I’m going to go ahead and start by giving you an overview
of the Excel window first so you’ll know exactly what we’re doing as we move forward. Let’s
move over into section four.
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Video: Overview of the Excel Window
Cindy: Welcome back. We are working in module one and in this module we are getting an
introduction to Excel. We’re all the way down to section four now where I want to give you an
overview of the Excel window. It’s going to be very helpful for you, especially when you get
started if you know where to look for things and some different terminology that we’re going to
use in a lot of these videos. Let’s go ahead and flip over to Excel and I will show you how to get
started.
Let’s go ahead and start at the top left of your screen and we’ll work our way down.
The first thing I want to point out is this whole line right here which is what we call the Quick
Access Toolbar. We’re kind of getting away from the term Toolbar but you’ll notice that we
have one left here in Microsoft Excel and it has a few of the common options that you’re going
to use on a regular basis. Get really familiar with the very first one, that left arrow. That is your
Undo. If you make a mistake you’re going to be able to undo that mistake. You have an arrow to
the right of it which if you click on it will give you a dropdown list of all the things you’ve done.
If you wanted to click at any point on that list you could undo everything from that point up at
the same time. There’s also a Redo. That’s the arrow that points to the right. Redo allows you to
bring back one at a time those things that you have undone.
A couple of other ones just to be aware of. This one is your Save button. If you happen to be
working in this file and you just want to hit the Save button you can do that at any point. Also
there’s a Quick Print option right there which will allow you to just print your file.
You’ll notice there’s a down arrow to the right and this lets you customize your Quick Access
Toolbar because you may have some buttons here that I don’t have and vice versa. You can see
that if you click on one it adds it here or if you uncheck it then it takes it away.
One that I want you to add is the Email button. If you happen to use Outlook for your email you
will love this little feature because what it allows you to do is go ahead and create a message
right from here and attach this file. And we’ll talk more about that in a later module.
The next thing I want to point out is the fact that this whole bar all the way across is what we call
your title bar. You’ll notice that currently it says Book 1 and it lets me know I’m working in
Excel. Book 1 is the name of a blank workbook. When you’re working in Excel and you first
turn it on or you click New you’re working in what we call a blank workbook. Sometimes people
call Excel files Worksheets. They’re not worksheets. They’re workbooks with sheets inside of
them. You’re going to see at the bottom of your screen a Sheet 1. That’s the actual worksheet.
And by clicking the plus sign I can add as many worksheets as I would like at the bottom. But
the file itself is called a Workbook.
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Once you decide to save this file you will give it your own name and it’ll be reflected right here
in the title bar.
Now over on the right you do have your minimize, restore, and close that will let you make the
window smaller or if you wanted to close it you’d be able to do that as well.
The next thing I want to point out across the top are your tabs. You can see that you’re currently
on the Home tab because it looks white but notice you can click any of these tabs to go ahead
and see what’s called the Ribbon below it. When I click on Home, for example, this whole line
across is called the Ribbon and on each Ribbon you will find groups of buttons. This is called the
Clipboard Grouping. Each group name is right here at the bottom.
Most groups, not all, have a little arrow on the bottom right. You’ll notice that each group has
different options. You just click the buttons to get to the options but what if there’s an option
here that falls under that group name and you don’t see it here? That’s when you click the arrow
to get to those additional choices. You’ll find that once you’re in what we call a dialog box you
can go ahead and close it with the X at the top.
If you click the File tab that’ll take you into what we call the Backstage View. We’re going to
look at this over in section six but I just wanted to show you that if you happen to click there hit
the left arrow and that’ll take you back.
Underneath your Ribbon you’re going to see what we call the work area. This is where you’re
going to actually type your text or your numbers or your formulas. You’re going to see that your
work area is divided into columns which go up and down. Your columns are labeled with a letter
at the top. You have 16,384 columns available to use. That’s quite a few columns so you’re not
going to run out of space there.
Now your rows that go across, notice they’re labeled with a number over on the left like this.
You’ve got 1,048,576 rows. You are really not going to run out of room, I promise. And that’s
all on this first sheet, Sheet 1. If you add multiple sheets with this plus sign like I mentioned each
sheet will have the 16,384 columns, the 1,048,576 rows.
The way each sheet is set up you’ll notice that the intersection of a column and a row is what we
call a Cell. And when you click there that cell will have a green line around it. We call that your
Active Cell. That’s how you know which one you’re going to be typing in.
You’ll notice that each cell here has a name. We refer to that name as a Cell Address. A cell’s
address will be the column you’re clicked in and the row you’re clicked in. For example, this one
here would be C3. And you’ll need to reference that when you starting writing formulas. So get
really familiar with that.
You’ll notice on the bottom righthand corner of your active cell is a little box. We call that your
fill handle. Your fill handle will do a couple of different things. It’s going to let you copy
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whatever is in that cell and it’s also going to give you a list of some predefined items. And we’ll
go over some of these in a later section as well.
Like I mentioned, each cell has a name. That name will be reflected right here in the Name box.
You can see when I click over here this is D2 and it says D2 in this name box. And this name
box does more than just tell you the name of the cell you’re clicked in. You’re going to see later
that you can actually select groups of cells, which are called Ranges, and give them names.
The X will allow you to cancel your entry, the checkmark will allow you to accept your entry,
and then we’re going to talk about functions later on in a later module and that’s where you’re
going to go when you want to start writing some of your formulas.
Whatever is in your cell you’re clicked on shows up in the Formula Bar up here. Your cells can
hold three things. They can hold text, numbers or formulas. And a formula is a mathematical
calculation you write to get an answer.
You’re going to notice on the righthand side of your screen that you have a scrollbar so that if
you need to scroll up and down you can. And you also have one at the very bottom of your
screen in case you need to scroll left or right for some reason.
You also have three buttons at the very bottom that are your views. And your views are just
different ways to look at your file. You want to stay in your normal view most of the time but
you’re also going to be using Page Layout from time to time and you’re also going to use what
we call the Page Break Preview from time to time.
I’m going back to normal and the last thing I want to point out is your Zoom at the very bottom
right. You can zoom in to make this a little bit larger or zoom back out to make it a little bit
smaller. And that’s just a view. That’s all that is.
Well that’s a quick overview of how the screen itself works. What I’d like to do now is take a
few moments over in section five and talk to you a little bit about how the mouse works because
you’re going to find that whatever the mouse looks like it will do different things.
Let’s go ahead and move over to section five.
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Video: Mouse Features
Cindy: We’re still in module one and we’re all the way down now to section five. I want to talk
to you a little bit about some of the different features that the mouse has. It’s going to be
important in any program you work in to recognize the different ways the mouse changes what it
looks like but especially in Excel. Let’s go ahead and flip over and I’ll show you the four
different ways your mouse will look in Excel.
There are four different ways your mouse will look when you’re working in Excel and let’s start
with this one. When you see a white cross like you see here you’re going to use that when you’re
trying to select one or more cells. If I click in any cell that’s called selecting a cell. That means
that’s the active cell now, the one you’ll actually be typing in. If I need to select multiple cells
I’m going to place that white cross right in the middle of that cell and drag straight down or
across and that’s called Selecting a Range. We’ll talk about ranges a little bit later but ranges are
basically a group of adjacent cells. If you click away from those you will deselect your range.
The next thing your mouse will look like is these black crosshairs that you see right here. Now I
got that by pointing to the little box in the bottom righthand corner of that active cell. This is
called the Fill Handle. The fill handle actually will do two different things in your computer. The
first thing is there is some lists that are prebuilt in Excel. Those lists are days of the week,
months of the year. If I type any day of the week in this cell, let’s say I put Friday in here and I
drag this down you’ll see it will continue the list for me. I can also go to the right or left and it
will do the same thing. I’m going to go ahead and delete those.
If you have something in a cell that’s not part of one of those predefined lists, and this could be
numbers, text, anything, it will actually copy whatever is in that cell. Let’s say I put the number
32 in there and I drag straight down. Notice it just copies 32. The reason it doesn’t count is it
doesn’t know in what sequence you want to count, and we will talk about how to make it do that
a little bit later but for now just know that the fill handle will copy whatever is in that cell. This is
going to be one of your best friends in Excel. There will be times when you write formulas that
you’ll want to copy that formula and this will just do that for you.
The next thing you’ll notice is that if I point my mouse around the edges of my active cell I get
this white arrow with a little cross behind it. That’s going to allow me to pick up whatever is in
this cell, let’s say I had that 32 in there again, notice I can just point around the edges and I can
drag this information where I’d like it to be and just drop it off and it will move that information
to that new cell.
Those are the different ways that your mouse will actually work in Excel. What I’d like you to
do is pay particular attention as we go along to this and you’ll see that this will make life a lot
easier for you in a lot of different situations.
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Let’s go ahead now and move over to section six and I want to talk to you a little bit about how
that Backstage View works. I will see you in just a few minutes.
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Video: Backstage View
Cindy: Alright we’re still in module one and I want to go ahead and wrap up this particular
module with section six and talk to you a little bit about the Backstage View. The Backstage
View is an area that you can go into where you’ve got a lot of different options like if you
wanted to save this file or if you wanted to create a new one or even if you wanted to go and
change some of the options in Excel you’d be able to do those things in the Backstage View.
Let’s flip over to Excel and I will show you how to get to the Backstage View and all the
options.
When you’re looking at the tabs across the top you’ll notice the very first one says File. By
clicking on File that’s going to take you into what we call the Backstage View. In the Backstage
View you’ll notice it automatically defaults to the Open option. This is where you would go if
you wanted to open an existing file. You will be able to look through these different places here
or browse your computer for that particular file. You would see any workbooks you’ve already
created here. You could actually double click and open one if you’d like or you can look through
the folders and find a file that way.
Back up above Open is the New option. If you wanted to create a brand new workbook you
could come in here and choose the blank workbook or you’d be able to look at some of the
templates that are in Excel and you’ll see there are a lot of different calendars and budgets and
different things like that. They’re great ways to start and that way you don’t have to set the
whole thing up from scratch. They’re templates you can use by typing over the information
there.
You have some Save options that we’ll be talking about over in module three, you have the
ability to print, you can actually Share this file with some other people you’d like, you can
Export this, you can Publish this, or you can Close this file. If you close the file you’re not
closing Excel, just this particular file that you’re working on. There’s also some other options at
the bottom and I want you to notice the one that says Options because that’s where you’re going
to be able to go to change a lot of the options that are in Excel, and we’ll be doing a lot of that in
a later module. But right now I just wanted you to know that if you click the File tab at the top
this throws you into what they call the Backstage View. To get out of it just hit this arrow that
points to the left and you’re back in your workbook.
Well that’s going to wrap up module one and that’s giving you a quick lay of the land here. What
I’d like to do is actually go ahead and get you started on creating some new workbooks. Let’s go
ahead and move over into module two and we’ll get started.
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Module 2 – Creating Workbooks
Video: Entering Text and Numbers
Cindy: Welcome to module two and we’re talking in module two about how to create your
workbooks specifically from scratch. I want to go ahead in this particular section, which is
section one, and talk to you about how to type in text and numbers and get the basic layout of
your spreadsheet ready to go and that way you’ll know how to set something up from scratch.
Let’s go ahead and flip over to Excel and I will show you how to get started.
One of the things that people often say to me is, “I don’t know how to actually get started with a
new blank workbook” and it’s really pretty simple. What you want to do is decide if you want
column headings at the top. The column would just indicate what type of data is below that
particular column. You can also have row headings. That means if you put something here, for
example, it would tell you what’s in the row across. You can have a combination of column
headings and/or row headings or just one or the other. That’s totally up to you.
It doesn’t really matter which row you start on. You do have some area above row one. That’s
called your header area. So don’t feel like you have to start down in row three so you have some
extra space there. I’m just going to start on row one.
Your cells will actually hold three separate items. They will hold text, they will hold numbers,
and they’ll hold what we call formulas. And a formula is basically a mathematical calculation
that tells Excel what to do to give you an answer. You can do super simple math. Like if you
wanted to add some numbers or if you wanted to do some sophisticated analysis, things like that,
you could do that as well. But let’s start really easy and put in some column headings.
I’d like my first column to say the word Months and because I’d now like to type in B1 I’m just
going to hit the Tab key on my keyboard and you’ll see Tab always moves you to the right. Enter
always moves you down.
This column I’m going to put in the word Sales, column C I’ll put in the word Expenses, and in
column D I’ll put in the word Totals. You’ll notice that after Totals I didn’t hit any key on the
keyboard. That’s why you see my insertion point blinking there. And I want to show you that if
you hit this little checkmark that’s just another way to accept the entry.
Let’s say underneath the word Months I want to put some actual months of the year. I want to
put January, February and March and we’ll use the abbreviations. I’ll just put in Jan and if you
remember back in module one I talked to you a little bit about the Fill Handle. That’s the little
box on the bottom righthand corner of your active cell. Remember if you get the black crosshairs
like this that’s called the Fill Handle and you can hold your mouse and drag down until you want
to stop. I want to stop when it says March out to the side and you can it’s filled it in now.
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Let’s say in A6 I want to put the word Totals. You’ll notice that when you type text in the text
lines up to the left side of each of the cells you’ve typed it in. That’s where it lines up by default.
You can change that. And we’ll get into that a little bit later.
Right now I want to put some numbers in underneath my Sales and expenses. I’ll say that
January sales were $150, then I’ll say that February is $175, and we’ll just say it was $225 for
March. I’m going to click over in C2 and put the expenses in. I’m going to say it was $125,
$150, and we’ll say $210 here for March. And you can see I just hit the Enter key to go down in
that particular case.
You’ll notice the numbers are considered generic. There’s no dollar sign, no point-zero-zero,
none of that. You’re going to have to tell Excel what your numbers actually represent. And we’ll
get to that, but for now just know that these are the numbers we’re putting in.
Now let’s say I’ve got the word Totals here and I have the word Totals here. And what I really
meant to do up here was put in the word Profits. Now I could hit Delete on my keyboard to get
rid of that but I really don’t have to. I can type the word Profits right over it and when I enter
I’ve got new text. Just be really careful that you’re typing in the cell you mean to because you
can type over your text accidentally.
The next thing I’d like to do is go ahead and add up these sales so why don’t we go ahead and
flip over to module two and I will show you how to write some super basic formulas in Excel.
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Video: Creating Basic Formulas
Cindy: Now that we know how to actually set up our spreadsheet from scratch, we’ve actually
typed in some numbers and some text, I want to show you how to go ahead and create some
super basic formulas. A formula is a mathematical calculation you use to actually add up
numbers or any kind of math you want to do with the numbers you’ve got. Let me go ahead and
flip over to Excel and we’re going to keep going with our spreadsheet and we’ll add up those
sales and those expenses.
A couple things just to know about formulas. Formulas can be on the same sheet as the data. In a
few minutes we’ll add up our sales and just put the answer right down here. But you may have
the data on this first sheet and want to put your answers over on another sheet. You can certainly
do that. You can also put your formulas in a totally different file, and we’ll be doing some of that
a little bit later as we go along. So formulas can be on the same sheet as the data, on a separate
sheet, or in a separate file.
The thing to remember is wherever you click the mouse that’s where your formula is going to
show up. If I click right here that’s where it’s going to be. If I click over here that’s where it’s
going to be.
There are a couple of keys on the keyboard that you’ll want to be aware of before we start
working because these are going to help you when you’re writing your formulas. I’m going to go
ahead and pop up a picture of my keyboard so you can see it and I’ll point to some of the keys
for you.
First of all if you have a numeric keypad on the right like you see here you’re going to see this
plus sign which is for addition, the minus sign here is for subtraction, you’ve got this little star
which is your multiplication, and the slash is division. So they’re all right together. If you don’t
have your numeric keypad on the right you can find these same buttons right up here. Here’s
your plus, you’ve got your subtraction, your multiplication, and then you’re going to see your
division is right down here.
You also need to be aware of these open and close parenthesis above the nine and the zero. We’ll
be using those. And we’re also going to be using the carrot symbol, which is above your six right
here. So just be aware of those when you’re working because you’re going to be using those to
actually do the math.
The other thing is you’ll notice there’s an equal sign right here. All formulas must start with an
equal sign, no exceptions. If you don’t have the equal sign it will not do the math for you.
All right let’s go ahead and write some formulas. I’m going to leave that up for a few minutes
and I’m going to click over here in B6. I’d like to add my sales and I want the answer to be in
B6. That’s why I’m going to start there.
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Remember I told you that all formulas start with an equal sign. You must type that in.
Now what we’re going to do is basically add the cells that we’d like to actually have Excel add
for us. Now I could type in 150+175+225 and I would get the right answer. The problem is that
if I change the numbers in these cells the answer won’t update. Instead of actually typing the
numbers you’re going to use the cell addresses.
The first one, the 150, is in B3. Notice I can type it but I’m just going to click here and that way
it inserts it in the cell for me. Now I’m going to type my plus sign because I another one I’d like
to add this. I’m going to click in B3 and then I’m going to hit plus again and then I’ll click in B4.
And that’s all I have that I’m going to be adding.
If you happen to have a plus sign at the end like this then you’re going to get an error message.
I’m going to hit the Enter key because I’m finished with this formula and here’s the little error
message I just mentioned. It basically says there was a typo. I had that plus sign at the end and it
thinks this would be the formula I do want. It is so I’ll just say Yes. And you’ll notice now that it
has moved me down to the cell below where I was and I have my answer back up in B6.
Now I’m going to click back in B6 and let’s go look at this formula. I’m just going to double
click in it to get back into it and you can see it took out that plus sign at the end for me.
If you’ve written formulas a little differently then that’s okay. Just kind of bear with us because
we’re building from the ground up so you’ll know why you do what you do. Think about this
too. If you’ve got a thousand numbers you want to add do you want to go +B2+B3 all the way to
a thousand? Probably not. So we’ll learn some other ways to write formulas using what we call
functions or words that tell it what to do. For now I’m going to hit the Enter key so that I have
my answer there.
I can do the same thing over in column C. I’ll just start with the equal sign, I’ll click in C2, hit
the plus sign on my keyboard, C3, hit the plus sign on my keyboard, and then C4. And once I’m
finished I’m going to hit the Enter key and you can see I’ve got the answer of 485.
Something I want you to be aware of. 485 is not what’s in that cell. That’s the result. The
formula that you see right up here is what’s actually in the cell. Same thing over here. You can
see there’s a formula in that particular cell.
Let’s say that I wanted to figure out my profits over here for January. Basically to do that I’m
going to take my sales minus my expenses. All formulas have to start with an equal sign. I’m
going to click on my sales for January and subtract my expenses and just hit the Enter key and
you can see that the answer is 25. I can go down the list and do the same thing with each one of
these. I can take my February sales minus my expenses, I can hit the enter key and I have 25.
And then I’ll do one more. We’ll say in this case that we take our sales for March and subtract
our expenses for March and in this case we get 15.
© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019
And if I wanted to figure out the answer down here I can write the formula the same way I wrote
it there. I’ll go ahead and put my equal sign in, I’ll add D2+D3+D4 and then I’ll go ahead and hit
the Enter key and I have 65.
That’s going to be a quick way to go ahead and write some super basic formulas here so that you
can add and subtract some really basic numbers.
We’re going to go ahead and go now over into section three and I want to talk to you a little bit
in section three about what we call relative references.
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Video: Relative References
Cindy: Hey welcome back. We’re in module two and this is section three, Relative References.
We just got through creating some super basic formulas and one of the things I want to show you
is that the formulas are the exact same when you look at the columns across and they’re the exact
same when you look at the rows down. And I want to give you an idea of what a relative
reference is and how you would make use of that when you’re writing your formulas.
Let’s go ahead and take out the profits for February and March real quick and I want to take out
the totals for column C and D as well. We’ll put them back in. Now let’s go ahead and look at
our cell B6 and examine that formula. I’m going to double click in the middle of it so we can see
it again. And if you notice we’re adding B2, B3 and B4.
Now we don’t have a total here in column C. I can type it. We’ve already figured out we can
write it by hand, but I’d like to use the Fill Handle to copy this. Remember that the Fill Handle is
in the bottom righthand corner of the active cell and one of the things it will do is copy whatever
is in the cell. And we’ve already determined that a formula is there, not 550. I’m going to drag
all the way across to column D and you’ll see there it just gives me all of my totals. I could drag
this as far as I needed to, all the way across. It’s a quick way if you already have the first formula
in to go ahead and copy that formula to the other columns across.
I can do the same thing up here if I want to go up and down. I can drag the Fill Handle and go
down to row four in this case and now I’ve got my answers filled in.
Now let’s talk about relative reference. Remember in this one the formula was B2+B3+B4. If I
go to column C the formula is C2, C3, C4, and the same thing over with column D. What is the
only difference in these three formulas? The column. That’s it. Excel knows that when you copy
a formula across like we did using the Fill Handle to go ahead and change the column so that the
answer is correct.
If we look at the rows up here, let’s look at D2 real quick. That formula said B2-C2. Well the
one below it is the exact the same, it’s just the row is different. See how it references row three
and the one below it would reference row four. Again that’s the relative reference.
There will be times when you don’t want Excel to do that and we’ll learn later how to create
what’s called an Absolute Reference. So just keep in mind that the relative reference is when the
Excel changes the column or row to make sure the formula is correct so you get the correct
answers.
Let’s go ahead and move over into section four and I’m going to talk to you real quick about the
order of operations.
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Video: Order of Operations
Cindy: Hi. Welcome back. We’re in module two and we are now down to section four where I
wanted to talk to you about the order of operations in math. And if you think back to middle
school, maybe around sixth grade or so our teacher taught us the order of operations in math but
most of us don’t remember it and now that we have to use it, well we’re going to have to relearn
it. So let’s go ahead and flip over to Excel and I’ll show you what the order of operations
actually is.
Math of any kind will always follow the order of operations. Excel will look through your
formula and if it sees anything in parenthesis like you see here it will do what’s in parenthesis
first. There’s no exceptions to that. Then it will look for any exponents and that would be if you
had 42 power, for example. Then it will look for any multiplication or division and then addition
or subtraction. I want to go ahead and give you a good example of why you need to write your
formulas keeping this in mind because if you don’t write them correctly your answers will be
wrong and you won’t even know it.
I want to come over here to cell A8 and I’m going to go ahead and put in here April Projections.
What I’d like to do is predict what my April sales are going to be and also what my April
expenses are going to be. There are a lot of ways to do this but let’s say that we want to take our
first month and our last month and just divide by two. That’s all we want to do.
I’m going to go ahead and put my equal sign in here. I’m going to have it add my first month
plus my last month, which in this case happens to be B2+B4 and then whatever that answer is I
want to divide it by two. And that’s all I want to do. I’m going to hit the Enter key and see what
we get.
Now if you notice we got 262.5 and we can look at this very easily and tell that answer is not
correct. But if you’re working with a long list of numbers it’s not always that easy to eyeball it.
Let’s go ahead and examine what Excel did and we’ll see why we got that incorrect answer. I’m
going to double click and open the formula back up.
My first question is do you see any parenthesis in this formula? No. Do you see any exponents?
No. Do you see any multiplication? No. Do you see any division? Yes. The first thing Excel did
was this part right here. It took B4 which is 225 and divided it by 2. The only thing left to do was
add B2. I didn’t want to do that. What I wanted to do was add B2 and B4 together to get an
answer and divide that answer by 2. So if you notice what I’ve done is just enclosed that B2+B4
in parenthesis so that we do that first. And now if I enter notice I get a totally different answer.
When I go back and look at this now if I said are there any parenthesis you can see there are and
it’s going to add my first and last month together, get an answer and divide it by two.
Let me go ahead and just do the expenses again just to show you one more time. I’m going to
start with equals. I know that I want to add my first month and my last month together first so I’ll
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go ahead and enclose that in parenthesis and then I’m going to divide the whole thing by two.
And you can see in this case it’s 167.5.
Now I could practice one more but I’m going to go ahead and use the Fill Handle and copy that
across and now you can see I have all of my answers.
That gives you a quick overview of the order of operations in math. Remember that’s probably
the most important thing about formulas. Always think about is it going to automatically do what
I want first. If not enclose it in parenthesis.
And by the way, if you see a formula that has multiple sets of parenthesis it’s always going to
work from left to right. It’ll add whatever is in the first set, then it’ll do whatever is in the second
set, all the way across. You can also have parenthesis inside of parenthesis, which would look
something like this. That’s called Nested Functions, when you have something like that. It’s
going to do the inner ones first and then go back and do the outer ones all the way across. And
you can have up to ten levels of those. We’ll see some of those as we move along as well. But
that’s your order of operations. Now that you know what that is let’s go ahead and finish up
module two and move over to section five where I’m going to talk to you about working with
ranges.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Working with Ranges
Cindy: We’ve made it all the way down to the end of module two now. This has been the
module about creating workbooks. This is section five and I want to talk to you in this particular
section about working with ranges.
You’re going to do a lot of different things with ranges. And a range is basically a group of
adjacent cells that you might want to change the color in. It could be that you want to make them
all dollars. It could be that you want to use ranges in your formulas. Let me go ahead and flip
over to Excel and I’m going to show you how ranges work.
Let me show you what a range looks like if you had it selected. This right here would be a range.
It is a group of adjacent cells. You can do a lot of different things with a range. It could be that
all of the numbers I have selected here I’d like to maybe make these dollars, for example. It
could be I’d like to center them. It could be I want to cut and move them somewhere else.
There’s a zillion different things you can do with a range.
You’ll notice that if you have a range and you hit the Enter key you stay in the range. The white
cell is just your active cell. You can also use the Tab key to go to the right instead of going up
and down. What you want to avoid if you’re trying to work with a range is don’t use the arrow
keys on your keyboard because notice it deselects the range or if you just happen to click your
mouse somewhere that would deselect your range as well.
Let me show you how to select a range. You’re going to find the starting cell, put your mouse
right in the middle of it, you want to make sure you have that white cross, and hold your mouse
down and click and drag. Just make sure you let up at the ending cell.
Now sometimes when you do that, especially if you have a lot of cells you’re trying to select you
might be holding the mouse down and accidentally go way down the page or way up the page
and it may not get you exactly what you want. So here’s another way to select a range. Click in
the cell you’d like to start with, hold the Shift key on your keyboard and click inside the cell
you’d like to end with. That’s a good way to always get exactly what you want.
Now when you start writing formulas you’re going to have to use these ranges. If you saw this
one written as an example this would be cell B2 through C4. So it would look like this. It would
say B2, colon, and then C4. That’s the range you would be working with in this particular case.
You’d be maybe adding these up, for example.
Let me go back and select that same range real quick. What if I asked you to quickly tell me
what these numbers add up to be? You might be able to quickly add this in your head but here’s
what I want to show you. When you start working with formulas and using ranges in formulas
you’re going to have to have a word in front of this B2:C4 to tell it what to do because right now
it knows the range but it doesn’t know what to do with the range. If you have a range selected,
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and remember that can even be two cells as long as they’re adjacent to each other. If you look
down at the bottom of your screen it tells me the sum equals 1,035. I don’t know if you can see
that down there or not. But that’s an example of a function or a word that we’re going to use in
our formulas later to tell it what to do.
If I wanted to right click on this word Sum here you’re going to see there are six what they
consider to be the most common and I could click on any of these to turn them on or off. So if I
frequently wanted to see any of them I could have them show up down here at the bottom just as
a quick look.
Now notice if I deselect you don’t see that down there at all.
Well that’s going to go ahead and wrap up our section on working with ranges. Let’s go ahead
now and move over into module three because we need to talk about saving this work. We’ve
done a lot to it and I’d hate to lose it. So let’s go ahead and go over into module three and talk
about saving.
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Video: Module 2 – Practice Exercise
Cindy: Now that we’ve completed module two, Creating Workbooks, I’ve got a quick exercise
I’m going to have you do and it’s going to end up looking like this. I’ll have the steps actually in
a Word doc so that you can actually go through the steps one at a time.
The first thing I’m going to have you do is start with a new blank workbook, then I’m going to
have you set it up this way where you have the month, sales, expenses across the top this way in
row 1 and column A is going to have the first few months of the year. I want you to plug in these
same numbers. Now the only numbers I want you to plug in are these because these numbers,
these and these are formulas. What you’ll end up doing over in D2 is you’ll end up creating a
formula that takes your sales minus your expenses to give you the profit. And then you can copy
that formula down using your Fill Handle.
Down on row 6 we’re going to be creating a formula that adds all of your sales and then one for
your expenses and your profits. And then row 8 you’re going to figure out April’s projected
numbers using the order of operations that we talked about in section four.
When you’re done with that just make sure you know how to select ranges. You can just practice
with a few of them. And I’ll put a few in there that you can use to practice with in your Word
doc. And that’s all I want you to do. Don’t close it because we’re going to use the same file over
in module three and then you’ll be saving it there. Good luck.
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Module 3 – Saving Workbooks
Video: Working with the Save and Save As Commands
Cindy: We’re working our way down and we’re all the way all the way now on module three,
which is where we’re going to talk about saving your workbooks. Once you create that new file
you’re going to want to go ahead and save it so that you don’t lose any of that information. We
also wrote some formulas and we really don’t want to lose those. After we save our work we can
always hit the Save button whenever we want to go ahead and update that and save all of our
work. Let’s go ahead and save that particular file we’ve been working on so that we can find it
next time we want to use it.
Anywhere in the computer that you’re working on a file that you’d like to save you’re going to
see there are two options. There’s going to be a Save and a Save As. The very first time you’re
saving the file it’s going to take you to the Save As window so that you can name the file and
also tell in this case Excel where you’d like to save that file. If I’d already saved it once and I
make any changes to that file I’ll want to hit the Save option frequently to update my work. If I
forget to do that and I go to close Excel it will ask me would I like to save my changes. Make
sure you say Yes because the first time you say No you’ll wish you had done that.
Now my first clue that this has not been saved is notice the name of the file is Book 1. Chances
are if I had saved it I would have given it some name that would help me remember what’s in
this particular file.
You’ll notice that when you’re looking at your toolbar here you do have a Save button right here
but you could also go through your File tab which takes you into the Backstage View and you’ll
be able to save here and you’ll have different formats you can save your file in as well.
You’ll notice on this list here’s your Save and your Save As. I’m going to choose the Save As
option in this case.
The first thing you’ll notice is that it will show you any recent folders that you have been
working in or any files and you’ll see them listed here. This is our first one so we don’t see
anything listed here.
The next choice we get is to save this to OneDrive. Now let me tell you what this is. You might
have noticed that everything is going out to the Cloud now and that basically means that instead
of saving your work on a hard drive or somewhere on your computer or a flash drive people are
opting to save those out in the Cloud, out on the internet somewhere so they can pull them up
whenever they have access to the internet.
Microsoft has something called OneDrive. It’s free. You just sign up for it, you get a username
and password and that way you can save your files there and if you go on vacation somewhere
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around the world you can log into the internet and then be able to pull up your files. It’s just
Microsoft’s version is all it is. If you’ve ever used Google Docs it’s very similar. It’s just
Microsoft’s version. It’s called OneDrive.
You can choose to save this to your PC, which we’re going to do. You could Add a Place which
has to do with adding a network, but let’s talk about Browse for a moment. This is where you’re
going to save most things. You’re going to use the Browse option.
Browse allows you to look in your computer and find a place you’d like to save your file. If you
decide, for example, that you’d like to save it in Documents then you can go ahead and give it a
name. Now you’ll want to leave that .xlsx that you see that there. I’m going to call this one My
Sales Report and as long as I know where I’ve saved it then I’ll be able to look for it and find it
very easily the next time. I’m going to hit Save and now you’ll see that my Title bar has changed
to reflect My Sales Report.
Remember if I make any change to this, even just a space Excel is going to ask me if I’d like to
save it when I go to close it. So make sure that you actually do that.
Now after I’ve already made some changes to this if I wanted to hit the Save button up here
frequently I can certainly do that or go back to File and choose Save that way. Either way is
going to work fine. It doesn’t ask you a thing. It just automatically saves your work for you.
Let me go back to File for a moment and I want you to notice that you’re going to have some
other options when you’re saving. You’re going to be able to go down and actually share this.
You’re going to be able to export this. And I want to talk to you about some of those options, but
we’re going to do it over in the second part of this particular section which is where we talk
about file extensions and some other things you can do when you’re saving your files.
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Video: File Extensions, Share, Export and Publish Files
Cindy: All right. Let’s go ahead and wrap up module three. We’ve been talking about saving our
workbooks in this module. This is section two where I want to get into a couple things. I want to
talk to you about file extensions, how to share, export, and also publish your files.
We already talked about saving your file. If I hit the File tab that’ll take me into the Backstage
View and I went down to Save As. And I want to go ahead and Browse and I’ll browse in
Documents because that’s where we just were. And here’s the file that we just saved, My Sales
Report.
Notice at the end of it it has an extension, .xlsx. This tells the computer this is a Microsoft Excel
file and to open it in any program that’s compatible with Excel. I want you to notice that you do
have other types that you can save your file as and you may need these from time to time. For
example, you might need the one that says CSV, Comma Delimited. Just so you’ll know what
this is, if you’ve ever seen a file that just looks like a line of text and it says Name, comma and
then it says, Address, comma and then the date is underneath and it’s set up that way. That’s
what they call a CSV file. Sometimes when you export data you’ll need to save it in that format
in order to be able to import it into other programs.
Another one that you’ll want to be familiar with is a PDF. If you ever want to save this file so
that no one can actually make changes to it you can save it in a PDF format.
Now let me go ahead and close this because I want to show you that if you look over here you’ve
also got the option to share this. I can actually share this with other people that might be on my
particular SharePoint serve. If the SharePoint server has been set up at your company then there
are other people that might be working on the same file and you can go ahead share this with
them and give them permission to do different things with the file. I can also email this directly
to someone if I’d like.
I can export this. Notice here again is the PDF option that I mentioned a few moments ago. You
can actually create your PDF over here. You’ll end up with the Excel file and the PDF file, both
with the same name.
I can also change the file type if I’d like. And this goes back to some of those we saw in the
dropdown list just a few moments ago, like that CSV file that we mentioned.
And the last one is to publish this. Microsoft has this feature called Power BI and basically what
that is is it’s a place where end users can go in and create their own reports, they can create
dashboards and they don’t need to rely on the IT department to help them set all this stuff up. So
if you want to collaborate on a meeting, for example, this would give you some interactive
visualizations and it’s got some self-service business capabilities and things like that in there so
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that you can set it up all by yourself and maybe have a meeting with someone on the other side
of the world. It’s pretty cool how that works. It’s called Power BI.
Well that’s going to wrap up module three where we’ve been talking about saving and some of
these other options that you can do with your file. Why don’t we go ahead now and move over
into module four and we’re going to talk in this module a lot about working with larger
workbooks and how we can search the file for different things and just basically manage a really
large workbook.
I will see you over in module four.
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Video: Module 3 – Practice Exercise
Cindy: Module three was all about saving workbooks. What I’d like you to do is make sure that
you still have your exercise open from module two and then we’re going to go ahead and save
this. Just go to your File tab and come down and do a Save As. Make sure when you save it that
you create a folder on your desktop and then I want you to give it a name. Call it My Sales
Report.
You also want to make sure that you have the correct file extension. It should be .xlsx.
Go ahead and look over some of the other options we talked about. We talked about sharing a
little bit, we talked about the Export and Publish options and just make sure you’re familiar with
those so that when you need to use them you know where to go to find them.
Once you’re done let’s go ahead and head over to module four and we’ll talk about navigating
workbooks.
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Module 4 – Navigating Workbooks
Video: Opening a File
Cindy: Welcome back. We have made it all the way down now to module four and in this
particular module I want to talk to you about navigating through your different workbooks.
You’ll need to know how to open files and when you get them open how do you work with some
of those larger files and some other options I want to go through with you.
This is section one and in this particular section I want to go ahead and talk to you about how to
open your files in Excel. And if you’re familiar with opening files in other programs it’s going to
be very similar. Let’s go ahead and flip over to Excel and talk about opening a file.
We’re currently working in the file called My Sales Report that we actually created. You do not
have to close one file to open another. You can open as many files as you want at the same time
and flip back and forth. However I do suggest that if you are finished with one that you go ahead
and close it just so you don’t have all these files open.
Here’s how you’re going to open a new file. If you go to the File tab at the top that’s going to
throw you into the Backstage View and you’ll notice the third option down says Open. If you
remember when we were saving a file we talked about all these different places that you could
save a file and opening is really the opposite of saving. You’re going to tell Excel where to look
and then which file you’d like to open.
Over here you’re going to see a list of all the files that you’ve recently opened. If you wanted to
open one of these again you just double click on it here from this list.
I wanted to show you also the little pin that you see over here to the right. If you want to actually
pin this to the list you could just click the little pin and notice it moved it up under these pinned
options. And those are files that will kind of stay at the top of the list for you for easy reference.
Those would be ones that you’d use often.
In this case let’s go ahead and browse. And I’d like to look in Libraries and in this folder called
Documents where I have this Excel folder. And I’m going to open that up and I’ll see all the files
that are in that folder.
I want to go ahead and open a particular file called Loan Workbook. You can either click once
and then go down to the bottom and hit Open right here or you can double click on the file to
open it.
Now I’m going to go ahead and zoom in down at the bottom so that we can see this a little bit
better. This is a file that actually will tell you a little bit of information about the loan that you
have created. You can see the monthly payment is $400.40. And over here you’ve got the
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principle, the interest rate, and the term in months. Any of these can be changed. If you notice
over in F4 where the monthly payment is there is a formula there that basically says if I changed
any of these three numbers go ahead and change my monthly payment. What if I want to borrow
$20,000 instead of $18,000? And then let’s say the interest rate was 5.7%. You can see how each
time I made a change that it affected my monthly payment.
If I look at the bottom of this file there are a couple of sheets here. We’re on a sheet called Terms
of Loan. Any time you’d like to flip to a second sheet you just click the sheet tab at the bottom
and now you’ll see this one breaks out every month of the loan, principle, interest, all the way
across.
Now let me zoom in on this one a little bit as well. It’s kind of small there.
You can see here is your beginning balance, here’s the interest, the principle, and the remaining
balance on this particular loan.
What I wanted you to notice in this exercise is that this $20,000 is the same number, if I flip back
to the Terms of Loan, that we had put in right here. Now someone could have typed that on each
sheet and it would be correct. What they did is they went to the Detail sheet for the five year loan
and they’d put a formula right here. And in this particular case if I double click and open it up
you can see that this formula basically says have this cell match the cell D3 on the sheet called
Terms of Loan. And I want to show you how they did that because it’s really fairly easy.
Any time you want a cell to match another cell this is all you have to do. Remember wherever
you click that’s where the answer is going to be. And I want to hit the equal sign because I’m
writing a formula. I want this cell to equal on the sheet Terms of Loan, and notice as soon as I
clicked there it put that in your formula for you, and then I want it to equal D3. Notice that’s in
the formula. That’s all you do. Hit the Enter key and that’s done and now they’re linked.
Let me try that one more time and show you how that works. I’m just going to delete this. I’m
going to start with the equal sign. I’m going to flip to the Terms of Loan because that’s the sheet
that has the cell on it I want to equal, and then I’m going to click in the cell that I want it to
equal, which is D3. And that’s it. I’m going to hit the Enter key on the keyboard. That takes me
back to the cell I was originally clicked in and if I double click there there’s that formula that has
the name of the sheet and the name of the cell.
When you’re looking at a formula and you see and exclamation point like you see in this one that
just tells Excel to change from a sheet tab to a cell. That’s all that is.
I want to go ahead now and show you a little bit about how to work with some of these larger
files like you see here. Why don’t we go ahead and flip over to section two and we’ll talk a little
bit about working with larger files.
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Video: Working with Larger Files
Cindy: Welcome back. We are working in module four and this is the module where I’m talking
to you a little bit about how to navigate through your different workbooks. This is section two
and I want to talk to you in this section a little bit about how to work with the larger files that you
have. A lot of your files will be pretty small and you’ll be able to find what you’re looking for
pretty quickly, but you will have some that have lots and lots of data in them and you need to
know how to navigate and find different things you might be looking for in that particular file.
Let’s go ahead and flip over to Excel and I’ll show you how to work with those larger files.
You’ll notice in this exercise that I can’t see all of the information on the initial screen. I need a
way to actually go up and down and see the rest of the information. The easiest way to do this is
to use the scrollbar that’s on the righthand side of your screen. All you have to do is click on it
and then you’ll be able to scroll up or down to see the data that you couldn’t see initially.
Some of you may have a wheel on your mouse. Now if you do use that wheel and just scroll it up
or down that way.
If you wanted to scroll left or right you have a scrollbar at the bottom here and that’s going to let
you go left or right and see data you couldn’t see in the opposite direction there.
The next way you’re going to be able to move around is to use some of the keys on your
keyboard that will take you to the top or bottom of your data. I want you to look for the Home
key and to the End key. Look over in your numeric keypad. If you look at the number seven
you’ll see Home underneath. And if you look at the number one you’ll see End underneath. If
you’re going to use those you want to turn off the number locks so they become the Home and
End buttons. Other than that they mean the number one and then number seven.
If you notice I’m actually at the top of my screen already. I’m in A1 so I’d like to go to the
bottom of this little table of data. If I hold down Control on my keyboard and hit the End key
notice I’ll go to the bottom of that table of data there. Control-End always takes you to the end
and Control-Home always takes you to the top.
If you use the Home and End key without the Control key Home isn’t going to take you
anywhere because it means the beginning of the line you’re clicked on. End will take you to the
end of the line you’re clicked on. So just know that you have those keys available if you want to
actually use those.
Another way to navigate is to actually type in the name box right here the name of the cell that
you’d like to go to. Now obviously you’d have to know that. But let’s say I type in here column
IV and I want to go to row 65,536. And I’m going to hit the Enter key and now look where it’s
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taken me. All the way down here. I’d like now to go back to the very top so all I have to do here
is type in A1 and hit the Enter key and now I’m back to the very top.
Anywhere you happen to be down in your workbook if you want to go to the top again you just
hit A1 and hit the Enter key and then you’ll be back at the top there.
Some other things you can do to search throughout your workbook is under your Home tab right
here if you go all the way to the end you’re going to see an option that says Find and Select. This
is going to allow you to find certain words or maybe some numbers that might be in your
workbook that you just can’t seem to find if you scroll. Let’s say I’m looking for the number 60.
I’m going to choose Find from this dropdown. I’m going to make sure I have the number 60 in
here and I’m going to choose Find Next. You’ll notice it found the number 60 for me right there.
If that’s not the instance I’m looking for I’m just going to hit Find Next again and it will go find
the next one. It’s always based on where your mouse is clicked. If it can’t find an exact match for
you it will let you know and give you a little message saying that it can’t find anything.
Now I want you to notice there’s also some options here. If you want to look specifically within
the whole workbook, for example, instead of just the sheet you’re on you could change that. It
could be that you want to search by rows or columns or you can have it look in formulas, values,
or comments. Values is basically the number that results from the formula. And we haven’t
talked about comments yet but you have the ability to actually make a comment that shows up on
each particular cell here.
The other thing is if you’re searching for 60 and it doesn’t find it but yet you happen to see it
with your own eyes try checking this box, Match entire cell contents, and see if that helps you
find it a little bit easier.
You also have a Replace tab here. That would let you type in specific text or some numbers if
you wanted and then replace it with something else that you specify here. And you just hit Find
Next and then find the particular instance you want or you can say Replace All of them or just
Replace them one at a time.
I’m going to go ahead and hit Close here and go back up to the top. That’s pretty much how
you’re going to work with your larger files.
Let’s go ahead now and talk about some of the options that you have when you’re working with
these larger files, like the Freeze Panes option, for example. If you wanted to have these
headings stay at the top so that you could scroll anywhere you want down in this file and still see
the headings you could use Freeze Panes. I will see you over in section three shortly.
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Video: Freeze Panes Option
Cindy: We are still working in module four and this is section three and this section is called
Freeze Panes. There is an option in Excel that will let you freeze columns or rows so that you can
keep those on the screen and then scroll down or across, wherever you’d like, and still see the
headings on the columns at the top or if you have row headings on the left you can see them that
way too. Let me show you how the Freeze Panes option works in Excel.
You’ll notice in this exercise if I scroll down then what happens is I don’t see my headings
anymore. So if I asked you which column was the Interest Paid you really wouldn’t know unless
you scrolled back up and you could see. We have the ability to actually freeze rows one through
seven so they stay on the screen all the time and then I can take rows eight and down below and
scroll up anywhere I need to be. Here’s how the Freeze Panes option works.
I’m going to click in A8. Now the reason I’m clicking here is because when you turn on the
Freeze Panes option it’s going to freeze any rows that are above where you clicked and since I
want one through seven to click I’m going to click in eight. It’s also going to freeze any columns
to the left, in case you were trying to scroll left or right. We don’t need that in this particular case
so we’ll just click in A8 and just freeze rows one through seven.
All you have to do is go up to the tab at the top that says View and you’ll see an option here that
says Freeze Panes. Now when you click on it you might get this dropdown list. All you want is
the top option because if you notice this one is just freezing the top row but we want rows one
through seven. And this one is just freezing the first column. So if you just click here it’s rows
above and columns to the left that freeze.
Now you should see a little small faint line under row seven right there. That tells you what’s
above it is frozen. Notice now I can scroll with my mouse anywhere I’d like up or down and
rows one through seven stay right there so I can see my headings. Isn’t that cool?
Now this line is not going to print, just so you’ll know.
If you want to take the Freeze Panes option off you don’t have to be clicked anywhere special.
You just go back to Freeze Panes and now it says Unfreeze Panes.
Now let’s try it where we freeze both up and down and left to right. Let’s say I click in C8. That
means it’s going to freeze one through seven and also A and B.
Now let’s go back up and turn on the Freeze Panes options again. I’m going to choose Freeze
Panes and now you’ll see that same gray line under row seven all the way across but also you’ll
see it to the right of column B there. Notice I can go up and down so I know what my column
headings are but if I needed to go left to right I could also go across. And notice A and B stay.
See that?
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So you can pretty much freeze this and see any two parts of the screen that you would like and
then scroll wherever.
That’s a quick way to freeze panes. Let me go ahead and turn that off. We’ll unfreeze these. And
the next little option I want to talk to you about is called the split screen option. Let’s go ahead
and flip over to section four and I’ll show you how the split screen option works.
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Video: Split Screen Option
Cindy: We’ve been working in module four where we’ve been talking a lot about navigating
through your different workbooks and we’ve looked at a couple of options like the Freeze Panes
we saw over in section three. Let’s go ahead and look now at the option called Split Screen.
What Split Screen basically does is allows you to see something in one part of your file and then
something in another part that you normally wouldn’t be able to see without scrolling back and
forth. Let me go ahead and show you how to use the Split Screen option.
This example is a great exercise because let’s say I want to do something like this. Row 9
happens to be the first month of my loan and if you notice this cell right here shows the interest
I’ve paid, which is $95. I’d like to see how much interest I paid the last month of the loan so I’ll
just scroll down and it’s down in row 68 and it’s $1.81. But now I can’t see the first month of my
loan. I’ve got to scroll back up to see that. Well if I split the screen it will allow me to see both at
the same time.
I’m going to start by clicking in cell A8 because I’m going to put the splitter right above row 8
here. All I have to do is go up here where it says Split. Notice I’m still on the View tab. I’m
going to click on Split and now you’ll see your splitter. It looks like this gray line right here.
Now notice that I can put my mouse on the splitter and move it up or down. That splitter can just
be wherever you want it to be. But what I really wanted you to pay attention to is the fact that
you now have two sets of scrollbars. I’ve got a scrollbar above my splitter and I’ve got a
scrollbar below the splitter. So I can really be in any two sections I’d like at the same time. I’m
going to scroll down a little bit so I can see the last month of my loan and voila, look, here’s
month one and here’s month 60 in this particular case.
If you want to turn the splitter off you can do one of two things. You can either go up and hit
Split again or you can drag the splitter to the top of the screen. That’ll turn it off as well.
Now let’s say I started by clicking in C8. This is going to put the splitter above row 8 but also to
the left of column C. Let me go back up and hit Split again and now you can see the splitter is up
and down right here and then across this way. So this means I can do something very similar. I
can look at row one and scroll down on the second part and look at row 68 in this case, which is
month 60. I can also go left to right. If there’s some reason that I don’t want to see maybe the
first couple of columns there I can scroll to the right like this and notice that column A and B
stayed right where they were.
So really you’ve got a lot of flexibility as far as looking at any two areas of the screen that you
would like when you’re working in Excel.
All I have to do to turn these off is just go back and hit Split up at the top and we are good to go.
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Just make a note that if you save your file with the splitter on or with the Freeze Panes option on
it will stay that way so that when you open the file the next time you’re ready to so.
That’s really all I wanted to tell you about navigating through your workbooks.
This is going to wrap up module four. Why don’t we go ahead and go over to module five where
we’re going to talk about a lot of the page setup and the print options.
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Video: Module 4 – Practice Exercise
Cindy: Now that you’ve gone through module four and you learned how to navigate your
workbooks let’s go ahead and just make sure you’re okay with actually navigating through
workbooks on your own.
I want you to start off by opening a file called Loan Workbook and once you get it open I want
you to just pay attention to the fact that you have two sheets at the bottom. You have a sheet
called Terms of Loan and also one called the Detail Sheet for the Five Year Loan. The sheet
Terms of Loan is where you’re going to be able to list your principle amount, your interest rate,
and your term in months and that will change the monthly payment if you change any of this.
Over on the Details Sheet for the Five Year Loan what we’re looking at here is each month of
the loan and then a list broken our by beginning principle balance, you’ve got the interest paid,
the principle paid, and the remaining principle amount.
Once you’ve looked through this I want you to take a few minutes and navigate. Navigate all the
way to the bottom of this. The last column and last row that information is in is in F70 and then
you can navigate back to the top. Just get really familiar with navigating whether you use the
scrollbar, whether you use your keyboard it doesn’t really matter as long as you know how to get
around.
Once you’ve done that what we want to do is make this cell right here which is C9 equal on the
sheet Terms of Loan whatever is in D3. You’re going to have to write a formula to do that.
Remember that the formula starts on the Detail Sheet right here in C9 because that’s where you
want the answer to appear. You’re going to write a formula that links C9 back to Terms of Loan
D3.
If you forget how to do that go back and watch section two again. That’s where we had written
the formula to link these two sheets.
Once you’re finished with that go back to the Detail Sheet for the Five Year Loan and I want you
to freeze rows one through seven at the top so that you can scroll down and see all the months of
your loan without your headers disappearing.
You can go ahead and take the freeze off once you’ve done that. Then I want you to go ahead
and click in cell A8 and put your split option on. Remember the split option is the one that will
allow you to see parts of your screen at once. I want you to be able to see the first month of your
loan, which is row 9, and the last month of your loan at the same time on your screen.
Once you’ve been able to do that you can go ahead and take the split off and then if you want to
close the file feel free to do so.
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That’s going to wrap up module four, Navigating Workbooks. Once you’re done go ahead and
move over to module five and we’re going to talk about the page setup and the print options in
Excel.
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Module 5 – Page Setup & Print Options
Video: Headers and Footers
Cindy: We are now in module five and in this particular module we’re going to talk a lot about
what we call the Page Setup and Print options. There are a lot of options that you’re going to
want to do with your page. For example, you might want a header and footer. Those actually
appear in the margin areas of your workbook. You’re also going to want to maybe make some
comments, maybe go ahead and print this out and you want it to fit on the page and look nice.
And that’s all the stuff we’re going to talk about in this particular module.
This is section one and we’re going to go ahead and get started with what we call Headers and
Footers.
You’re going to see that headers appear in the top margin of your worksheet. Footers appear in
the bottom margin of your worksheet. You can put things in your header or footer like dates, if
you want to put file names, maybe your name. anything you want you can put in there. You can’t
tell right now if you have a header or footer set up because you can’t see the margins. If you go
down to the bottom where your views are the middle view is called Page Layout. And if you
click on Page Layout then you can actually see what the entire page is going to look like when
you actually print it.
You can now see that there is a header setup here and if you look at the bottom of the page
there’s a footer setup here as well. And typically what Excel will do is it will actually pull the file
name and put it in the center of the header and it will pull the actual page number and put it in
the center of the footer. You can change any of this that you want. You can go in and type
whatever you want on the left section, the center section, or the right section. And the same thing
down with your footer.
Something to note. When you type something in a header or footer it’s going to be on every
page. You’ll notice this is page one and it’s got the name of the file there and if I scroll down I’ll
see Page 1 in the footer. And if I look at page two it’s got the exact same header and it’ll have
the same footer except the page number will change and that’s because there’s a little coding that
you can set up to have it do that. If you had a third, fourth, or fifth page and you add those then
you would have the same exact thing.
Now there’s a different way to go in and look at these headers or footers and I’m going to flip
back to the normal view for a moment. That’s the first view at the bottom. And one thing you’ll
notice is when you’ve been into that Page Layout view and you come out you’ll see a page break
right here. That’s just automatic.
If you go up to your Insert tab and go all the way to the right you’re going to see right over here
it says Header & Footer. Now when you click on it first it looks like you’re back in the same
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view but what I want you to notice is that you now have some options for your header and footer
right here that you didn’t have just clicking on the Page Layout View. Notice you’re in a
contextual tab and that’s a tab that appears only when you need it. And in this case it’s Header &
Footer Tools. Notice if I click down on the page I don’t have that tab anymore. But if I click
back in the header or footer it’ll pop back up. So don’t think it’s gone if you happen to be clicked
in the middle of the page and it’s gone.
There are some things here I want to point out to you. The first thing I want to point out is that
you have some options up here to put in page numbers, the number of pages, the date, the time,
file name. You can kind of see all those options right there.
Let’s put in a few things in our header. Let’s go ahead and take out this center section. We’ll just
delete it totally. And then let’s put over here the actual current date. You can type a date, which
is fine, and that means it will always have that date. But if you use this one here where it says
Current Date that means that today it will have today’s date, tomorrow the file will have that
date, the next date it will have that date. So it’s a way of changing the date and always keeping it
in sync with whatever day it happens to be.
Now I put a little space in there and I also want to put in the current time. And you can see it’s
just some coding that tells it what to do here.
Now I’m going to hit the Tab key to go to the center and I’ll Tab once more. I could just click
over there if I wanted to.
Let’s say over here that what we want to do is go ahead and put in our name. Now let’s go down
and look and notice if the second page has that same information and you can see that it does
right here.
Now let’s talk about the footer a little bit. I’ll click down here where it says Page 1. I can
certainly leave that there but let me go back up and pull up the Header & Footer Tools again and
I want you to notice that I can go ahead and say Page 1 and if I want to I can put a space and say
Of and then have it put in the number of pages. And that way it’ll say Page 1 of 1 or Page 1 of 2,
however many pages there happens to be. I’m going to go ahead and click over here and look at
it and now you’ll see it says Page 1 of 2 and page two says Page 2 of 2.
All right. Let me go ahead and click back in the header or footer again and pull up my Header &
Footer Tools. Let’s go all the way back to left where it says Header right here. These are just
some predesigned headers that I could pick from if I really didn’t want to customize this myself.
Let’s say, for example, that I wanted to put over here the name of the file and also the page
number. So you can see what it did right there is the file name and the page number. It overwrote
what I manually typed in.
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Now the other thing you can do is in the footer section you can do the same thing. You can have
something like Prepared By, the date and the page number. Now if you notice now it’s got
Prepared By and then it’s got the date and it’s also got the page number here. And that’s going to
be the same on page two.
Remember if you type it then it’s going to be on every page like that. If you actually go in and
use some of the coding for page numbers and time and so forth then it will update those page
numbers and the time.
Notice I can also put a picture in here if I wanted to. And I can also navigate a little bit. If I don’t
want to click on the footer I can say Go To Footer and it will actually take me to the footer of the
page.
Now one thing that you’re going to find when you go to print multiple pages. Some people think
that it’s not professional for a page one to say Page 1 on the bottom so you can actually take that
off. You’ll see right here it says Different First Page. And all that does is when you check the
box page one is not going to have a header or footer but all the other pages will. See how page
two has the header and the footer? Let me go back.
The other thing is you can have different odd and even. If you want all the odd pages to say the
same thing and all the even pages to say the same thing you can set that up as well. And you can
also align your page margins with the actual margins of the page if you wanted to do that.
So there’s a lot of different things you can do with headers and footers here. If you want to get
out of it you just go ahead and click inside your spreadsheet somewhere and then go back to the
bottom to the first button which is Normal and then that’s how you work with your headers and
footers.
Let’s go ahead now and go over into section two and we’ll talk about print titles and how those
work.
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Video: Print Titles
Cindy: Welcome back. We’re working in module five and this particular module we’re looking
at all of the page setup and print options that are in Excel. We’ve already gone through headers
and footers in section one. Now we’re in section two where I want to talk to you a little bit about
print titles.
You’re going to have spreadsheets you want to print that have multiple pages. The first page may
have the titles of your column headings but then your other pages don’t have any headings. You
can actually set Excel up so that those headings print on every page. Let me show you how to set
up your print titles.
When we look at this exercise you’ll notice that rows four through seven actually have column
headings at the top. But if you look at the second page you’re going to see there are no column
headings. Let me go back down to the Page Layout view for just a moment so you can see what
I’m talking about. Here’s page one with your column headings but notice page two does not have
any. So if you printed this out you really wouldn’t know which each of the columns represented.
I want to show you how to get it to print those four rows at the top of every page that prints out.
Let me go back to the Normal view and let’s go ahead and go over to the tab that says Page
Layout. Now we’re going to be talking about all these different options here in this module but
right now I want to go over to where it says Print Titles.
What you want to do is where it says Rows to Repeat at Top you want to click there and then
come back in your spreadsheet here and select rows four, five, six, and seven. You’re going to do
that by clicking on the actual row heading itself over here and you can see that it put that right
here for you. Let’s go ahead and Print Preview from here and see what it looks like.
Now this has taken us into the Print Option that we’re going to talk about later, but I wanted you
to notice here’s page one with the headings and to see page two you go all the way down to the
bottom where you see the arrow that says Next Page and then here’s page two. See the headings?
And if you added additional pages they would just have the headings automatically. To get out of
this I’m going to go back and hit the Back arrow there and that takes me back into my normal
view.
You can also print columns on every page. If you had a really long document from left to right
that you’re going to print. And the way you would do that is you would go back to Print Titles
but this time you would say Columns to Repeat at Left and then you would select those columns
that you wanted to be on every page that prints out. But more likely you’re going to use the rows
to repeat option.
That’s really all there is to working with your print titles. Let’s go ahead now and go over into
section three and we will talk about working with comments.
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Video: Comments
Cindy: We are working our way down through module five. We’ve talked about headers and
footers already, we’ve talked about working with print titles. Now I’d like to talk to you a little
bit about working with the Comment feature that Excel has.
You have the ability to click on any cell and actually put a comment in. And it’s not going to be
part of the actual spreadsheet that prints out. It’s just going to be a comment that you can see on
the screen. I want to go ahead and show you how to set some of those up and then if you wanted
to print those out you could do that do that as well.
You can have a comment on any cell that you’d like. All you have to do is select that cell and
then insert your comment. Let’s say that this is the interest paid and this is month eleven on the
loan and we’d like to make a comment at this particular cell that says to ask the bank about a
reduction in the interest rate. All I have to do is right click and you’ll see Insert Comment on the
list.
Now you’ll notice that I can type anything I want in here and it has the name of the person who
is logged into the computer. If you don’t want that there you can always just delete it but I’m
going to go ahead and put in here “See about a rate reduction.” And I’ll say, “This may change
the rest of the interest paid cells.” Now if I click away from the comment you’re going to see that
the comment disappears but there’s a red indicator on the top right corner of that cell. If I just
move the mouse over it I don’t even have to click. You’ll see that particular comment appears.
When I move away from it it disappears.
If I want to edit that comment I’m going to select that same cell, right click, and then you’ll see it
says Edit Comment. And that will take me back in so I can make some changes.
The other thing while I’m in here is you’ll notice that you’ve got these squares around the edges.
If you need to put your mouse on one of these and make the comment box a little bit bigger or
you need to make it smaller or change the size of it in some way you can certainly do that just by
dragging those different what we call sizing handles.
I can also right click on that cell and actually delete the comment if I don’t want it anymore.
Now let’s go ahead and go up to our tabs across the top and I want to click on the tab that says
Review. These are where the comment options are going this way and there’s your Edit
Comment, we’ve seen how to do that. Here’s a way to delete. But let’s talk about these two real
quick.
You have the ability if you’ve got multiple comments to actually just move from one comment to
another just by hitting the Next or Previous buttons.
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You can also show or hide your comments. And you can see when I click on that then the
comment appears and it stays there instead of moving away when I click away from the cell. I
can also show all the comments. So if I have multiple comments I would just see them all over
the page here.
A couple things that you’re going to want to do. You may want to actually print these comments
and I want to show you how to actually do that.
If you go back to the Page Layout tab, and we were talking about the Page Setup options earlier,
notice that if you go right here to this little arrow that this is going to take us into Page Setup.
And earlier we were in here under the Sheet tab. What I want to show you is under that same tab
you have this Comments option right here and it currently says None. If I choose the down arrow
I can choose to put these at the end of the sheet or my other option was as displayed on sheet. Let
me show you what end of sheet looks like. And I’ll Print Preview and what you’re going to see is
that if you go down to the last page you actually have a third page now. See how there’s three
pages? And what it does is on that last page it tells you the cell number and then it just shows
you what the comment says. Now let me go back and I’m going to show you the other option.
I’m back under the Page Layout tab, Page Setup, I’m going to hit the arrow on the right there, go
over to the Sheet tab. This time instead of at the end of the sheet I’ll say As Displayed on Sheet
and then Print Preview that. And now if you go down and look you’ll see wherever the comment
happens to be that’s where you’re going to see it. And it’s going to actually print just like this.
Now let me hit the Back button and show you one more thing.
You’ll notice that you can’t see the numbers that are underneath this. All you have to do is click
in there and instead of using the sizing handles this time get just on the border of your object
there and just drag it somewhere off to the side and that way you can see all the numbers that
were underneath and it does have this arrow that points to the cell that that particular comment
refers to.
That’s going to be how your comments work. That’s a pretty nice feature that Excel has where
you can make comments about individual cells. Let’s go ahead now and go over to section four
and we’re going to look at all of those different Page Setup options and get you familiar with
them.
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Video: Page Setup Options
Cindy: We are working our way down through module five where we’ve been talking about all
the page setup and print options that Excel has. We’ve talked to you now about headers and
footers a little bit, we’ve talked about your print titles, your comments, but there are so many
other page setup options there that I just want to take a few moments and look through some of
those and get you familiar with what’s there so you’ll know where to go if you want to do some
of these different things. Let’s go ahead and head over to Excel and let’s look through those page
setup options.
You want to make sure you’re on the Page Layout tab and then we’re going to be looking at all
of these options here. Let’s start with Margins.
Here are predesigned margins that you can pick from and you can see that every page has six
margins. There is a top, bottom, left and right, and header and footer. Notice your header and
footer margins are always less than your top and bottom. If they were more they would actually
appear in the printed part of your page and you don’t want that.
If you don’t like any of these that they have pre-setup for you all you have to do is come to the
very bottom where it says Custom Margins and click there and that’ll take you into this Page
Setup that we ran earlier. Now remember the way to get directly here, you can actually go here to
where it says Page Setup with the little arrow and it’ll take you into this one.
Here’s where you can change your top, bottom, left and right margins again. And something else
that’ll be of interest to you is this Center on Page option. If you have a small spreadsheet you’re
working with and you print it out it’s always going to print in the top left. To make it a little bit
nicer you can center it on the page horizontally. And sometimes you may want to center
something both horizontally and vertically. You can just choose both or none.
I’m going to go ahead and click OK and that’s how the margins option works.
The next one I want to show you is orientation. When you print as you would normally think of
printing something that’s what we call Portrait. If you turn the paper sideways that’s what we
call Landscape. And sometimes you need that when you have a lot of columns left to right that
you want to get on a page.
The next thing is where it says Size. You can always change the paper size. Normally you have
8.5 by 11 inch piece of paper but then there’s legal and there’s envelopes and you can see these
other sizes that you might want to use.
The next one is called the Print area. If you have a certain area that you’re going to want to be
printing and you don’t want it to print the rest of it you can set the print area. And basically what
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would happen here is you would go through and actually select just by dragging down like this
the area that you think you might want to print and then that’s how you would set the print area.
You can also go back and clear the print area and then that way when you get ready to print
you’ll be able to tell it that you want to print a page or something specific that way.
Breaks is where you’re going to put in page breaks or remove page breaks. Now normally what
Excel will do is it knows how much will fit on a page and it will insert a break for you. But if
you want the break somewhere else you can certainly do that yourself. Right now you can see
that it breaks here at row 52 right at the bottom. You want to put manual ones above the ones the
computer generated because you can’t put more on a page physically. You can put less but you
can’t put more. I would actually select one of the rows above the one the computer put in and
then I could go to Breaks and says Insert a Page Break. And then that will actually put a page
break there for me and you can see it there and it got rid of the other one. And do you notice this
one is a straight line where the other one was a green dotted line? That’s how you know the
difference between the ones you put in and the ones the computer put in.
If you want to delete one then go ahead and just select the row above and below and you can go
back to the Breaks and saw Remove Page Break. And so there’s lots of ways to put in page
breaks or remove page breaks that way.
Now let’s talk about Backgrounds for a second. This is really neat.
You have the ability to take a picture that you might have already in your computer somewhere
or you can do a Bing search or you might have one saved on your personal OneDrive. Let’s say
we do a search and we look for Money. What’ll happen is that it’s going to go out to Bing and
it’s actually going to look for any pictures that you have permission to use and then you’re going
to go ahead and choose one and you’re going to say Insert. And now you’ll see the background
of your whole entire spreadsheet here is that picture of money. Now this makes it really hard to
read but that is an option and it does not print by the way. It’s only for viewing on the screen.
Notice you can now delete your background if you wanted to do that.
Now let me scroll back up to the top. We already talked about your print titles so let’s move over
here to where it says Width, Height and Scale. And this is where you’re going to be able to go
ahead and shrink the width of your printout. If you want it to fit, for example, two pages you can
actually change the width of it, you can change the height or you can change the scaling. Now
width and height are automatic but you can go in and say you want to set it to one page, two
pages, or whatever you want to set it to.
Now scaling, it’s actually going to look at your page at 100% and let’s just say one column
wouldn’t print on that page, for example. It would actually shrink it so that you could get
everything on one page. That’s called Scale to Fit.
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Let’s go back over here to Page Setup because I want to go down here to this arrow and see if
there’s any options that we didn’t have buttons for.
On the Page tab here’s our portrait and landscape that we talked about, there’s your scaling we
just mentioned, sometimes if one column prints on another page you might try the Fit To option
to see if it would make everything fit one page across and one page tall. You can change your
paper size here. We already talked about margins and we talked about header and footer and we
talked about a couple of things under the Sheet tab. I did want to mention that you have the
ability to print your gridlines right here. Sometimes people ask me how do you print these lines
around each of the cells and those are your gridlines. But what you really want to do is print
borders not gridlines. Gridlines will print all of them that are on the page.
You can also choose to print this black and white, what they call draft quality, or print the row
and column headings which would be this A-B-C or this 1-2-3 over here.
You can also tell it how you’d like to print the page order. If you have five pages maybe you
want to go down first and then across or across and then back down, whatever works for you.
And that’s going to be your page setup options right there. So you can see there’s quite a few
options there are far as your page setup.
Well let’s go ahead and go over to section five now and I’ll show you how to go ahead and have
everything fit on one page if these options we talked about up here don’t work for you.
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Video: Fit to Print on One Page
Cindy: Hey, we’re still working in module five and in this module we are talking about your
page setup and print options in Excel. We’re all the way down now to section five and I want to
talk to you in this section about how to make everything print on one page because what happens
often is you will set up your workbook and you’ll go to print it and one column prints on a
second page. Let’s talk about how you make it all fit and look really nice when you print it out.
I’ve got this exercise open that has several columns of information. If you notice it has the name
of the sales person over in column A and then it has figures for January through August and the
last column, column J, are the totals here. I want to look at it and see what it looks like if we go
ahead and print it. I’m just going to go to the bottom and go to the Page Layout View, which is
the middle view there, and you’ll see that page one actually prints from the column that says
Name all the way over to the column that says July. But look how it chopped off August and
Totals and it’s going to print it over on this second page. That’s just not going to work for me.
Let’s look at some options that we can do to get everything to fit on one page for us. Let me go
back down to the Normal View and let’s see what we’ve got.
The first though is that you may want to turn the paper from portrait to landscape. If I go back to
the Page Layout tab here at the top then I can change the orientation to landscape. But I will tell
you that we don’t have enough columns to make it actually look right. If I choose landscape let’s
go look at it now. I’m going to go down and do the Page Layout and you can see that I really
have a lot of space left over here and I could do a lot of things to take up that space but this isn’t
really what I wanted in this particular case. Let me go back to Normal and we’re going to change
it back to portrait because that’s what I want.
The second option is I can go up and adjust this scaling right here. Right now it’s set at 100%. I
could go down and make it maybe 75% or 80%. The problem is that I don’t know exactly which
one is going to work, if that’s going to be too small or too large. Let me show you what we can
do and it will actually adjust the scaling for us and get it set up perfectly.
Here’s what we’re going to do. Let’s go down to the bottom where our views are and let’s use
the last view which is your Page Break Preview. I’m just going to click on that and in this
particular view you’re going to see the page break right here. Also notice there’s a page break
right down here underneath the words Canadian Division. All you have to do is actually drag this
dotted line even with the edge of the page and you’ve actually just changed the scaling right
here. And if you notice it made it 90%. Now I wouldn’t know that automatically so it knew that
for me and it went ahead and adjusted it.
If you notice the page break that’s down at the bottom here it’s going to break up that Canadian
Division. Now I could drag this one all the day down to the bottom and fit everything on one
page but I can tell you just from working with this exercise so many times it’s too small. In this
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case I think I’ll just drag it back up above the Canadian Division like that and at least all of
Canada will print together on the same page. And that’s the easiest way to change your page
breaks.
Now obviously if you have a lot of columns left to right that orientation might be the best bet for
you and then this may not work as good as it does right now, but when you’ve only got that
situation with a couple of columns then it works great.
I’m going to go back to the Normal view and now we’ve got two pages and it’s going to print
perfectly.
What I’d like to do now is talk to you a little bit about printing so let’s go ahead and head over to
section six and I will talk to you over there real quick about printing your workbooks.
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Video: Printing Workbooks
Cindy: Okay welcome back. We are in module five and we’re going to wrap it up with section
six where we’ll talk a little bit about printing your workbooks.
When you go to print your workbook you’re not always going to want to print everything that’s
in the workbook. Sometimes you want to print just one sheet, sometimes you want to print just a
particular section on that sheet. I want to go through and show you all the options that you have
when you’re printing your workbooks.
When you get ready to print anything you can go up and use the Print that happens to be here on
your icon bar but if you really want all the choices I suggest you go through the File tab and go
into the Backstage View and print that way.
When you click on the File tab you’re going to see an option that says Print about halfway down
right here. And you’re going to have lots of options when you’re printing.
The first thing I want to point out is this is where your Print Preview is and you’ll be able to go
back and forth between the pages. Down at the very bottom it’ll say Page 1 of 2 in this case and
you can use the arrows to go back and forth to see how it’s going to print.
If you remember all those page setup options that we looked at in section four you can get to
those in here as well. First of all if I happen to click Page Setup right here this screen will look
familiar because we went through all of these options.
A lot of these are in the Page Setup but let me go back through those with you. First of all here’s
your custom scaling. This is where we just went through in section five and talked about getting
it one page and we adjusted the scaling to do that. You can set your custom margins here. We
saw this earlier. And if we didn’t like any of these we could go to the Custom Margins and
change it that way.
The next thing is the paper size. Probably you want 8.5 by 11 but if you wanted to change it then
here’s that option. You can turn the paper from portrait to landscape here.
Now here’s something you haven’t seen yet, collated. Collated basically means that if you
wanted ten copies of this it would print page one, two, one, two, one two, ten times. If it’s
uncollated it’s going to print all of page one, then it’ll print all of page two.
Here you can print one sided or if you have a printer that you can print on both sides you can go
ahead and flip the pages and you can print on both sides that way.
Currently it’s going to print the active sheet. That would be sheet one that we’ve been working
on. And if we wanted to print specific pages only we can specify that right here. So let’s say for
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whatever reason you just want to print page two you would set it up like this. But if you don’t do
that it’s going to print all the pages on that active sheet.
If I drop the list down here I can also print the entire workbook. That means that any sheets that
actually had printing on them it would actually print. I could also print a selection. That would be
let’s say I just want to print Australia and I had selected it before I came in here, then I’d be able
to print just the selection.
The next thing is the printer that you’re going to be printing to and you have all these choices
available. This would be how many copies of this would you like and then when you’re ready
you would actually hit the Print and this would print right out the exact way that you want it.
That’s how printing is going to work.
All of that has to do with your page setup and print options. We’re going to wrap up module five
now and let’s move over to module six where we’re going to talk a lot about adding some rows,
some columns, and cells into some of your existing workbooks. I will see you over in module
six.
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Video: Module 5 – Practice Exercise
Cindy: We’ve actually gone through module five now. We’ve been talking about the page setup
and print options. I have a lot of things I want you to do in this exercise. Again, I’m going to
have these in the Word doc, all the instructions, but here’s what I want you to do.
Go ahead and open that file we’ve been working with called Loan Workbook and I want you to
go to the sheet called the Detail Sheet for the Five Year Loan.
We’re going to look and see if there are any headers or footers. And the way we’re going to do
that is remember at the very bottom your second button is your Page Layout view. And if you
click here you can see that you just have the generic ones that come in Excel. What I want you to
do is take the one that’s in here out, you’re going to add the date on the top right and then go
down to the footer and I’m going to have you in the footer in the center where it says Page 1
currently, put your name there. Once you’ve done that and you see it looks right go ahead and
flip back to Normal view, which is the first view at the bottom.
The next thing I’m going to have you do is add a comment. You’re going to put a comment right
here in C9. And I’ve listed the comment which is “This is the beginning balance of this loan”
over in the Word doc with the instructions.
The next thing you’re going to do is change your margins to one inch for the left and right. I’m
going to have you center this on the page vertically and then set rows four through seven as print
titles so that every time you print a page the titles for rows four through seven will print.
You’re going to go ahead and print the entire workbook and then go ahead save and close the
file.
Great job. You’ve done a lot. Let’s go ahead and move over into module six when you’re done
and we’ll talk about working with rows, columns and cells.
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Module 6 – Working with Rows, Columns and Cells
Video: Adding and Deleting Rows, Columns and Cells
Cindy: We are working now in module six. And in this particular module I want to talk to you a
little bit about how to work with rows, columns and cells in your workbook. This is section one
and in this section I want to talk to you about adding and deleting rows and columns and also
how to add or delete cells. You don’t necessarily need to add columns or rows to have more in
your spreadsheet. What you need to do is add columns or rows in the middle of a table. Let me
show you how all this is going to work.
Let’s take a quick look at the exercise before we start working with our rows and columns. This
is a company called Books and Beyond. You can see that this is the Northeast region on this side
and this is the Mideast region on this side. For each region it looks like they’re tracking the sales
people for that region, it looks like they’re tracking their figures for January through April and
then over here are your totals. And even though this one doesn’t say Totals here that’s what
column G represents.
If you look down at the bottom it looks like they’re actually writing formulas to add up all of
their sales for each month. They’ve also got one for the average right here and the high right
here. And in a later module we’re going to go through and actually write those formulas. But for
now let’s talk about making this look a little bit nicer.
Let’s say that I’d like to put two blank rows at the very top of this. Now remember I don’t have
to do that because we do have a margin area at the top but just for the exercise let’s make it look
a little bit nicer.
The way you’re going to insert rows is you’re going to start off by selecting the number of rows
you’d like to insert. You’re going to select them by clicking on the row heading, which is the
number itself all the way on the left. You’ll see your mouse turns to this black arrow that points
to the right and you just click. If you try to do this that is not a row. That’s X amount of cells. So
make sure you click on the row heading itself.
Now I said I wanted to put two rows in here so I’m going to drag down so I get rows one and
two selected like this.
Now the way you’re going to insert these rows is you’re going to go to the Home tab and if you
go all the way over here where you see the Cells you’ll see this Insert option. When you click the
down arrow you’re going to have several choices as to what you’d like to insert, but one of these
is to Insert Sheet Rows. I’m going to click on that and now you’ll see there are two blank rows at
the very top. The new rows always go above the one or ones you have selected.
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Columns always go to the left of the one or ones you have selected. Let’s say that you like
column G to represent May and you want to push these over into column H. Notice when I select
the G at the top, that’s how I select the entire column. Again, to select multiple columns I could
drag across like this, but I just want one in this case.
Again, I’m going back to that Insert option and this time I’m going to Insert Sheet Columns. And
you can see it pushed everything over to the right and I have a blank column.
Now for both of these inserting rows and/or columns I could have right clicked in the highlighted
area and chosen Insert this way.
If you want to delete a row or column hitting Delete on the keyboard is not going to do it. That
deletes the contents of those cells you have selected. To actually get rid of the row or column
you’re going to have to choose Delete. Now again I can right click and choose Delete, which is
the easiest way to do it but notice there’s also a Delete right next to Insert up here and you can
tell Excel that you’d like to Delete Sheet Columns in this case or if you had rows selected you
would have an option to delete those rows.
Now you know how to insert rows, you know how to insert columns, let’s talk a little bit about
inserting cells.
Let’s say that I’d like to put a new sales person in the Northeastern region and I’d like to put
them on row eight where I see Baker right now. Basically I want to push everything from Baker
down one. I’m going to select row eight and I’m going to right click in the highlighted area and
choose Insert. And now you’ll see that I have a space to put in my new sales person. But if you
look closely notice there’s also a blank row over here. And I didn’t want to do that because I
only want to put the new person over in the Northeast region. This is an example of where you
want to insert cells and not an entire row because a row goes across all the columns.
I’m going to go ahead and select row eight and I’m going to right click and delete it and here’s
how you select cells and then insert them. I’m going to click on Baker, hold the Shift key and
click on 900 here. So that is the range, B8 through G8. Now if I right click in the selected area
and choose Insert it’s going to ask me what would you like to do with the cells you have
selected. I want to shift them down and I’ll click OK and now you can see everything pretty
much moved down one row. But look how it didn’t affect this table over here. That’s how you’re
going to put in individual cells.
Now if I wanted to type someone in here I can go ahead and put that new person in. This would
be Mr. Newberry. He’s going to have 150, 200, 125, and 275. And then if we want to get his
total we can actually use the fill handle and copy it from the one above it and that way we’ve got
his answer.
That’s a quick overview of how to work with adding and deleting rows, columns and cells.
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Now that you know how to add, delete columns, rows and cells let’s talk a little bit about
changing the column/row widths. Let’s go ahead and move over to section two and I’ll show you
how that’s done.
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Video: Changing Column and Row Widths
Cindy: Okay we’re in module six and we’re all the way down now to section two. I want to talk
to you a little bit in this section about how to change your column width and your row width.
What’s going to happen is if you don’t have enough space in a particular column for numbers,
for example, you’re going to end up seeing these little pound symbols. And if you don’t have
enough space as far as the rows go then you might cut off some of the text that’s in a particular
cell. Let me go ahead and show you a little bit about how to change your column and row
widths.
Let’s talk first of all about text. A good example in this exercise is if you look in column A, row
3 this text says Books and Beyond Northeastern Region. You’ll notice it’s all in A3. None of it’s
in B3 because when you click here you’ll see there’s nothing in the formula bar. Text will spill
over to the next cell provided it is empty, like in this particular case. Numbers will not do that.
Now if I happen to type something in B3, for example, notice how it chops off whatever is over
in A3. Now I can make the column a little bit wider so that I can see everything there and I can
do that just by putting my mouse between the headers at the top. See how if your mouse between
the A and the B there you get the double black arrow? And then you can actually drag this as far
as you need it to go in order to see everything that’s in that particular column.
Now you’ll notice in this particular case it made column A really wide so that’s really not going
to work for me in this case, but that’s how you would do that.
I’m going to go ahead and delete that five and I’m going to move this back over a little bit.
Something else you can do is if you know that you need a column to be a little bit wider, instead
of dragging that left or right you can actually double click that line that separates column A and
B and what that will do is look down the entire column, find the widest piece of information and
make your column just that wide, because a lot of times you might make it wide and it looks
great and then you get further down and you need it to be even wider. Sometimes it’ll make a
column smaller. For example, if I look here at February and I come up and get the line that
separates the D and the E, notice it made it a little bit smaller. See that? So you can always work
with your column widths that way.
Now let me go back and just make that smaller again because it’s way too wide.
The other thing I want you to notice is that numbers will not spill over. Let’s say I take, for
example, and I happen to make it a little smaller like this you’ll see that eventually you’re going
to see these little pound symbols like this. And sometimes you’ll only see one in that column
because maybe that one cell only is the one that wasn’t wide enough, but any time you see these
that means that the column is not wide enough. Even if the one to the right of it’s empty like this
it’s still not going to spill over. Only text will spill over. I’m going to undo that.
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All you’d have to do is go ahead and make your column a little bit wider like we talked about.
I’d probably get up on the line that separates column E and F, double click, and now you’ll see
that it’s wide enough.
That’s pretty much all you need to know about changing your column and row widths.
Well that’s going to wrap up module six. Why don’t we go ahead now and move over to module
seven and I want to talk to you a little bit about how to move your data around. We’re going to
do our cut, copy and paste and I’ll also show you how to copy some formulas. Let’s move over
now to module seven.
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Video: Module 6 – Practice Exercise
Cindy: Module six was all about inserting rows, columns and cells. You’re going to start by
opening an exercise called Eastern Regions Report. I’m going to have you adding rows in here.
You’ll be adding a couple of rows at the top. I’m going to have you add some columns. And I’m
going to have you add some cells in here.
Once you get those rows and columns in I’m going to have you delete them just to make sure
you know how to delete a row or column.
You’re also going to insert a range of cells so that you can actually put the new sales person in
the Northeast region right up here.
You’ll have some figures you’ll plug in for the new sales person whose name is Newberry. And
at the end when you get over to column G you’ll be actually creating a formula to figure out Mr.
Newberry’s totals.
When you get done with that if you’re comfortable go ahead and save it and close the file and
you are done with rows, columns and cells.
Why don’t you go ahead now and head over to module seven where we’re going to talk all about
moving your data.
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Module 7 – Moving Data
Video: Cut, Copy and Paste
Cindy: We are all the way down now to module seven and this is the module where I want to
talk to you a little bit about moving your data around. This is section one and I want to go
through cut, copy and paste with you. Cut, copy and paste is a basic that you have to know for
any program you’re working in. It basically is a way for you to take your data from one place
and put it in another place. Sometimes you actually want to move the data. Other times you just
want to make a copy of it somewhere else. Let’s go ahead and run through cut, copy and paste
and then you’ll be an expert in knowing how to move your data.
In this exercise we have Books and Beyond, the Northeast region is on the left, the Mideast
region is on the right. I’d like to do a few things to make the exercise look a little bit nicer. One
of them being I’d like to take the information here and line it up with the edge of the table in
column K and maybe the same thing over here. I’ll take what’s in A3 and move it up to B2.
The easiest way to do this is go ahead and select whatever you’d like to move and you’ll notice
that if I put my mouse around the edges of this cell, which is the active cell, I’ll get a white
arrow. All I have to do now is hold the mouse down and drag it to the cell I’d like to drop it off
in and let go. Pretty easy to do that. Let me do it over here. I’m going to select J3, point around
the edges till I get the white arrow and click and drag over to K2 and drop it off. And now you
can see it looks a little bit nicer like this.
Now we just call that moving. That’s not cut, copy and paste. What I’d like to talk to you about
now is how to actually cut this Mideast region and we’ll place it down below the Northeast
region.
If you cut something you’re actually removing it from where it is and you’re going to put it
somewhere else. If you copy you’re making a copy of that information somewhere else. That’s
the difference.
Now before I show you the four steps we’re going to be working with what we call the Clipboard
and I want to show you how to turn the clipboard on.
If you go over to your Home tab you’ll see a clipboard grouping and there’s an arrow on the
bottom right that you just click on to turn it on and this is called the Clipboard right here.
The way the clipboard works is every time you cut or copy something it will show up on this
clipboard so that you can paste it in somewhere else. There is one clipboard for the whole
computer, not one per program. So what that means is that if I cut or copy something here I’ll be
able to paste it into Word if I’d like or into a webpage I’m creating, wherever I’d like to put it in
my computer.
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The clipboard is only wiped if you close all of Microsoft Office. You can close just Excel but if
you had Word still open, for example, then it would still be there. But once you close Word that
would close all of Microsoft Office and then everything on the clipboard would be gone.
There are four steps to cut, copy and paste. Number one, you’re going to select whatever it is
you’d like to cut or copy. Number two, you’re going to choose the Cut or Copy options. Number
three, you’re going to click the mouse wherever you’d like to put the data. You do not have to
put it in Excel even though we’re going to do that. Like I said, you can put it anywhere in your
computer. And then the last thing is you’re just going to paste. Let me give you an example of
how that’s going to work.
Following the four steps, the first thing I want to do is select my entire Mideast region. In this
case it’s going to be K2 and I’m going to follow this down and end it over in P16. K2, hold Shift
and click P16. That selects everything between those two points.
Number two is I’m going to Cut or Copy. There’s a couple of ways you can do this. You can
either come up here to where you see Cut or Copy or you can just right click your mouse
anywhere and you’ll be able to choose Cut or Copy this way. I’m going to Cut because I want to
remove it and you can see it looks like it’s still here. It won’t disappear until I actually paste it in.
Number three says click your mouse where you’d like to put this. Now I’m going to click down
here in B18. I could click over in Word and put it in or somewhere else, like I said. Now when I
go to paste this you can do it one of two ways. You can do it right click and choose Paste right
here or you can actually come over here and click on it from the Clipboard. Either one is going to
work. I’ll go ahead and choose Paste right here and now you’ll see it’s moved it. It’s no longer
on the right and it’s down below.
Just so you will know, if you happen to paste by clicking over here it leaves the original and you
have to go back and delete it if you don’t want it.
When you’re working with the clipboard if there’s something specific on the clipboard that you
don’t want anymore you can actually click the down arrow and delete that one piece of
information, but like I said, it’s going to be deleted when you close all of Microsoft Office. Your
clipboard only holds 24 items. Once you cut or copy that 25th item it’s going to pop up and say
“Would you like me to replace the first one?” Just know that.
You do not have to turn the Clipboard on to actually do what we just did. We just turned it on so
we could see what’s there.
I want to show you how this works between programs as well. I’m going to go ahead and open
up Microsoft Word for a moment and you’ll see the clipboard there and I’ll show you how it
works.
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This is a blank document in Microsoft Word. Do you remember the clipboard we turned on in
Excel a few moments? If you notice this is the exact same grouping right here and I can hit this
arrow to turn the clipboard on. And look, there’s the data we just cut from Excel. All I have to do
is click on it and I’ve now pasted that into Word.
Let me give you one more example. I’m going to go over to the internet and grab a picture real
quick.
Let’s say I found this picture of this dog that I like. If I right click you’ll notice that it says Copy
Image. Now just be aware that when you’re on the internet you want to be super careful about
copying images because some of them may be subject to copyright. But the point is I want to
show you how to copy from anywhere on the computer.
I’m going to choose Copy Image and I’m going to flip back to Excel and see if it’s on the
clipboard. There it is. So if I want to put this dog over here, for example, all I have to do is go
ahead and choose it and you’ll see there he is. Now it’s a whole other subject when we start
talking about sizing images and all of that but the point is you see how to cut or copy from
anywhere in your computer.
Let’s go ahead and wrap this section up and I want to talk to you a little bit in section two about
copying formulas.
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Video: Copying Formulas
Cindy: Hey. Welcome back. We’re in module seven and we’re talking in this module about how
to move your data around. We’ve already done section one where we went through the basics of
cut, copy and paste. I want to go ahead now in this section two and talk to you a little bit more
about cut, copy and paste some additional options and how they apply to formulas. Let’s jump
right in and I will show you how to copy your formulas.
In this exercise if we look down at row 12 we have a formula here in cell C12. I’m going to
double click to show it to you. And we haven’t really talked a lot about formulas but this one
basically says add everything between C6 and C10. If I wanted to add this column I would be
saying add everything from D6 through D10. So basically it’s pretty much the same except the
columns different.
You have the ability in Excel to copy your formulas using what’s called the Fill Handle. The
easiest thing to do is if the first formula is correct click on it and drag the fill handle across this
way and that will actually copy that formula to the cells across. When I look at these you’ll
notice this one says D6 through D10, this one will say E6 through E10, and all the way across.
And I could do the same thing for these as well and for this last one. And that’s a really quick
way to copy your formulas.
A little term that I want you to get familiar with for later, in each of these when we copied across
Excel changed the column in the formula for us. There is a term for that. It is called Relative
Reference. Excel will change the column or row relatively so that the answer stays correct. Let
me show you up and down what I mean.
When we look at G6, for example, this one is saying add across and it says add C6 through F6.
The one below it says C7 through F7. So this one changed the row automatically. When you go
down and use the fill handle the row will change automatically for you. You’re going to learn
later that you don’t always want it to do that but that term that I want you to remember is called
Relative Reference.
Now let go back to this for a second. I’ll just delete this one. I could if I wanted to have just right
clicked on this one, chosen Copy, and I could right click on this blank one and then choose Paste.
That would certainly work but I’d have several to do that with and it would just be very time
consuming to do that.
Now I did want to show you that there are several other options when you’re pasting. Let me go
ahead and select this whole table and I’m going to copy this. Now if I just come over and right
click these are actually all of all your paste options right here and you can see a preview as I
move across them, but I want to go through them real quick so you’ll know what they mean.
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This first one is the regular paste that you’ll use most of the time. The second one will paste the
values. Okay I’m going to click on that and just show you what I mean. Now at first glance this
looks just like this. But here’s what I want you to notice. When I click here there’s no formula.
It’s just the value that was in that cell over here. Same thing all the way across with all of these.
And that’s what Paste Values means.
Let me go back and copy this again and I’ll just slide to the right for a minute and show you a
few other things here. Let’s say I right click this time and look at the third one. That’s called
Formulas, which is basically what the first one did in this case because we have formulas there
we were copying.
Now let’s talk about transpose, what this does. If you notice the original had the months going
across and the names going down this way. Transpose just flips that. Notice now the months go
up and down and the names go across. So anytime you’d like to flip your column or row
headings like that use the Transpose option.
There were a couple of more there so let me go back and select this again for you. I’m going to
right click and Copy. Now when I look at this and I right click this one says Copy the
Formatting. The formatting is the bold and italics and the colors, all of that. So that would not
actually copy the numbers or text, just the formatting. And you’ll see later on as we go through
her how this would apply. And then we’ll talk about paste links a little bit later as well. I just
wanted you to be familiar with all those options so that when you see them you would know
which one that you might want to choose.
Well that’s going to go ahead and wrap up module seven. We’ve talked about moving your data
around. Let’s go ahead and really get into some of these formulas over in module eight. I want to
go ahead and start in section one and give you an overview of how formulas work.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Module 7 – Practice Exercise
Cindy: We’ve been working in module seven and in this module we’ve talked about how to
move your data and we did that a couple different ways. We actually used the Move feature
where we were able to actually point around the edges of our active cell and move data. We did
cut, copy and paste, and I want you to go ahead and go through here and do a quick little exercise
just to make sure you’re okay with all of this.
The first thing I’m going to have you do is open a file called Eastern Regions Report 2. It should
look just like this when you get it open. I’m going to actually have you move this information up
here so it lines up with the table nice and neat. You’ll move this information over here and then
once you get done we’re actually going to take the Mideast region which is on the right and put it
below the Northeast region. Remember when you do cut and paste and you go to do the paste
portion just click in B18. You don’t have to select the whole exact same size range. It’ll fill down
and across for you when you do that.
Once you get that done then you’ll have a little bit of a nicer looking file and I want you to go
ahead and save it for me. And then we’ll move over into module eight and talk about formulas
and functions.
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Module 8 – Formulas & Functions
Video: Overview of Formulas
Cindy: We are ready to start talking about formulas and functions. We’re all the way down to
module eight now. This is section one and in this section I want to give you a quick overview of
formulas and basically how they work.
A formula is basically a mathematical calculation that tells Excel what to do. You can do simple
things like add a column of numbers to really sophisticated things like statistics and things you
would never even imagine. Excel is very, very powerful when it comes to formulas. Let’s get a
quick overview of how formulas work and then we’ll jump right in and start creating some
formulas using functions.
What you need to remember when you’re writing formulas is that wherever you click the mouse
that’s where the answer is going to appear. Formulas can be on the same sheet as the data, they
can be on a separate sheet as the data, or they can be in a totally different file, and we’ll be doing
all of this as we go through these videos, but just to give you a quick overview and review.
Let’s say that I wanted to add my numbers for January. I’m going to click in C12 next to Total
because that’s where the answer to be and I’m going to put in the equal sign. Remember that all
formulas must start with an equal sign, no exceptions.
I’m going to click on C6, I’m going to hit the plus sign, C7, plus, C8, plus, C9, plus, C10. And
when you’re finished writing your formula you just hit the Enter key and you will have your
answer just like that.
Now think about this. Even though I was able to click on each cell and tell Excel that I’d like to
add another number if I have 1,000 numbers to add do you think I want to count all the way to
1,000? That’s just going to take me all day long to do that. We’re going to have other ways we
can write formulas using functions. A function is going to be a word we use in our formula to tell
it what to do.
Another example of a super basic one where we’re adding is let’s say we go over here to column
G and I want to add up all of the figures for this line. I’m going to start with equals, I’m going to
click on the 110, which is in C6, plus because I have another one, then I have D6, plus because I
have another, E6, plus and then F6 and I’ll Enter. And now I’ve got that one.
That’s going to give you a quick overview of how basic formulas are written. I really want to
take you now over into the second part of this and let’s talk about how to use functions because
that’s really going to make your life a lot easier when you have a word that tells it what to do in
your formula.
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Video: Create Formulas Using Functions – Part 1
Cindy: Welcome back. We’re working in module eight and we’re talking about formulas and
functions in this particular module. We did a real quick overview of formulas in section one.
Now that we’re section two I want to actually talk to you a little bit about creating formulas
using functions.
A function is basically a word that tells it what to do in your formula and I’m going to go
through all of these with you and show you how this works. Let’s flip over to Excel and we’ll
write some more formulas.
We already added up January. We did this manually by clicking inside of each of the cells we
wanted to add but that was the long way to do it. I’m going to go ahead and hit Delete here and
talk to you a little bit about using functions in your formulas.
A function is a word that you use in your formula to tell it what to do. There are over 200
functions built into Excel. The most common of the 200 is the word Sum, S-U-M, which
basically means to add. Typically if I ask students if they’ve ever written a formula before they’ll
say Yes and they’ll say someone showed them how to do this. Notice that I’m under the Home
tab and there’s this AutoSum button right here. You’re also going to find that same button under
the tab that says Formulas. I’d probably use it under the Formulas tab. You’ll see it right here
because we’ll also be looking at some of these other options that have to do with formulas as
well.
I’m going to click the AutoSum button and notice that it put a formula in for me. And do you
notice it didn’t put the answer in? It put the formula in and it’s just sitting there because it wants
to make sure this is exactly what I want.
Now notice it’s assuming I want to add everything above where I was clicked. Notice it also
included row eleven which has nothing in it. That won’t affect anything as far as the answer goes
in this case but if I did add a number in C11 it would become part of my answer. If this is what I
want I just hit the Enter key. If it’s not, let’s say I didn’t want 11 in there, I would just drag
through what I do want, just like this, and then hit the Enter key. And now you can see I have the
exact same number I had earlier except I didn’t have to manually tell it to add each one of these.
So if you notice the way the formula reads now it says I want to add the range C6 through C10.
And that’s the easiest way if you want to add a range of numbers that are all together.
Now let me show you what happens when you go over to the next one because I need February
as well. If I come up and hit AutoSum again you’ll see that again it assumes that I want to
everything above this. I’m going to go ahead and just hit the Enter key and now I’ve got 965.
Now watch what happens when I do the third one here. I’m going to hit AutoSum and notice it
assumes I want to add everything to the left of where I’m clicked. I don’t. I’m trying to add
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everything above it. So I’ll just click and drag the range I do want to add and then hit the Enter
key.
Now if it were me doing this I would have done the first one and just used the fill handle and
dragged across to copy my formula, but I did want to show you some other ways to write this
formula.
I also wanted to show you this little green mark that you see right here and what that actually
means. If you know how grammar check works in Microsoft Word it’s very similar. It’s letting
me know that the formula I have here may be wrong. And the reason it says that is because it’s
looking at the one to the left of it and it knows it’s different. When you have an error if you
notice if you look where this exclamation point is it tells me the formula in this cell differs from
the formulas in this area of the spreadsheet. This one over here was 6 through 10. When I look at
this one it’s 6 through 11. It’s not hurting a thing. My answer is still correct, but if I wanted to fix
it I could go ahead and pick one of the choices from this dropdown list. The one I’d probably
choose is to copy the formula from the left. There you go. The answer is the same but now it
includes 6 through 10.
The last way I wanted to show you this is if you before you ever write your formula select
everything you’d like to add and the blank one for the answer then you can go up to AutoSum
and it will just give you the answer because it doesn’t have to guess what it is you’re trying to
add.
I could also do the same thing from left to right. If I wanted to go ahead and select all of these as
an example, I’ve got all the cells I’d like to add and the blank ones over here for the answer I can
hit AutoSum and there I have the answer as well.
Now I’ve got one more down here. There’s several ways I can do this. I can actually copy this
formula using my fill handle or I could have hit AutoSum and added everything above. And
that’s actually a really good way to check and see if this total answer is correct, to do it each way
and if you get the same answer then you know it’s the right answer.
Now let’s go down and talk about averages. The word that you want to use here is the word
Average. If I type equals, the entire word Average, and then my open parenthesis I can drag
through my range and then I can hit the Enter key and I’ve done it the exact same way.
The word High means when I’m looking at this range of numbers what’s the highest number.
The word I’m going to use for that is the word Max. I’m going to type equals, the word Max,
open my parenthesis and then I can drag through the range and I should get 220.
Now let’s talk a little bit about these functions and where they come from. Let me go ahead and
just select this range again because I wanted to show you that if you have a range selected you
can look down at the bottom here and see the six most common functions and the answers. And
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these aren’t going to put the answer anywhere. It’s just for you to know. I happen to have the
average turned on, there’s a count. Count counts the number of cells you have selected. The
numerical count will count the ones with numbers in them. Min means what’s the lowest number
in my range. And if you had Max there it would mean what’s the highest number in the range.
And of course Sum means add. If I right click on any of these you’ll see right here in this area
are the six most common. The ones I’ve checked are the ones that you’re seeing down there at
the bottom. So if I don’t want one of these I can just uncheck it and you’ll see now I’ve only got
a couple of them down there. But those are the six most common functions right here. And you
can’t change that.
Average you’re going to add all the numbers and divide by the number of cells you have
selected. And I told you about the rest of these so you know what those mean.
Now remember a range can be two cells, as long as they’re adjacent. If they’re not adjacent
you’re not going to see anything down here. If I just click randomly somewhere you’ll see
there’s nothing down here to look at.
Now let me go back to C12 and I’m just going to hit Delete here. I want to take you through your
Ribbon to show you where all of these functions happen to live.
You can use this little fx here, which is Insert Function or you can come up here where it says
Insert Function and use it that way.
I did tell you that there are over 200 built in functions in Excel and I wanted to show you that
they’re all right here in this list. Now when you start looking at this list you’ll notice that
currently I’m looking at a category called Most Recently Used. These will be the last ones that
were used in my computer. This makes it easy if you have several that you use on a regular basis.
You can come right back and just click on them from here. But notice if I drop this list down I
can look at all of the functions, and they’re in alphabetical order. From there I can take that list
and look at just the ones that have to do with financial, just the ones that have to do with math
and trig, statistics, you can kind of see the list here.
Let me go ahead and click on All and just show you how you can look through this list to
determine what equals each one of these actually does.
When you’re clicked on a particular function it will tell you down here what that function does
or the definition. This one, for example, will return the inverse hyperbolic cosign of a number.
And some of these may be way over your head because these can be very, very sophisticated.
But looking down this list let’s talk about a few of these that you’re going to use.
Here’s Average, for example, and you know what that one means. Some of these that say If at
the end, this means do the average if certain criteria is met. You’ll see that there’s a lot of them
that have to do with what we call Chi Beta Probabilities. You’re going to see that there are some
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that have to do with ceilings, some of these have to do with columns. Here’s one that you might
use from time to time, Concatenate. If you happen to have two columns of information that you
want to put together in one column and an example I see all the time is someone will have the
last name in a column and the first name in another column and they want to actually join them
all together in their own column. You would use concatenate to do that.
Let’s go ahead and stop the video right here and I’m going to have you go over into the second
part of this and we will continue looking at these different functions.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Create Formulas Using Functions – Part 2
Cindy: Okay welcome back. We’re in module eight and we’re talking about formulas and
functions in this particular module. We’ve already gone through section one where we got an
overview of how formulas work and we started working on section two where I’m showing you
how to create formulas using functions. We were in the middle of looking at those functions so
let’s go ahead and continue so we can see some of the other functions that are in Excel.
The last one we looked at was Concatenate, which allows you to join two different columns of
information together in one so let’s keep going.
When you go down the list another one that’s going to be really popular is the Count function. If
you have a series of numbers and you know you should have a hundred numbers and you select
them all and it says you have 99 then you know you’re missing someone. Here’s one that counts
all the blank cells. Here’s one that will do a count if it meets certain criteria that you put in.
Going down the list we’ve got a couple more. Let’s say for example you want to work with some
date and time functions you’ve got a couple right there. You’ve got some other functions going
down and let’s keep on going until we see if an If statement is going to be something you’re
going to do on a regular basis. We’ll be actually running one of these in a later module, but
basically you have it checked to see if something you’ve typed in is true. If it is true you have it
do one thing and if it’s false you have it do something else.
Going down the list there’s a few more that are going to be really popular. And let’s just kind of
get on down here to where we see Sum. There was Max. I just passed Max on the list. That finds
the highest number in your range. Remember that Min, M-I-N, will find the lowest number in
your range.
Let’s say we’ve looked down the list and we come across the word Sum, S-U-M, and we decide
that this is the one we want because it adds all the numbers in a range of cells. I’m just going to
hit OK and now this is the part called Function Arguments. The arguments portion is basically
the range portion or where the numbers are you want to do something with. Notice it assumed C6
through 11. I can leave it there or I can change that last one there to a 10 because I do want to C6
through 10. Notice it shows me all the values in those cells and it gives me the result right down
here.
I’m going to come back in a minute and tell you about number two but for now I’m going to
click OK and there’s the exact same formula we wrote using the AutoSum or we could have
written it by hand.
The reason you have that number two field was because what if you’re going to add two
different ranges. Let’s say for whatever example over here I’d like to add January and March.
What I would do is I would go to Insert Function, I would find Sum from the bottom of the list
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here. Notice if I click here I can hit S and I’ll go to the S’s. I’m going to find Sum. When I click
OK it’s going to assume the range and I said I wanted January so that’s my first range. Now I’m
going to click where it says number two and I’m going to drag through March. And that’s why
you have multiple fields. I could even add a third range if I wanted and it would keep on going.
But that’s what that extra field there is for. Let me go ahead and cancel out of that.
I’m going to go ahead and use my fill handle and copy across to get my averages and my fill
handle for the highs to copy across to get those.
I wanted to briefly tell you about these buttons right here. They may look familiar. This is your
Function Library. If you remember when I took you into the Insert Function button there were
several different categories I told you that you could pick from. You’ve got Financial, Date &
Time, Math & Trig, and you’ll see a lot of these right here. It’s just a quick way if I don’t want to
come all the way back into this Insert Function window and I’m looking for a particular function
that I know happens to be under Financial, for example, I can just grab it right from the
dropdown here.
Now one more thing that I wanted to point out. When we were looking at this exercise we had
done all of these formulas right here, but if you notice we have no formulas down here at the
bottom. And I don’t have to go down here and actually write new formulas. I can actually copy
these and paste them down here. All I have to do is right click and Copy, go down to the bottom
where it says Total, and then right click and Paste. And the reason this works is because of that
relative reference we talked about earlier. It knows to change the column or row relatively so that
the answer is correct.
When you do this always check one answer. If one’s right they’re all right. If one’s wrong
they’re all wrong. And when I look at this particular one it does refer to 22 through 26 so that is
correct.
That’s going to give you a quick overview of how to use your functions when you’re writing
formulas. We’ve got one more section in this particular module we need to look at and I want to
look at section three which is the Absolute Values and show you how those work. I’ll see you
over in section three.
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Video: Absolute Values
Cindy: We are working in module eight and we’ve been talking a lot in this module about
different formulas and some of the different functions in Excel. We’ve had a quick overview of
formulas. We’ve gone through and looked at a ton of different functions and now I want to talk
to you about something called Absolute Values.
I’ve mentioned to you a couple of times the term Relative Reference and that’s where Excel will
automatically change the column or row so the answer so the answer is correct. I did mention to
you that you’re not always going to want to do that and this is an instance where you would want
to create an absolute value. Let me flip over and I’ll show you what an absolute value is and why
you’d want to use it.
This exercise is very similar to the one we’ve been working in. This is that same company Books
and Beyond and they have an Australian division of the company and a European division of the
company and they’re tracking pretty much the same information as far as the sales person and
their figures for all their quarters and their totals. But now we see something new. It looks like
they’d like to give them a commission as well and they’re going to give them a commission rate
of 15%, like you see up here.
What I want to do is first of all go back and review relative reference so you can see what that is
and then we’ll write a formula to figure out the commission. Remember that relative reference
basically means that when you write a formula Excel will automatically know to change the row
if you go up and down or the column if you go across. So all of these formulas right here would
be the exact same except that the row right here would be different. When we look at our
columns all of these across this way will be the same except that the column would be different.
There are some times when you don’t want to do that and this is a prime example.
Let’s go ahead and click over here in H8 and I want to figure out Mr. Long’s commission.
Remember it’s going to be a 15% commission based on his total. And the easiest way to do this
is just hit the equal sign on your keyboard, we’re going to take G8 which is Mr. Long’s total and
we’re going to multiple it times G3 which is the commission rate. I’m going to go ahead and hit
the Enter key and you’ll see his commission is $176.25. And let me just make a comment here.
A lot of times people think that you have to have a word or a function in every formula and that
is not the way it is. Think about this one. All I want to do is take one cell times another. There’s
not really a word for that and I wouldn’t need one anyway because there’s no range here. So
don’t get caught up on that. Make your formulas as easy as possible.
But let me show you what’s going to happen in this case if I use my fill handle and just copy this
down.
Look how I have zeroes. Let’s go see why. Well we know this one is correct obviously but let’s
look at this first one. This one is taking G9, so it did move down like it should, but look it also
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went down up here to cell G4 and there’s nothing there. That’s why I got zero. If I look at the
one below that, again it went down, G10, that’s correct. But look up here. It’s G5. That’s not
correct.
So what’s happening is it’s moving down like it should to make the answer what it thinks should
be correct but what we want is a little different this different this time. We want the total to move
down in the formula but we never want G3 to change. What we’re going to do is in the formula
itself we’re going to make G3 what we call absolute. The way you do this is make sure you’re
clicked in the formula where the G3 is. It doesn’t matter if you’re in front of the G, behind the 3,
or in the middle of it, just as long as you’re in G3, and you’re going to insert dollar signs in front
of the G and in front of the 3. Yes, you can type them but you can also use on your keyboard
your F4 key and that will actually put those in for you. I’m going to go ahead and type mine right
here real quick and what you’re going to see is that I’m going to actually hit the Enter key and
now I’ve got my same answer but now it’s absolute. The way you actually read this is you want
to say G8 times the absolute value of G3. If I copy these down now notice they’re all going to
say G9 times the absolute value of G3. This one will say G10 times the absolute value of G3.
And that’s how you do an absolute value.
Now one thing I just want to give you a little heads up on, in module twelve we’re going to talk a
little bit about working with names. You do have the ability if you’d like to not have this 15%
anywhere on this sheet and you can still have it do these calculations for you. And we’ll come
back and use this exercise when we get ready to do that.
Well that’s all there is to working with absolute values. Let’s go ahead and wrap up module eight
and move over to module nine and talk about working with our sheets.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Module 8 – Practice Exercise
Cindy: In module eight we did a lot with formulas and functions and I want to make sure that
you can write some super basic formulas when it comes to working with your spreadsheets.
What I’m going to have you do is open this file called Eastern Regions Report and we’re going
to put a lot of formulas in here.
I’m going to have you guys start by clicking in C12 and adding up January and then you can
copy that across. And do the same thing for Averages and the highs as well.
Once that’s done we’ll come over to column G and figure out the totals across for each person
and also the commissions. Remember when you figure out the commissions you’re basically
taking your total times this commission rate to get an answer. And also remember that it will
have to be an absolute value. If you don’t create the absolute value when you copy the formula
down you’ll get zeroes for your answers.
Once you get all the answers in here you’re going to copy every single one of them down to this
Mideast region. And I’ve got instructions over on the Word doc on exactly what to do.
Well good luck with that. It’s not really that hard but just take a few minutes and just make sure
you know how to do this before you move on to module nine, Working with Sheets.
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Module 9 – Working with Sheets
Video: Adding, Deleting and Renaming Sheets
Cindy: All right. We’ve made it all the way down to module nine and in this module I want to
talk to you about how to work with your sheet tabs that you see at the bottom when you open a
workbook. You can actually add sheets, you can delete those sheets, and you can rename those
sheets. Let’s go through and talk a little bit about how sheets work and I will show you how to
add, delete and rename those sheet tabs.
We have an exercise here that has multiple sheets with information on them and I want to take a
peek at what this looks like before we get started. This is the Australian division of the company
and if you notice they’ve listed each item that they’re selling, the figures for quarters one through
four here and they’ve just totaled them down in row nine. Now notice that we’re on Sheet1 at the
bottom. Let’s see what’s on Sheet2. All I have to do is click on it and I’ll flip to that sheet. This
looks like the European division. If you notice the setup is the exact same except these numbers
are different which obviously changes our totals. Let’s see what’s on Sheet3. Looks like the
North American division, Sheet4 looks like the South American division, and Sheet5 looks like a
summary. What we’re going to end up doing in section three is writing a three-dimensional
formula here. That would be a formula that goes to the other four sheets and gives me a total here
on this fifth sheet. But meanwhile let’s go back to Sheet1 for a moment.
If I asked you which sheet was you Europe would you remember that it’s Sheet2? Probably not.
So the best thing to do is go ahead and rename your sheet tab so that you know what’s on each
sheet.
There are a couple of ways to do this, but the easiest way is to double click on the words Sheet1
at the bottom. That will select it and then you can type right over it. I’ll just go ahead and put
each of the sheet tab names in here. Sheet2 is Europe. Looks like Sheet3 is North America. It
looks like Sheet4 is South America and Sheet5 is Summary. Now we know that when we click
on the Europe sheet we’re going to see the European division of the company.
There are some things you can do as far as adding sheets. Let’s say you wanted to add a sheet in
between North and South America. If I select the South American sheet I can right click and I
can insert a sheet in front of that sheet. It will ask you when you do this what is it you’re trying
to insert and you want a worksheet so I’ll just click OK and now you’ll see it’s using the name
Sheet1 since we’re not using that name anymore.
Now there is a plus sign all the way over here and if I click on that plus sign you’ll notice I’ve
added another sheet there. So that’s another way to put a sheet in front of the sheet that you’re
currently on.
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If you want to delete a sheet you just right click on that sheet tab and you can choose Delete from
the list.
If you delete a sheet you cannot undo it. Just know that.
I’m going to go ahead and delete Sheet1 as well. I’m going to right click and choose Delete and
now that sheets gone too.
Now I do have the ability to move the sheets around. What if I decided that I’d like North
America to be the first sheet? Notice how if I just click on it I can drag the sheets left or right.
You’ll see a little down arrow and when you let go that’s where it’s going to be.
Let’s say I move this back and I’ll move it to the right of South America.
Be really careful about moving your sheets on the other side of Summary because when we talk
about our three-dimensional formulas we’re going to be saying that we want to add a range of
sheets and if you’ve moved this on the other side it won’t be in the range. Just be really careful
about that.
That’s a quick way to go ahead and add sheets, delete sheets and rename and move your sheets
around. Why don’t we go ahead now and go over into section two and I’ll show you some
additional sheet tab options you have.
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Video: Additional Sheet Tab Options
Cindy: Welcome back. This is section two of module nine and in this particular module we are
talking about working with the sheet tabs at the bottom of each of your workbooks. We’ve
already learned how to add some sheet tabs, delete them and rename them. Now I’d like to go in
and show you some of the additional sheet tab options you have when you’re working with each
of those sheets.
We’ve already talked about some of the options you can do with sheets as far as adding sheets,
we talked about deleting sheets and renaming them but let’s go ahead and look at all the options
available when you’re working with your sheet tabs.
If you’re on any sheet tab and you right click your mouse you’re going to see a list of things you
can do, starting with Insert. We talked about the fact that you can insert a worksheet and it will
actually go to the left of the sheet you have selected, or in front of that sheet. You can also right
click on a sheet tab and delete it. Remember if you delete it you cannot get it back so make sure
that’s really what you’d like to do. you can also rename a sheet. Choosing Rename this way just
selects the sheet tab name and that way you can type right over it. It’s actually a little bit easier
just to double click on the sheet tab name to do the same thing.
Here you can move or copy. We did talk about the fact that you pick up a sheet tab and move it
left or right but let’s look at the options when you go this way.
Here what you’ll see is this is the name of the file that you’re working in and these are the sheet
tabs in that particular file. If I wanted to take South America, the one I’m clicked on, and move it
to the very front I would choose Australia because it says Before Sheet, and then click OK and
now look how it’s moved that sheet tab.
Now I’m going to right click on that again and go back to Move or Copy because here’s
something that’s really nice. Sometimes people ask me, “Can you take a sheet tab and actually
copy it into another file, like a blank workbook?” And the answer is yes, you can. Let’s say you
want to copy South America but this time what I want to do is put it in a new workbook and I
want to create a copy because I want to leave this one here and just make a copy in the new
workbook. Now when I click OK I want you to notice this is a brand new file. Notice it says
Book1 at the top and notice we only have one sheet and it’s the one called South America. That’s
a really great way instead of copying and pasting. A lot of times what happens when you copy
and paste the data on one sheet into another file you lose all your formatting, you lose your
column widths and all that. Doing it this way you don’t lose any of that.
I’m going to go back and close this and we won’t save it. And then we’ll be back on the file we
were working in.
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All right I’m going to right click again on South America and I want to just mention the View
Code. If you click on this it’s actually going to take you into an entirely different program called
Visual Basic and you do have the ability to write some what they call VBA Code and stuff like
that to make Excel do different things. But I don’t want you to get lost in here because this is
programming and if you happen to click on it accidentally just go ahead and hit the X and close
out of it. It’s not actually part of Excel.
All right I’m going to right click again and let me talk to you briefly about protecting the sheet.
We will talk in a later module about protecting your file and protecting your sheet but you do
have the ability to create a password to put on this sheet so that when someone opens it they have
to know the password to get in.
Notice you can also change the tab color. If there is a particular sheet, like maybe the Summary
sheet, and you’d like that sheet to stand out for some reason, change the tab color and when you
click on another tab you’ll see that there’s where the color shows up.
I can also hide a sheet. If you hide a sheet you can see that it looks like the sheet is not even
there. You can right click and unhide a sheet. It will list the hidden sheets. You choose the one
you want to unhide and click OK.
Some reasons for hiding a sheet might be obviously you don’t want someone to see that sheet.
Let’s say, for example, you’ve created a list with a dropdown and this is a little more advanced
than we are right now, but you can have dropdown lists in Excel. Well those dropdown lists have
to live somewhere. They can live on a sheet you’ve created and then you hide the sheet so that
others can’t get in and actually mess with the list and screw it up. So that’s a great example of
why you might want to hide a sheet.
Now I’m going to go back because you can also do one more thing. You can select all the sheets.
And you can see when you do this that all of these turn white or they’re selected so that whatever
you do on one sheet now appears on all the sheets.
To deselect all the sheets you just click on any sheet tab and now you’re on this one sheet tab
only.
Those are the options that you have when you’re working with sheet tabs. Let’s go ahead and
wrap up this section and I’m going to have you go over to section three where we’re going to
talk about three-dimensional formulas.
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Video: 3-Dimensional Formulas
Cindy: We are going to wrap up module nine with section three here. We’ve been talking about
working with your sheet tabs and now I want to talk to you a little bit about how threedimensional formulas come into play.
A three-dimensional formula is basically a formula that you write on one sheet and it calculates
data from other sheets and puts the answer on this sheet that you’re on. And we call those 3-D
formulas or three-dimensional formulas. Let me go ahead and show you how three-dimensional
formulas are actually setup.
In this exercise, if you remember, I told you that all of the sheets were set up exactly alike. Each
one was listing the items they were selling, the figures for quarters one through four and totals
down in row nine. This area right here is the only thing that’s different on each sheet because
that’s where the numbers are for each of the divisions. Now if we click over on the Summary
sheet we’re going to actually putting the answers right in here. We’re going to tell Excel to go to
each of these four sheets at the bottom and add up B4 and then put the answer here on this
Summary sheet.
Now a couple things to review before we actually do this. If you remember when we were in
section eight and we talked about formulas one of the things we talked about was how to select a
range. Remember a range means you have a starting cell, you’re going to hold the Shift key and
then you’ll click the ending cell so that it gets everything in between. You need to know that
because when you’re writing a three-dimensional formula you’re going to be selecting a range of
sheets instead of a range of cells. But you’ll do it the exact same way.
If I wanted to select the sheet Australia all the way to South America, I’m going to make sure
Australia has been clicked on, I’m going to hold Shift and I’m going to click South America.
And you can see the sheet tabs all look like they’ve been selected when you do that. If you type
something on a sheet tab that’s part of a range of sheets that’s selected like this it’s going to be
on every sheet. Let me give you a little example. I’ll put Books and Beyond here. Now I’ve just
typed it on the Australia sheet but notice I can click North America and it’s in the same place,
South America it’s in the same place and so forth. I’m going to delete that and then if you want
to deselect a range of sheets then you just go ahead and click a sheet not in the range.
Now let me go back to Summary and I’ll show you how to write a three-dimensional formula.
I’m going to start in B4. What I want to do is add cell B4 from all four of these sheets and put the
answer on the Summary sheet.
You’re going to start with equals so that it knows it’s writing a formula. We’re going to put in
the function, the word Sum, which means add. And make sure you have the open parenthesis
because remember all ranges have to be in parenthesis. It’s easy to forget that one step.
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Now I’m going to click on the first sheet that I want to add from, then I’m going to click the cell
I’d like Excel to add for me. And the only thing left now is to say add the rest of these sheets. To
get the range I’m going to hold Shift and click South America. Now I’m going to hit the Enter
key. Don’t click over on Summary sheet because then that will just replace whatever you had
typed in. I’m just hitting Enter and now I’ve got 900.
Now let me open up this formula so you can see what it looks like. Notice it says you want to
add the range Australia through South America and on all four of those sheets you want to add
cell B4.
Let me do a couple more so you can get the feel for how this works. We’ll do our software. I’m
going to start with equals, I’m going to put in the function in this case the word Sum, make sure
you have the open parenthesis, go to the first sheet you want to add from, click in the cell you’d
like to add, hold Shift and click South America, then just hit the Enter key. One more.
I’m going to add the furniture. I’ll start with equals. I want to have the word Sum which is the
function in there and then an open parenthesis. I’m going to click the first sheet I’m adding from,
I’m going to click in B6, hold Shift, and click South America and then hit the Enter key. And
you get the idea that you just do them all the exact same way.
Now you can just do one and then use your fill handle to copy the others down. Once you’ve
copied them down then you can pick the fill handle back up and go across. But make sure that
first one’s correct because remember if it’s wrong they’re all going to be wrong. And this is
something you just have to practice. Once you do two or three and you get it you’ll realize it’s
super easy to do, but just make sure you watch the video and go back through the exact steps that
I did and you’ll be able to do it perfectly.
If you didn’t have the four sheets set up the exact same you would have to manually go to each
sheet and tell it which cell to add. You wouldn’t be able to do a range that way.
Well that’s all I’ve got for you for module nine where we talked about working with those sheet
tabs and the three-dimensional formulas. Let’s go ahead now and move to module ten. We’ve
got a lot of formatting that we want to do on these worksheets to make them look nice.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Module 9 – Practice Exercise
Cindy: We finished with module nine and we talked in this module about working with your
sheets and these are your sheet tabs that you see at the bottom of your file here.
What I’m going to have you do is go through the first five of these sheets and rename each one to
the actual division that they represent. Like this one would be Australia, this one would be
Europe, and so forth. Sheet5 is a summary sheet. Make sure you rename that as well.
I want you to go ahead and add a sheet. I want you to add one in front of Sheet4. That’s going to
give you another sheet. Then I’m going to have you delete that sheet as well.
Also the Summary sheet I want you to make it red. You can just change the color of that tab so
that that one stands out.
The last thing I’m going to have you do is write a three-dimensional formula. And if you
remember a three-dimensional formula is one that spans several sheets. What you’re going to do
is on this Summary sheet starting in B4 you’re going to write a formula that tells Excel to add B4
from all of these sheets and put the answer on Sheet5, which will be Summary.
If you forget how to do this go back and look at section three where we went through 3-D
formulas.
Once you’ve got that down pat then you can move over to module ten and we’ll look at
formatting our worksheets.
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Module 10 – Formatting Worksheets
Video: Formatting Cells – Part 1
Cindy: Welcome to module ten and in this particular module we’re going to talk about
formatting your worksheets. And there’s a lot for us to talk about in this particular module.
The formatting is basically when you’re taking the information that you’ve typed into your cells
and you’re making them look nice. When we talk about making borders and put shading and
when we talk about we want our column headings to be bold and we want our numbers to have
dollar signs, all of that’s considered formatting. And we’re going to have different areas of
formatting. You’re going to have formatting you can do with the cells and you’re going to have
formatting you can do with the numbers.
Let’s go ahead and start off with formatting cells and then we’ll go into formatting numbers right
after that.
When we look at this particular exercise you’ll notice that nothing actually stands out. We can
see that this is the title for the entire page. We can see that we’ve got some column headings here
and some row headings but nothing really stands out. We don’t even know if the numbers
represent dollars or if they represent individual numbers. So we’re going to go in and make this
look a little bit nicer so that we can draw our eye to the things that are important in this particular
file.
Let’s go ahead and start with our title. I’m going to click in B2 because all of this is in B2. And
here are some really basic things you can do to change the formatting.
Let’s start with this Font grouping right here. Right here where you see this word Arial, if you
click the dropdown list you’re going to see a list of different fonts that you could use. Fonts are
just different ways the letters look. Sometimes you get cursive writing, sometimes you get more
space between the letters. And you can see that as you move your mouse across these different
fonts that it gives you a little preview of what they look like in the background there. You could
choose any of these that you like. You could also go on the internet and just find all kinds of
fonts and just pull them in and use those as well. I’ve picked a font called Algerian for this title.
The next thing I want to point out is the size and that’s where you see this 10. Typically you’re
going to find that most letters or most generic spreadsheets will start out with their text or
numbers in size 12. In the olden days everything was size 10 automatically. You’ll see in the
newer versions that 11 is the default number and the default font by the way is usually called
Calibri. Again I can choose any size that I’d like my text to be right here.
You’ll notice this list goes 8, 9, 10, 11, 12 and then it counts by twos. It goes all the way down to
72.
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A little piece of trivia. 72 points is equivalent to one printed inch.
What if you want a number that’s not on this list? Let’s say you wanted 15, for example. All you
have to do is type it right up here. You can see the 10 is selected. If I type 15 and hit the Enter
key then I’ve got that size.
If you wanted a size and you don’t know exactly what number to choose you can use these two
arrows here that increase by one on the list or decrease your font size by one on the list. So any
of that’s going to work to help get the size that you’re looking for.
Underneath we have B for Bold. You can just turn that on or off. We have I for Italics and we
have U for Underline. When you’re underlining I want you to notice you’re underlining the text
or numbers that are in the cell, not the actual cell itself. You also have a dropdown arrow because
you can do a straight underline or a double underline here if that’s what you want to do. If you
don’t want the underline at all you can just turn it off.
Now we’ll come back to these two a little bit later. Let’s go over here to your font color. Your
actual text or numbers can be any color that you’d like them to be. And you can see there are
tons of different colors to pick from. Let’s say you pick a color and it’s not exactly the color
you’d like. I want you to notice that there is an option for more colors right here.
When you go into the More Colors option you’re going to have a Standard tab and a Custom tab.
On the Standard tab you have additional colors that you might want to choose from. Under the
Custom tab you can create your own color. The way this works is you generally know ahead of
time that you’re looking for a blue or a purple or a green and notice if you move your mouse
throughout these colors that you’re actually changing all of the colors down here and there’s an
arrow in this bar that you can point to the exact new color you want and then click OK.
The last color that you chose will be right here, so if you wanted to use it again you could, but
I’m going to go back and actually pick this dark blue color.
The next thing I want to talk to you about is the fact that you can actually do some of those same
things with this information down here. Now there’s going to be additional options when you
click this little arrow on the bottom right of your font grouping. Let’s see what’s here that we
didn’t have a button for.
The first thing I want to you to notice is that when you’re on the Font grouping and you click the
arrow you’re in this option called Format Cells. Notice that it puts you directly on the Font tab. If
you happen to be on this Alignment grouping here and you clicked this arrow you would be in
the Format Cells, you would just be on the Alignment tab, and the same thing with Number over
here. There’s a few of them that you can’t get to without coming into one of these and that’s the
Border and the Fill and we’re going to talk about these here in a few minutes.
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But right now if I look at the Font options we could change our fonts back here, same thing.
Here’s our Bold and Italics that we see right here. Here’s your font sizes, so nothing new yet.
Let’s check out Underlining.
From here we were able to pick a single or double underline, and we can still do that but we also
have the option to pick single accounting or double accounting here as well. Here’s our color
options. And then here’s a few options you did not have buttons for. Strikethrough, and that’s
when you strike through your text like this. Typically you’ll see that in a legal document because
you don’t want to delete the old information. They’ll usually strike through the old information
and put the new information to the right of it.
And to tell you what Super and Subscript are. Superscript would be when you type something
like Mattel ToysTM and you have the little trademark, the little TM that’s kind of up above.
That’s called Superscript. And subscript would be if you have H20 where the 2 is down below.
They call that Subscript. You might notice that when you’re typing your text in you’re in the
center or it looks like you’re in the center I should say of each of your rows. You’re actually on
the bottom. You’ll see that here in a moment. But the superscript puts your text up and the
subscript puts your text down.
So not too many new options there. I’m going to go ahead and click OK and now you can see
what we’ve got so far.
Let’s take some of this information here and make it stand out. We’ll take the word Name and
make it bold. We’ll actually make these bold as well since these are our column headings. And
these down here, let’s go ahead and italicize those.
Now there’s one more thing I want to do with these. I want to skip over to this alignment
grouping here real quick. Do you see these two right here? Increase or Decrease Indent. If I
increase indent it’s like indenting within a cell and it’s a quick way to make something like this
stand out from the word Name right above it.
The rest of these are your alignment options and let’s talk a little bit about these.
Right now when you look at January through April you’ll notice the text looks like it’s lined up
on the right side of each of these cells. If I make these a little bit wider you’ll actually see what
I’m talking about here. Let’s say you want to put these in the center. You’re going to use these
three buttons here to left align, center or right align the text within the cell. I’d like these centered
and I’m going to center Totals as well.
These up here have to do with aligning the text up and down within the cells. Let me just show
you something I mentioned a few moments ago.
Let’s say that for the months of the year I want to make row four a little bit wider. If I put my
mouse on the line that separates the four and the five like this I can actually drag down and make
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that row wider and you can see you’re actually typing the text on the bottom of that particular
cell. Well if I select these and then change this to the middle align option now you’ll see they’re
centered up and down.
You can actually use this Orientation button to actually rotate your text at an angle. I can use
counterclockwise, I might use angle clockwise, there’s a couple that lets you take the text and
vertically put it in your cells. And obviously if you were going to do this you’d have to make the
row a lot wider, like this, so you could see it.
You’ve also got options up here with the orientation to rotate the text down. I’ll go ahead and
choose angle counterclockwise and then I’ll make the row a little bit wider so we can see it all.
You can see it’s starting to get a little bit of formatting so things are starting to stand out a little
bit.
Let’s go ahead and look over at part two of formatting cells and I’ll continue to show you some
of the options you have when it comes to formatting.
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Video: Formatting Cells – Part 2
Cindy: Look, I’m back. We are in module ten and we’re talking about formatting our
worksheets. We just got through talking in section one about formatting our cells and there’s a
few more things I want to show you. Let’s go ahead and dive into part two so that we can
complete talking about how to format your cells.
There were a couple of more options under the Alignment grouping that I wanted to show you
and let’s start with the Wrap Text option. I want to go down here to cell B18. Books and Beyond
Mideastern Region. All of that’s in B18. You can see that C18 is empty so the text has just
spilled over. I’d like to keep all the text in B18 and just have it word wrap, and that’s what this
option will do.
I’m just going to click on Wrap Text and you can see now the text has word wrapped. To take it
off you would just click on Wrap Text again and now it’s back the way it was.
The next option underneath is the Merge & Center option. If you notice all of this text for the
title for our page here, Books and Beyond Northeastern Region, is all in B2. And again it’s just
spilled over because these cells are empty. I’d like it to actually be centered across my table.
That means I need to center it from column B to column G.
The way Merge & Center works is you select the cells you’d like to center across and you just
choose the Merge & Center option and now it’s made all six cells one cell and centered in that
one cell. You can see that it’s chopped off part of the B over here and part of the ending of my
wording there and there’s a few things I can do. I can actually go in and start adjusting some of
the column widths if I wanted to make it all fit but the easiest thing is probably to work with your
size until you get it to the exact size you want so it’ll fit right in there.
Let’s go up to the arrow at the bottom of our Alignment grouping and see if we’re missing
anything.
You can see we’re on the Alignment tab. All of these options are right back here. We saw a
Wrap Text. You haven’t seen Shrink to Fit yet. Let me show you how that works.
I’m going to go back down here again to B18 and I’d like to shrink all this so it fits in that one
cell. I’m going to click the arrow next to the Alignment grouping, choose Shrink to Fit and click
OK. And now you can see the text is super tiny because it has shrunk it down so it would fit in
that one cell. I’ll go ahead and undo that.
There was one more option in here I just wanted to mention to you and that is the option for the
text direction. You can actually have your text go from left to right or from right to left.
But the big thing I wanted to show you here is this orientation. If you remember we were able to
change it up here and we had several options we could pick from. But what if you had an exact
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degree of rotation you like to use? You can actually click this red diamond and drag this up or
down to any exact orientation that you would like and then when you let go you’ll see that the
text will be orientated at that particular degree of rotation.
And that’s pretty much the options I wanted to show you that have to do with formatting your
cells. We do have some more formatting to do. We’re going to be formatting our numbers. Why
don’t you go ahead and flip over to section two and I will see you there.
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Video: Formatting Numbers
Cindy: Welcome back. We are working in module ten where we’re talking about formatting the
different items that are on your worksheets. We’ve already gone through section one where we
talked about formatting your cells. Now we need to talk a little bit about formatting numbers.
You probably noticed that when you type your numbers in Excel they’re considered generic.
There’s no comma between the thousand, no dollar sign, no point-zero-zero and that’s because
you have to tell Excel what numbers actually represent. I want to go through and show you all
the different things that you can have numbers look like when you have them formatted.
When you type numbers in Excel they’re considered generic. That means there’s no comma
between the thousands, there’s no point-zero-zero, there’s no dollar signs. You have to tell Excel
what the numbers actually represent. Let’s just say in this case that all of these numbers happen
to represent dollars.
What I want to do is I’m going to go ahead and select the entire sheet. Now the way you do that
is notice there’s a little box to the left of the column A and above the row heading one there. By
clicking there you select the whole sheet. Whatever I do now will format every single cell here
for that particular choice.
If you look up here your next number grouping is the one that says Number and all I want to do
is click the dollar sign and now you’ll see all of these are dollars. I’m going to make a couple of
these columns a little bit wider so that we can see all the numbers and there you go.
Now I just formatted every single cell on this sheet. That means even these blank cells over here
they hold formatting. If I took a blank one and just put the number one in there and hit the Enter
key notice it assumes it’s a $1.00. That means that if you happen to have numbers on the sheet
that some might represent dates and others might just be regular numbers you may not want to
start by selecting the whole sheet like I did. You may want to just select just that one area that
represents the dollars.
Now let’s go up here and look at some of our choices.
From this dropdown here we can tell Excel that the numbers are generic and this is how you
would actually put these back if you decided they weren’t dollars and you wanted them generic
again you would just choose this option. They could represent a number. They can represent
currency. It can be an accounting option. There’s short and long dates. You can see time,
percentages, fractions, scientific, and text. Now we’re going to go in and a moment and see that
for all of these there’s additional choices and I’ll explain what each one of these means, but for
now let’s just look below that and you’ll see that there’s the dollar sign that we chose earlier. I do
have the ability from this list to choose a different style of money. Maybe I wanted the Euro or
the pound. You can see there’s different choices there. If my numbers happen to represent
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percentages I would just click this here. If I needed a comma between the thousands I would
click here. And then I’ll tell you about these two in a little bit because these let you increase or
decrease your decimal to change the displayed value.
Let’s go ahead right now and click on the arrow at the bottom right of the Number grouping and
let’s look through these categories and talk about what each one of these represents. And this is
the same list we had when I pulled this down right here.
General means that there’s not going to be a comma between the thousand, no dollar signs, just
like the numbers are when you first type them in. The next option is Number. If you have a
number you can specify how many places behind the decimal point, if you’d like to use the
separator between the thousands, that’s where you have one comma and then three zeroes. And if
you have negative numbers you can make them appear with a minus sign in front, maybe you
want them just red, or you can have black or red with parenthesis. That’s great if you have some
sort of spreadsheet where you have payments because then the payments stand out.
The next option is your currency. These are going to be the same options that you have with
number except that you also can pick the symbol right here. From this dropdown you’ll see
there’s a ton of different money symbols you can choose. They’re all right there. This is not
going to convert Euros to dollars or anything like that. It’s just going to put that symbol in front
of the number. That’s all it’s going to do.
The next one is the Date option. When you have dates you can make them appear in any of these
formats that you see here. Some of these actually have the day of the week. You can see some of
these have the month spelled out. They’re just all different. Some have the time. And then below
that is the Time option where you have different ways that time can appear and some of these
might include the date as well.
Your next option down is percentages. You can specify how many places you’d like behind the
decimal point if you’re working with percentages. You’ve got fractions. If you’re using fractions
you can specify that you’d like two digits or three digits or you want to see these as halves. You
can kind of see the choices there.
The next one is Scientific. You can specify how many places behind the decimal point.
And then you have Text. There’s something I want to tell you about the text option. One of the
things that will happen with numbers is you’ll type 001 and the two zeroes at the beginning will
disappear but you really wanted those. The way you actually get those to stay is to treat those
numbers as text. Text format means that whatever is in there, whether it’s text or numbers, is
treated as text.
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All right let’s talk about Special for a moment. There’s a couple of different things you can do
with special. You’ve got Zip Code setup, Phone Number and Social Security Number. I’m going
to show you an example using Phone Number here.
Let’s say I have this column right here and it’s going to represent phone numbers. And typically
I would type Shift, parenthesis, you put in the area code, Shift, parenthesis, and then you’ve got
all these little spaces and hyphens and all that. Well we can set this up ahead of time so that it
automatically formats it for us.
Notice I’ve selected the entire column. I’m going back to the arrow to the right of Number. I’m
going to choose Special and then I’m going to choose Phone Number and click OK. Now watch
as I type phone numbers in this column. I’m not going to type anything except the numbers. I’m
not typing parenthesis or anything. Watch how it put the spaces in there for me and it put the
parenthesis. Now if you didn’t have an area code and you just had a number it would look like
this. So everything is formatted perfectly.
Let me go back in there because you did have one other option. You had the Custom option.
What Custom allows you to do is create your own format. Now you’ve got several you can pick
from here but let me give you a really good example.
Let’s say that you sell parts and all of the parts are two digits, a dash, and three digits. I’ve
actually typed what I want the format to look like. When you type this you can use the zeroes or
the pound symbols, either one. I’m going to click OK and now I’m just going to type five
numbers here and I want you to watch how it actually put the two digits, the dash, and then the
three digits just like this. See? And that’s what Custom allows you to do.
That’s going to be all of your options in here. Let’s go make sure we got them all. Yep, that’s
going to be all of them right there. Let’s go ahead and click OK. And I do want to talk to you
about one more thing as far as numbers and that’s going to be these two here which say Increase
Decimal or Decrease Decimal.
Let’s say that I take this right here and I make this number $220.89. Obviously that changes the
answer and you have $0.89 at the end there. But let’s say that I don’t really want to show the
cents on my spreadsheet even though I need those to get to the actual closest dollar amount. I can
actually take away a place behind the decimal point or add a place behind the decimal point.
Notice this one is increase and this is decrease. I’m going to go ahead and decrease decimal and
notice now it looks like $220.90. But it didn’t change the value of the number. Look, it’s still
$220.89. So that doesn’t change my answer.
Let’s say I go one more time. Notice now it looks like $221. Again it did not change the value,
just what it looks like.
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We call this little feature Displayed Value versus Actual Value. And if I want to bring those
decimal points back I could just use the Increase Decimal and then I can get it back to where it
was before.
Well that’s how your number options are going to work in Excel. You’ve got tons of them there
so make sure that you make the numbers look exactly the way you want them to look.
Let’s go ahead now and move over into section three and we’re going to talk about working with
borders and shading.
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Video: Borders and Shading
Cindy: Welcome back. We’re working in module ten and we’re talking about formatting your
worksheets in this module. We’re all way down now to section three where I want to talk to you
a little bit about borders and shading.
Often people ask me, “How do you print the boxes that are around each cell?” Remember that
those are called gridlines and they don’t normally print. If you want them to print you have to
actually select the cells you’d like to put borders around and then apply borders. The shading is
actually going to be the color or whatever you put inside of the object. Let me show you a little
bit about how to use borders and shading to enhance your workbooks.
The first thing you need to know is that borders are always around just your selection. Let’s say
that I’d like to put a border around all of my totals, averages and highs here, just like a big box
around these so they stand out a little bit. Your Borders button is going to be under your Font
grouping here and you’ll see the dropdown where you’ve got different types of borders you can
apply. Notice you can put a bottom border on. That would be just on the bottom of the selection,
not each cell in the selection. I can put just a top border, just a left or a right. The No Border
option is the one you choose if you do apply a border and then you don’t like it you can set it
back to No Borders.
The All Borders choice that I’ll choose in this case will actually put a border around each cell in
your selection. Let’s say I don’t like that. I really wanted a border just around the actual selection
itself, like a box. I would go back and I would choose No Border to take it off and then I would
go back and choose either Outside or Thick Outside Border. And this one is the thick outside
border and that will print.
Your other choices that you have here, you’re going to have a choice to put a bottom double
border, maybe a thick bottom, you’ve got a top and bottom, a thick top and bottom, and then top
double border. A good example of a bottom double would be this. Let’s say under the last name
here I go back and put a bottom double border and that would look like this.
The next thing I want to talk about real quick is your shading. I’m going to go ahead and select
the same area and if you see this bucket of paint this is your shading. Your shading is the color or
whatever you decide to put in the background of your cells. Let’s say that I want to choose a
really light color like maybe I want this blue right here and I can just choose that and click away
from it and now you can see that I’ve got black text and a blue background.
Now you’re always going to have more options if you go through the little arrow on the bottom
right corner of your Font grouping. I’m going to click there and notice that when it takes us in
here it doesn’t take me directly to the Border tab. I’m going to have to click on it.
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I’ve got a lot of extra options here that I don’t have with my button on the Ribbon there and the
first one is the style of the box that I have. Instead of just a straight line I can choose any of these
different styles and I can also pick a color for my border.
Now if you pick a style and a color and you just click OK nothing is going to happen because
you have to go over in this Preview and click on the Borders you want to be that style and color.
So notice that I could actually make all four sides different if that’s really what I wanted to do.
Notice I’ve just changed my style and color and now I’ve made top and bottom look different.
I’m going to click OK and then click away from it so you can see what you’ve got.
Let’s go back in there. I’m going back to the arrow under the Font grouping, I’m going to the
Border tab and now I want to go over to the Fill tab real quick because I want to show you that
instead of just picking a color I can do a couple of fill effects or use a pattern.
Here’s the different colors that we can choose from and here’s fill effects. Fill Effects allow you
to mix and match two colors. Let’s say you want to use this yellow and maybe we want to use
this particular blueish-gray color. Now that I’ve got two colors I can also tell Excel how to shade
those colors within my selection there. I can have them go horizontal, vertical, diagonal, up or
down from the corner or from the center. I’ll choose from the center and click OK and now
you’ll see that you’ve got this little patterned effect.
Now you also have another option with the Fill. I’m going to go back in there, I’m going to click
the arrow to the right of Font, I’m going to the Fill tab and I can also pick a pattern. If you
choose a pattern you’re going to be picking a pattern from this dropdown here and then you’re
going to be picking a pattern color. That means the color of the dot itself or the stripe itself that
you see in that pattern. And then click OK and now you’ll see that you’ve got a little patterned
effect.
So you can get really creative with all of this.
Now I wanted to show you one more thing you can do with borders because you can actually
draw your own borders.
If I go back to my Border tool here you have a whole section down at the bottom that says Draw
Border. And notice you’ve got some buttons where you can draw the border, you’ve got an
eraser, a line color, all of that stuff. I’m going to click on Draw Border and notice my mouse now
looks like a little pencil and I can click and drag to create any borders that I would like. Notice
then I can drag down if I want or I can drag back this way. But what’s cool about this is I can
create a little patterned effect if I like that looks something like this. And that way I’m not stuck
with straight borders that go on top and bottom, left and right.
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Now I do have options to change the pen color. If I go back up here I can come down and choose
the option that says Line Color, which is your actual pen color. And let’s say I make it green.
Notice now if I wanted I could go down and I have a new color here I’m working with.
Now let’s say you get a line like that and you want to erase it. All you have to do is go back to
your Borders tool, grab the Eraser Border and you just drag across that line you drew and that
will actually erase it. And then you can turn your mouse back to the pen if you want and that way
you can use it to draw again.
So that’s how that’s going to work. You’re going to be able to draw your own borders.
Well let’s go ahead and wrap up this section on borders and shading. We need to move on and
talk about formatting as tables.
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Video: Format as Tables
Cindy: We are working in module ten and we’re talking in this module about different ways to
format your worksheet. We’ve gone all the way down through section one where we talked about
formatting your cells, we talked in section two about formatting your numbers, and then in
section three we just covered the borders and shading option. Now that’s a lot of different
formatting options that you can do but what if you just don’t have time? Well Excel has some
prebuilt ones that you can go in and actually use and then you can customize those if you like as
well. Let me just go ahead and show you where all those options are.
Okay I’ve got this little table here that represents the payroll for the company called Books and
Beyond and you can kind of see the different headings, the first name, the last name, the
division, things like that. To us this is what we might call a table but to Excel it’s not really a true
table at this point. It’s just a range of cells that we have some data in. I want to show you how to
convert this to a table and then some of the different things you can do with a table.
All you need to do is be clicked inside the table before you start and under the Insert tab this first
grouping is your Tables grouping and then you’ll have a Table option that I’m going to click on.
And notice that it already goes and selects my whole entire range here because I started by
clicking in the range.
Now my table has headers at the top so I’m going to go ahead and make sure that my table has
headers is selected and click OK. And now this is what an actual Excel table looks like.
Now we haven’t talked about some of the features here, like these dropdowns for example.
These allow you to filter out data that you would like to see. We’ll get into that a little bit later.
That’s turned on automatically when you have a table.
One thing I wanted to show you is when you actually scroll up notice that your headers here,
when you scroll up, become instead of column A, column B, column C, they’re now at the top
there. And that’s automatic in a table. So as you scroll down you’ll know exactly what data is
below which of the column headings there. That is really a cool feature about a table.
But here’s what I wanted you to notice. You now have your Table Tools contextual tab here and
there’s a lot of different options you’ve got and I want to go through some of these with you so
you’ll know exactly what you’re looking at here.
First of all if you notice the way this looks, every other row is like a blue color and then in
between is the white ones. That’s because you have banded rows. That’s what this is right here.
And where it says Header Row that’s this row right here. And we told it that when we actually
told it to convert this to a table. But notice you could go in and do all kinds of things. Like if you
wanted first column, notice when I check that that this column becomes bold and that way you
can read across a little more easily. You do have what we call Total Row. So if you have some
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totals down at the bottom you’ll see it actually put that double border there and made that a total
row. Each of these you can turn on and it creates a certain style for your table.
Now let’s go over and look real quick at some of the other options, specifically right here where
it says External Table Data.
First of all Refresh means that if you had a formula and that formula pulled data from another
sheet you might want to refresh the data here. It doesn’t automatically update. Also Export
allows you to export your table to a SharePoint list if you want to.
The other thing is over here. We’re going to talk about Pivot Tables in a later module but you do
have the ability to remove duplicates. So it’s going to pick up any columns, it’s going to look
down that information in the column and if it sees any that it thinks are duplicates it’s going to
let you know and then you can do what you want to with those duplicates. You can also just
convert this all back to a range if you wanted. All the data is still going to be there. It’s just going
to be a range and Excel won’t see it as a table.
Over here you’ll notice you have different table styles and you can see there’s a dropdown. If
we’d rather have this orange color instead of the blue we can just choose that. Or you’ll notice
that maybe you want to have this green color. You can choose that. So you have different styles.
You also have the ability to go down to the bottom where it says New Table Style and go
through and actually create your own. The first thing you’ll want to do is give your new style a
name. I’ll just call mine New Style. And then I have the ability for each of these table elements
to go through and make some formatting changes. Let’s say, for example, I wanted to have the
header row a certain color. I can go ahead and format that. And I might decide that I want a
yellow on the header row, for example. If I want fill effects I can go ahead and choose those.
Maybe I want a yellow and a lighter blue like this. Any of these options I pick will only affect
the header row in this particular case. Notice I could then go in if I wanted something to affect
what they call the first row stripe. Then I can go ahead and format that. And I’ll be able to go in
and make those whatever color I’d like as well.
When I click OK and then click OK again it’s not going to automatically apply it. You’re going
to notice that on your Table Styles you now have a Custom Style. And you can click on it and
then you’ll see that’s the style that you chose.
You now have lots of options when it comes to table styles that you can use.
That’s pretty much what you’re going to be able to do with your tables right now. Let’s go ahead
and wrap up this particular section and I want to take you over to section five and talk to you a
little bit about using the Styles feature.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Using Styles
Cindy: We are working in module ten and in this module we’re talking about formatting our
worksheets.
We’ve done a lot of individual formatting for our cells and our ranges of cells but if you want
some quick ways to format your ranges and make them look nice you’ll want to use Styles.
We’re in section five now and I’m going to show you how to use the Styles feature to format
your data in Excel.
We already know that we can go ahead and choose manual formatting for our file. We can go
ahead and for example if we wanted these to be bold we could choose that, if we wanted them to
be italics, we could put a color back there, but all of that is time consuming and if you need a
quick way to just apply a really nice format to your entire table or range or whatever go ahead
and select it first and then you’ll be able to use the styles that you see here under the Home tab.
Now a style is basically a group of formats they’ve put together and given a name. And you can
go ahead and use some of those. You area always using the normal style to begin with and that
basically means that your text is going to be the font Calibri, it’s going to be size 11 like you see
here, the text will be black, your numbers are considered generic. All that’s part of the normal
style. I can go and choose any of these that I like and then I can edit whatever I choose.
Let’s say that I go up and I pick this neutral one right here. Now it’s got a little bit of color back
there but I think I want to make this look a little bit different. Let’s say I take everything that’s
here and I make it bold and I might want to center it within their respective cells like this. I may
want to do something like put a border around this area since those are my actual numbers that
I’m working with. I’ll go and apply a thick outside border. It could be that all of these numbers
represent dollars and I could go in and change this as well. There’s just a lot of things that you
can do. And remember that if you see these pound symbols that means the column is not wide
enough and you can just double click the line to the right of the column heading to change the
column width.
There’s a lot of things you can do with this. You just want to go and jazz it up. Keep in mind that
if you use one of these styles and you’re spending all of this time reformatting some pieces of it
then you may want to not use Styles at all in that particular case.
Now you do have the ability with your Styles to create a new style. Let’s say, for example, I’ll
take all the formatting off of this. I’ll just go to Clear the formatting.
Let’s say that you create your own. You spend a lot of time working on this, you’ve made this
bold, it could be that you’ve indented these a little bit, it could be that you’ve bolded them,
italicized them. Maybe all of these are dollars. And you’ve created this new style that you’d like
to use on a regular basis. All you have to do is select those cells using that style and go ahead and
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say New Cell Style right down here at the bottom. You’ll notice that what this does is allows you
to name your style. I’ll say My Style. And then if I don’t want to include some of these options
or maybe I do then I will turn these on or off and I’ll click OK. And now what happens is when I
look at my Style list I’ve got this one available to pick any time I’d like to use it.
And that’s how the Styles work. They’re just predesigned and it’s a set of formats already
grouped together and given a name. And now you know how to create your own.
That’s really all I wanted to tell you about Styles. Let’s go ahead and go over to section six and
talk about how to use the Format Painter option.
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Video: Using Format Painter
Cindy: We are working in module ten and in this particular module we are talking about all the
formatting options that Excel has available to use. We’ve made it all the way down now to
section six where I want to talk to you a little bit about using the Format Painter option that
Excel has. And you will have this option in all the Microsoft Office products.
When you do a lot of formatting a lot of it’s time consuming, especially if you have several areas
where you need to use the exact same formatting. You can actually use the Format Painter to
help make that process a little bit easier. Let me show you how working with the Format Painter
actually helps out.
In this exercise we have two different divisions of our company. There’s our Books and Beyond.
We’ve got the Northeast Region at the top here and if I scroll down you’ll see there’s the
Mideast Region down below. And it looks like we did some formatting up top but we didn’t
really do any formatting down below.
Let’s say that I’m looking at this and I’ve got January formatted the way I’d like. You can see
there’s a color in the background, I’ve rotated my text a little bit. There’s also a particular color
and font that were used and I’d like February, March, April, and Totals to be the exact same. I
don’t really remember what the colors are that I chose here and I don’t remember the font. I
could actually copy all of the formatting from one place to another. Here’s how this works.
You start by selecting where you’d like to copy from. In this case where it says January, and this
is your Format Painter. I’m right here on the Home tab on the Clipboard grouping. If I click on
that notice my mouse has a little paintbrush attached and I can now click in any of these and it
will have the same formatting. I could go ahead and turn this back on and click on February.
And you’ll see that when you do you this that it actually works one time and turns itself off. A
little trick to help you out. When you first turn on Format Painting double click and then it will
stay on until you turn it off. So notice that I could now scroll down if I wanted and come down
and get January, February, March like that. And to turn it off you would just go back and click
on Format Painter or hit Escape on your keyboard. Either one would work.
Now I could do that but what if I have a lot of different regions that I want to look exactly the
same. That’s a lot of work. I wanted to show you that you can actually use Format Painter when
you’re working with a range of cells as well.
If I go ahead and select from B2 all the way down to G16 I’ve now selected my entire table. All I
have to do is click on Format Painter and then scroll down until where I see the Mideast Region.
Now here’s where I want to click. You want to click where this starts. I’ll click in B18 and you’ll
notice now that the entire Mideast Region now looks just like the Northeast Region up at the top.
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A couple of things that you need to know about this. First of all don’t try to select something
when you’re pasting this because it’ll only work on the cells you have selected. As long as you
click where you want to start it’ll fill down and across for you. You don’t have to worry about
that.
The other thing is there’s one little caveat here. I actually added row eight and that’s where I put
Newberry. If you remember us doing that back up in section one, that means that we now have
five names here and we have five names here. If you only had four names in the top and five on
the bottom what would have happened is when you copied the formatting it would have actually
not had any formatting on the bottom row and actually every row would have been off one. The
caveat is that you have to have the exact same amount of columns and rows when you do this or
it’s going to turn out a little funky looking and you might have to go in and manually make some
of those changes. But that’s the quick way to use your Format Painter right here.
All the Microsoft Office products have it and you’ll want to make it your best friend in any
program you’re working in.
That’s all I have to say right now about using Format Painter. Let’s go ahead and wrap this up
and we’ll move over into section seven and talk about protecting your sheets.
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Video: Protecting Sheets
Cindy: Welcome back. We are working in module ten and in this particular module we’ve been
going through all the options that Excel has as far as formatting your worksheets. This is going to
be section seven. I want to show you a little bit about the protection option that Excel has to
offer.
You have the ability to protect the sheets you’re working on, you have the ability to protect the
cells you’re working on, and also workbooks themselves. Let’s go ahead and flip over to Excel
and I will show you how the protection option works in Microsoft Excel.
I mentioned to you that there are three things you can have Excel protect. Excel can protect a cell
or a range of cells for you, it can protect a sheet, and it can also protect a file. Let’s go ahead and
start with a sheet and before we do that let’s just take a quick peek at how the exercise set up.
This looks like a company called Benjamin of Brussels. It’s their international chocolate
distributors and it’s the Southwest U.S. Regional Sales Report. In column A it looks like they’ve
listed the name of each of their sales people. It looks like they’ve got their figures for each
person for April, May and June across this way and there is a formula over in column E that adds
up April, May and June. If I double click you can see that formula. There’s also formulas in
column F and over in column G as well.
Over here they’ve got some commissions. You can see there’s a quota and a commission rate of
18%. You can see they’ve got a little bonus table here as well.
Now what I’d like to do is I’d like people to be able to type in these cells because we need these
numbers to get our totals, commissions and then to work on the bonus a little bit later. But what I
want to do is I want to protect all of these so that people can’t type in there.
Now some reasons for doing this. If you write formulas one of the things you’re going to find is
that sometimes it takes you a while to get the formula correct. And once you figure it out you
don’t want to accidentally type over it and lose what you did. Or if you share the file with
someone else you wouldn’t want them to be able to accidentally or on purpose delete or edit
those formulas you worked so hard for.
The way this is going to work is that you’re going to go through and you’re going to unlock all
the cells that you’d like people to be able to type in. Now I know that’s going to sound
backwards but here’s how it works. In Excel all cells are locked automatically, even if it’s a
brand new file you just created then all cells are locked. You don’t know that because in Excel
it’s a two step process. You have to unlock the ones you want people to type in and then you
protect the file or the sheet. If you don’t do both of these you won’t be able to tell if your cells
are locked or not because Excel will let you type in any cell.
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As far as selecting the ones that you do want people to type in there’s a lot of cells here. I could
do something like this. I could actually hold the Control key down and then I can go ahead and
select all the names like this, I might select all this across this way. It might be that I want people
to type over here, but my point is you can see that I’m holding Control and it’s taking a little bit
of time to select all the cells I’d like to unlock. These cells are what we call Constants. They are
cells that have something in them that are not formulas. Instead of me doing this manually Excel
will actually do this for me.
On your Home tab if you go all the way to the right you’re going to see an option that says Find
& Select. On this dropdown if you choose the Go To Special option you’re going to see several
things here that Excel will just go to. And some of these we’ve talked about and some we will
talk about coming up in some later modules, but starting with Comments and then you’ll see
Constants. That’s the one we’re going to choose. But notice that you could also select just the
formulas for whatever reason. You can select just the blank cells. You can select all the objects
that you have on this particular sheet. And you can see some other things you can select as well.
We’ve chosen Constants. I’m going to click OK and now look at everything Excel has selected
for me. The only thing it left is the cells that have actual formulas in them.
Now we’re going to go and unlock these. On the Home tab go to the grouping that says Font and
click the arrow on the bottom right of that grouping. That takes you into the Format Cells options
and the last tab over says Protection. You want to make sure this is unchecked. And then you’re
going to click OK. And now all of those cells are unlocked. Let’s go and try it out.
Let’s say that I want to type something in E6. I’ll just put the number two in there. Oh, it let me
type in there. Did you notice that? And that’s because even though I unlocked this I didn’t do the
second step yet of protecting. So let me go ahead and undo this and let’s go do that second step.
The way you’re going to get to the Protection options is you’re going to go to the Review tab and
then you’re going to see a grouping here that says Protect. I’m just going to protect the sheet.
When you choose that option it will ask you to set up a password. I’m not going to do it right
now because I’ll probably forget it but in real life I want you to go ahead and do that because
especially if you shared this with someone else you don’t want them to be able to go in and just
unprotect it. It’s kind of pointless if you don’t have a password here.
I want you to notice that it says it’s going to protect the worksheet and the contents of the locked
cells. It also has the first two selected, Select locked cells and Select unlocked cells. And I would
just leave it where it defaults and click OK.
Now let’s try it out. I want to type something again in E6. I’ll put the number two in there. And
now you’ll see that I have a message basically saying that this particular cell is protected. And in
order to make the change I’d need to unprotect it. Remember if you’ve shared this with someone
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else and you’ve set a password they won’t be able to unprotect it unless they know the password.
And that could be a good thing if you’re sharing files.
Now remember that I do need them to be able to type over here because we want the answer to
update. I’m going to go ahead and put 50 here and you’ll notice that it does change this total.
That works perfectly. That’s exactly what we want it to do.
Now how do I know if this sheet is protected? All I have to do is look up here and if it says
Unprotect that means it is protected.
Let me go ahead and mention a little bit about protecting the workbook. If you’re sharing this file
with someone then one of the things you might want to do is protect the whole workbook. Maybe
you want to keep people from deleting some columns or rows, you might not want them to add
or delete some sheets in there or move things around. It could be you just want them to view the
data. That’s an example of protecting the entire workbook so that none of those types of things
would happen.
Now I also want to mention a couple of these. You do have the ability under the Allow Edit
Ranges, if the protection is not turned on yet then what you can do is you can go ahead and set
this up so that certain people that you share the file with you may want them to be able to edit
certain ranges that you had predesignated before you turned on the protection. Also you can unshare the workbook.
These two options here you would need to be set up on a SharePoint server in order to use them.
Just so you’ll know what that means, in all of the Microsoft Office products if you’re setup on a
SharePoint server then you have the ability as the administrator or the owner of the file to share
your files with others and then all of you can work simultaneously in the same file. You would
be the owner. If changes are made you would be notified. And at the very end when all the
changes are finalized you would be able to go in and finalize the whole entire workbook or
document if you happen to be working in Microsoft Word. Again, you have to be on a
SharePoint server in order for some of these options to work.
That’s pretty much what I wanted to tell you about protecting your cells, sheets and files. What
I’d like to do is go ahead and wrap up section seven here and we are going to go over to the last
section, section eight, and talk a little bit about the fill handle and how the custom list work in
Excel. I’ll see you shortly.
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Video: Fill Handle and Custom Lists
Cindy: Welcome back. We are working our way down through module ten where we’re talking
about how to format our worksheets. We’ve talked about a lot of different things already but I
want to take a few minutes and talk to you about how the Fill Handle actually works and then
we’ll talk about how Custom List work. Now both of these go hand in hand. That’s why I wanted
to talk to you about these at the same time.
If you remember the Fill Handle will actually let you copy whatever is in the cell you’re clicked
on. Also there are some predesigned lists that we kind of mentioned in an earlier module. Let’s
go ahead and get started and I will show you how the Fill Handle works.
If you’re clicked on a cell you’re going to notice on the bottom righthand corner of that cell is a
little box and we call that little box your Fill Handle. We’ve talked a little bit about this in
previous modules but remember that the Fill Handle will do one of two things. It will copy
whatever is in the cell you’re clicked on, and remember you could have just a number or you
might have some text or you might have a formula. The other thing is there are some predesigned
lists already in Excel. Those are days of the week, months of the year. And if you type any of
those from one of those lists then it will copy that list for you. Let me give you an example.
Let’s say I put Friday in here and whether I hit the Enter key or not I can drag that Fill Handle
down and it will continue that list for me. Or notice I can also grab it and go across this way.
You just can’t go diagonal. It won’t work like that. But you can see that it continued the list for
me.
Now the abbreviations also work. Let me go ahead and select this and hit Delete. Let’s say here
that I typed Sat for Saturday. Well all I have to do now is drag my Fill Handle and you’ll see it
completed the list for me. And again that’s because that is a predesigned list already set up in the
custom list we’re going to look at in a little bit.
Let’s talk about numbers for a moment. Let me go ahead and delete what’s in here.
Let’s say that you wanted to number something. Let’s just say one to ten. If you just type the
number one and hit the Enter key when you go back and try to drag your Fill Handle it’s going to
actually copy whatever was in that cell and that’s because it doesn’t know in what sequence you
want to type your numbers. If you want it to count for you, you have to type in a particular
sequence. If I type one and then I put two in the next cell and then I go back and select both cells,
that’s the trick is you have to select both of them so it knows in which sequence you want to
count. Now drag the Fill Handle and it will continue the list for you.
This could be any sequence. I might come over here and say 25 and then 50 like this. And then if
I select them both, drag the Fill Handle you’ll see it’s counting in this case by 25s. It’ll also
count negatively. What if I typed six and three? And then I do the same thing it will go zero,
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negative-three, negative-six, all the way down. So you can pretty much have it count in any
sequence that you would like.
Now let me go ahead and delete all of this. I want to take you into where these lists live basically
and how you can actually work with these lists if you want to make some changes, add your own
list, things like that.
Where we’re going is to the File tab and we’re going to the Options in Excel.
When we get in here what you want to do is you’ll notice there’s some options on the left. You
want to choose Advanced and then you want to scroll all the way down to the bottom and start
looking up because you’re looking for right here where it says Edit Custom List.
Here are the days of the week, months of the year that I mentioned and that’s why it works if you
type any one of those and then drag your Fill Handle.
You do have the ability to create your own list. Now notice you can’t edit these lists. These are
the ones set up in Excel. But if you’re clicked on New List here you can type your new list over
here.
Let’s say that you wanted to add three departments. We’ll put in Admin, we’ll put in
Maintenance, and we’ll do Personnel. We’ll just do it this way. Now all you have to do is hit
Add over on the right and you can see that it has added your list to the custom list. I’m going to
click OK and then we’ll try it out back here.
Anywhere in my spreadsheet I’m going to type any item from that list. I’ll do Maintenance, MA-I-N-T, and you’ll notice that once you do this and grab your Fill Handle it will continue that
list for you.
That’s great if you have a list that you type repetitively and you’d like to be able to start with any
item in that list.
Now let’s say this. Let’s say that over here you already have a list set up. Let’s say that that list is
a list of first names. We’ll put in here Allen. We’ll say Larry and we’ll say Melody. If I already
have the list set up I don’t have to retype the list. You can just open the file the list is in and
select the list. When I go back to the same place, I go back to File, the Options, I want to use the
Advanced option here I see on the left, scroll down to the bottom and look up until you see this
button that says Edit Custom List. Now if you look down here you’re going to see this range here
and that is the range you actually have selected. All you have to do is hit Import and you’ll see it
brought your list in for you. Now you just click OK and OK again and the list is in here. Let’s try
it out over here. I’m going to put in Larry and let’s go ahead and drag the Fill Handle and see
what happens. And you can see that once it goes to the bottom of the list it repeats the list again
for you. And it’s always going to start with the one that you actually type in.
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Now let’s say that you want to delete one of these lists. I’m going back to the same place. I’m
going back to Options. I’m going to use the Advanced option on the left, scroll to the very
bottom and look for Edit Custom List. You can’t delete the ones that Excel put in but you can
delete the ones that you just put in. You will not delete where you’ve used the list in any of your
workbooks. You will only be deleting it from this place so that you can’t use it again in the
future. I’m going to go ahead and hit Delete over to the right and it does warn me that my list
will be permanently deleted.
Let me try one more. I’m going to hit Delete and click OK and then it will tell me the list will be
permanently deleted. I’ll go ahead and click OK and OK. And you’ll notice that back in Excel
the lists are still here but they’re not over in the Custom List anymore.
Now one thing to know is the custom list is for all of Excel, not just the file you’re clicked in. so
you wanted to go ahead and just set them up you could and then you can just use that Fill Handle
in any workbook that you happen to be working in.
Well that’s a quick wrap up of module ten. I want to go ahead now and take you over into
module eleven and we’re going to talk about in module eleven about working with charts.
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Video: Module 10 – Practice Exercise
Cindy: All right. We have finished module ten now where we’ve been talking about formatting
your worksheets. We did a lot of formatting in this particular module and I have a quick exercise
I want you to do just to make sure that you’re okay with how to apply a lot of those formats we
talked about.
I’m actually going to have you take this file called Books and Beyond Regional Report, open it
up and then you’re going to format each of these tables. I’ve got instructions over in the Word
doc on what I want you to do. But you’re going to start with things like taking your titles here
and merging them across your table. You’re going to add some borders, you’re going to add
some colors, dollar signs to all your numbers, all kinds of things like that to make it look really
nice.
When you’re done you’re going to actually use the Format Painter to copy all of the formatting
you did from the Northeast Region down to the Mideast Region down at the bottom.
Make sure you look at the solution to the exercise so that you know what it should look like
when you’re done.
After you’re through formatting your worksheets here let’s go ahead and move over to module
eleven and then we’ll talk about charts.
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Module 11 – Charts
Video: Creating Charts
Cindy: Welcome to module eleven and in this particular module we’re going to talk a little bit
about working with Charts. All a chart is is a visual representation of the data that you have
selected. You can have a little bit of data and come up with many different charts related to that
particular data because it’s all based on the areas of that data that you have selected. Let’s go
over to Excel and I will show you how to create some super simple charts.
Let’s take a quick peek at how the exercise is set up before we start creating a few charts from
this data. This is our company Books and Beyond. It looks like they are tracking their quarterly
sales report. If you notice column A has each of the locations, row five across has each of the
quarters and then look at column F, it looks like they totaled across, and row ten at the bottom
they’re actually totaling each of the quarters down.
A couple things to remember about setting up the data if you’re going to create charts from the
data. You want to make sure that you do have row and column headings. Here are my row
headings here and here are my column headings here. What’s going to happen is if you don’t
have row or column headings when the chart is actually created you won’t know what the data
actually represents. You’ll see when we get our chart in that because you have these row and
column headings you will then have what we call axis in your chart.
Charts are always based on what you have selected. You could just one area selected and create
some charts or you might have different selections and create charts based on that. And we’ll do
a few of those so you’ll get a feel for how this works.
I want to start with a simple, basic column chart. I’d like to chart each of my locations and
quarters one through four. I’m actually going to select the range A5 through E9. I want you to
notice that I’ve actually selected the locations or the headings over here and I’ve selected quarter
one, two, three, and four here so that I can see those actually in my chart. I didn’t select just the
data.
Now a super quick way to create a basic column chart on its own sheet is on the keyboard use
your F11 function key. I’m going to go ahead and do that now and hit F11 and now you’ll see I
have a basic column chart. When you look at this you can see each of the quarters and at the
bottom here you can see which countries are represented by the different colors.
The big thing I wanted you to notice is that we had our data a second ago over here on this chart
data sheet and when you use F11 to put in a chart notice that it gives it a name, Chart1, Chart2,
Chart3, whichever one is next. You’ll want to go ahead at some point and rename those sheets so
you’ll know what’s on each sheet.
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Let me go back to the chart data sheet. That’s an example of one selection. Let’s do one where
we have multiple selections.
Let’s say I’d like to only chart quarters one and four. I’m going to select my first range being A5
through B9, then I’m going to hold the Control key and I’m going to select the range E5 through
E9. And now you’ll see that these are two different selections. If I do the same thing I’m going to
hit my function key which is F11, notice now I have another chart sheet. Notice this one is
Chart4 down here at the bottom. And notice I’m only tracking quarters one and four for each of
my divisions here.
I’m going to go ahead and rename these. I’m going to name this one, I’ll just call them Chart and
then I’ll say Quarters 1 & 4. And this first one here I’ll just call it Chart and then we’ll call it All
Quarters. How’s that sound? Chart All QTRS. Now I know what’s on each of my sheets.
Let’s take a quick look at this chart and get some terminology.
I want you to notice first of all that these are my axis. You have your X axis and your Y axis and
here’s how you know the difference. Your Y axis goes up and down this one in this case. Y
always represents the values. You can see the values here on the left. Across this way are my
categories. Quarter 1, Quarter 2, Quarter 3. X always represents your categories. Y represents
values and X represents categories. You can have charts where it might be reversed, where the
values may be across the bottom and you might have your categories up, then that would be
reversed. Sometimes you might have a chart with a little 3-D effect. If it does you’ll have a little
3-D right in the corner here and that would be what we call your Z axis. A pie chart, which is
round, would have no axis. So just know that term when we’re talking about charts.
Another term to be familiar with is what we call the Legend. So where it says down at the bottom
each of the divisions, Australia, Germany, Canada, Great Britain. That’s the legend. You might
have your legend appear on the right sometimes. You might not have one at all. There’s just
different ways you can make this appear.
In the chart itself you’re going to see these lines here which we call gridlines and you’ll notice
that I clicked on them and when you select a gridline they all have these little dots on the ends.
That’s how you know they’re selected. So that if I didn’t want them for some reason I could just
hit Delete on my keyboard.
The area that would be behind the gridlines, which is actually behind each of these bars here is
what we call the Plot Area, and then the gridlines would actually sit on top of the plot area and
then these bars would sit on top of that. So you actually have like three layers when you’re
talking about charts.
This one actually has a title at the top as well, which you could type over that if you wanted to
give it a title and just call it whatever you like you could.
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Let me go back to the chart data sheet. Those were two examples of column charts that are on
separate sheets. Let me give you an example now of what we can an Embedded Chart.
An embedded chart appears on the same sheet as your data. Let’s say that I only wanted to chart
my locations. I’ll then hold the Control key and come over and get my totals. Just the locations
and the totals is all I want to chart. This time I’m not going to use my F11 key. F11 will always
give you a column chart and it will always be on a separate sheet.
The way you would actually put in a chart, if you go up to the Insert tab you’re going to notice
that you have a whole area here where you have all kinds charts you can put in. And if you
notice one of these looks like a pie chart right here. And let’s say I’d like to put in this one right
here, which is a three-dimensional pie chart. You’ll notice that now the chart is actually on top of
the data. It’s on the same sheet. That’s called an Embedded Chart.
You’ll notice that it’s really bit and it’s on top of my data. I can actually do a couple of things. I
can change the size by grabbing one of these circles on the edges. Those are called Control
Handles. If you don’t see those it might be because you’re clicked back in your data. Just click
back in the chart itself and now they’ll pop up. See how if I grab one of these I can drag down
like this and change the size of the chart. And that would just be up to you whatever size you
want the chart to be.
You can also move this chart. Notice I can click right in the middle here in this white area and
click and drag and maybe move it down here like this. And then if I wanted of course the size to
maybe line up at the edge of my column F there I could do that.
So you can see that now I have my data here and I have my chart here.
Charts and data sheets are linked. That means if I change the data here it’ll change the chart. Let
me give you an example. Let’s say that I change Australia’s quarter three and let’s say I change
it to 10,000. What I want you to notice is that this piece of the pie actually changed. Look at that.
And if I flip over to the chart All Quarters you’ll notice that now this bar actually reflects the
new value. If I look at Quarters 1 & 4 you’ll notice the same thing. And then back to chart data
over here. Now let’s say I put it back and I make it 3,000. I want you to watch that blue piece of
the pie down there. It’s going to change. And now you’ll see it reflects the 3,000, and these will
as well when I go back and look at these.
When you’re printing your chart, if you’re on a sheet that has the data and the chart if you’re just
clicked on the chart itself you’re going to print just the chart, you won’t print the data. If you’d
like to print both the data and the chart make sure you’re clicked out to the side and then you’ll
be able to print them both. I’ll go ahead and do a Print Preview and just show you. I’m going to
File, Print and now you’ll see that you’re printing both the chart and the data like I said.
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What I want to do now is take you over into section two because there are different types of
charts that you can have. We’ve looked at column charts and a pie chart already but there are
several different ones. Let’s go ahead and go over to section two and I will talk to you about the
different types of charts you can put in in Excel.
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Video: Types of Charts
Cindy: Okay welcome back. We are working in module eleven and we’re talking about charts in
this module. We’ve already gone through section one where I showed you how to create charts a
couple of different ways. Now what I’d like to do is talk to you about all the different types of
charts that are available in Excel. In section one we actually had done a column chart and we had
put that on a separate sheet and then I showed you how to create an embedded chart and we used
a pie chart as an example, but there are so many different types. Let’s go ahead and flip over and
I’ll show you the different types of charts that are available in Excel.
When we were in section one we only briefly looked at two different types of charts. We saw the
pie chart like you see here and we also saw the what they call Clustered Column Charts and
that’s where we did our chart All Quarters and Quarters 1 & 4. But I want to go in and show you
some of the other different types that are available in case you want to switch these out or maybe
put in some new charts.
If you’re under the Insert tab you’re going to see the Charts grouping right here. You can access
a lot of the different types of charts from here. Notice that we’ve got Column Charts. Over here
we’ve got what they call Scatter Charts. These are 2-D Line Charts. These here are what they
call Combo where you can have a combination of maybe a line and a clustered column. You’ve
got Charts right here which are your pie charts, but I want to take you in right here and show you
some of the other types of charts that are available and some of the options just in case you want
to take this a little bit deeper.
The first thing I wanted you to notice is there is a tab called Recommended Charts. That would
have been the same thing as clicking right here. These are several that they recommend for your
type of data. All you have to do is click on one of these and you can see a preview on the right.
You can see this particular one here is a cluster bar chart. And a bar chart is basically one where
the axis have been switched. Notice you have your categories on the left now and your values
down on the bottom. But if you don’t want one of these just go over to the All Charts and look
through all the charts that are available. Notice it put me on a pie chart because that’s the
particular one that I’m clicked on, but let me just go down the list real quick with you.
Here you’ve got Recent. These are some of the recent ones that you might have used. Like
there’s our pie chart. Notice if I move my mouse over these you get a preview of them. But I can
also click on these different ones here if I decide to change the type of chart. Maybe I want a
scatter chart instead, I could use that.
Skipping over templates for a minute, I want to go down to Column. These are the basic cluster
column charts. We had used a quick one when we did our F11 key and it gave us a clustered
column on a separate sheet. But notice there are some variations of this. I might have a stacked
column. A stacked column is where the colors or the categories are stacked on top of each other
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like this one. There’s different variations of that. This one has a three-dimensional effect. Notice
the little area right here. That’s a 3-D.
The next one down is a Line Chart. If you prefer to use the line that actually shows you your
values if they’re up or down you can see that right there. And there’s several variations of the
line chart as well. This one actually has little data points on it as they’re called.
Here’s a pie chart. A pie chart remember has no axis. We’re using a three-dimensional one here
but this is an example of just a regular, plain pie chart right here. Here’s the 3-D one. They’ve
also got one called Pie of Pie. They’ve got one that’s called Bar of Pie that has the bars on the
right. And then this is a donut chart.
The next one down are your Bar Charts. Remember that the bar charts are the ones where they
actually show your axis flipped. Your bars instead of going up and down they’ll go from left to
right. Then you have area charts which look like this and you’ve got several variations of these.
The next one down are your XY Scatter Charts. Here if you like to use dots and then maybe
you’d like to also connect those dots with lines like you see some of these, you could do that.
You have Stock Charts. You can see there’s several variations of these as well.
You’ve got what we call Surface Charts and you have to have at least two series of data in order
to use a 3-D Surface Chart like you see here. Here’s a wire frame one and then here’s a contour
and the last one is called a Wire Frame Contour.
You’ve got Radar Charts which look like this. A couple of variations of that as well. And the last
one is a combo where you can actually have a combination if you’d like to have for example a
clustered column and a line together you could do that. There’s a couple of them like this one has
a secondary axis. This one here happens to be a stacked column. And then you’ve got the last
one which is a custom combination.
So you can see there are many different variations of each of these types of charts. I do want to
just mention the templates folder right here. You can actually go through and edit these which
we’ll be talking about in section three. And if you’ve done that you can actually save these as a
template in case you want to use want to use it later on and it would show up in that templates
folder right there.
That’s really all I wanted to show you about the different types of charts that are available. Why
don’t we go ahead now and flip over to section three and let me show you how to edit these
charts because there are a lot of different things you can do to actually make these charts look a
lot nicer. I’ll see you over in section three.
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Video: Editing Charts – Part 1
Cindy: We are working in module eleven and we’re talking about charts in this module. We’ve
already talked about how to create some charts. We’ve already looked at different types of charts
you can create over in section two and now we’re in section three and I want to show you how to
take those different chart types that you’ve put in and edit those. There might be some things that
you want that aren’t currently on the chart that you chose or you may want to move those to a
different area or delete them totally. There’s just a ton of different things you can do so let’s flip
over and start editing some of these charts we created.
The first thing I want to tell you when it comes to editing charts is that there are a ton of different
options. There will be several different ways to get to those options and I’ll show you those
different ways but go ahead and look through them at some point and just see how some of these
options can help enhance the chart that you currently have.
I’m going to go ahead and click on this pie chart we have here and the first thing I want to point
out is that you have this plus sign that let’s you add, remove or change some of the different
elements in your chart. Like if you wanted to get rid of this total here or if you wanted to do
something with the legend you could. We’ll go through those in a second. The little pencil that
you see here is what we call Chart Styles. When we start talking about color schemes and
different styles of colors we’ll use that particular option. And then you can also use this filter
option if you want to filter out data in your chart.
The next place you can go is if you notice at the top you have your Chart Tools contextual tab
and when you click on it there are two tabs below, the Design tab and the Format tab. Let’s start
with this Design tab.
Probably the easiest thing to do is to start with a chart styles right here. There is a scrollbar.
Make sure to scroll so that you can all of the styles.
A style basically means that a group of elements have been put together to create a style. For
example, we’re using the first one and you’ll notice in our pie chart we really can’t tell what
percentage of the pie each of these happens to represent. But if I look at Style 2 or 3, you’ll
notice in 3 that there’s actually a percentage on top of each piece of the pie. Notice the legend
has also been moved over to the right in that style.
When you go across you might like Style 6, for example, or Style 7 is very popular. Notice in
Style 7 that you actually have a darkened background, but you still don’t know which piece of
the pie is represented other than looking at the colors down here and you don’t know the
percentage. So we can actually add those. Those would be elements that we could add with this
plus sign.
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Notice that if you look at Style 8, this particular one doesn’t have the legend anymore but it does
have to the right of each of these the name of that particular piece of the pie. So you can see this
is like a starting point and then you can add things that you might want. I’ll go back and use this
Style 7 here to start with and let’s go down here and maybe add a few things to this particular
chart.
I’m going to hit the plus sign and notice there are three things that I can add or take off. So I
have my legend down at the bottom so I really don’t need this if I’m going to use the legend. I
can take either one of these on or off and I can go back and add them if I’d like to. So you’ll
notice by clicking and unclicking that I was able to actually take one of these on or off and notice
I was able to add data labels as they’re called.
Let’s look at the chart styles option here. These are the same ones that I saw up above. So if there
happens to be a particular one that I like better I can just go and click on it from here. Notice
there is a Color tab that I can click on as well. If I don’t like the current color scheme I might
pick one of these other color schemes.
The last tab at the bottom is the Filters tab. If I only wanted to see Australia and Canada I could
uncheck the other two and only see those in the pie. I would have to hit Apply at the bottom in
order to see that. Filter means you’re going to give it the criteria you’d like and then it will hide
everything else. I’ll go back and turn them all back on and hit Apply again and now you can see
that I see all of the different locations.
Now let’s go ahead and look over at my chart All Quarters and see if there are some options we
can do with this one.
Notice we have our same plus sign over here but I want you to notice this time that I have several
different chart elements I can choose from. Axis, which you do want. Remember your axis are
where you have your Y axis representing the values here and your X axis representing your
categories here. But I don’t have what they call Axis Titles. Let me turn those on so you can see
what those are. You’ll notice over here it says Axis Title and here it says Axis Title. What I can
do is I can click in there and then type in whatever I’d like this to say. I’ll say Categories in this
case and let’s say that I come over on this one and I get rid of what’s in there and let’s say that
we actually say Dollars this way. You can have those say anything you want. They’re just labels
for the categories.
Back to the plus sign. I can add data labels. If you notice I haven’t clicked yet. I’ve just pointed
the mouse there so I can show you what these are but data labels appear on each of the column at
the very end so that you can see the actual value of that particular column. You do have the
option to move those inside of the bars but we’ll see that a little bit later.
A data table would be this. This is the data and then this is the chart. We call this the Data Table
down here.
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You might have what they call Error Bars. You might have Gridlines, which we had turned these
off earlier. We have our Legend turned on. And then we might also add a Trendline. If you add a
trendline you can tell Excel which series you’d like the trendline to be on. Each of these
locations is a series. All the blue ones are a series, all the orange ones are a series, etcetera. And
those are some of the chart elements you can turn on or off for the charts like this. I’ll go ahead
and turn off the data table at the bottom.
Notice the Chart Styles up here. This one here is very popular because you can see it a little bit
better. You’ve got a darker background.
Some other options that you would have. If you look all the way over to the left you have Add
Chart Element. We were able over here to check and uncheck chart elements but here we can
take it a little bit further. For each of these you’re going to have some additional options.
With axis I’m showing the primary horizontal. I can also show the primary vertical if I’d like.
Axis Titles. Notice that I can show them horizontally or vertically. Then I have my Chart Title
and that’s this title right up here. It’s on top of the chart right now but I might choose what they
call Center Overlay which means that it’s on top of the actual chart itself. Or I might turn it off. I
might not want it at all.
We did talk about the Data Labels and I mentioned that they don’t have to be at the top of the
column. It could be inside of the column. You can see that I can choose Center, Inside End
means it’s inside the column but towards the top end, Inside Base means towards the bottom,
Outside End is where we started, and you might have Data Callouts, which are these. I’ll just
choose Inside Base.
Going back we’ve got our Data Table that we turned off but I could turn it back on with the
legend keys or with no legend keys.
Here we’ve got what we call Error Bars and you can have Standard Error Bars, you can have
some that show in a 5% range or what they call Standard Deviation.
Gridlines. I’ve got my primary major on but I could have primary vertical ones. And then
primary minors and I can have them vertical or horizontal. The minors would be instead of
having a line just at every thousand I can have one it looks like in this case at every 200 in there.
The last thing is the Trendline. We do have one. So we have different ways that we can let the
trendline show. We can have exponential if we want. There’s just different ones that we can opt
to show here.
The next thing is the Quick Layout. There were a lot of things that we could turn on as far as
chart elements but some of these layouts will have some of these things already in the layout. For
example, if you look at Layout2 you’ll see that this one looks a little bit different because they
separated the bars a little bit and it also has a chart at the top and the legend at the top. Here’s the
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normal one, Layout3. Let me just go down. I don’t want to look at every single one of these.
There’s so many. But let’s look at Layout9 for example has the legend over on the right. And
then we’ve got Layout11 which also shows you the legend on the right as well. You have
different ones you can pick from so you just pick the ones that you would like.
Now under the Format tab up here you’ve got a ton of options. One of the things that I just did
was I chose an option that made the bars lay on top of each other like this. I can actually select
one bar and you’ll notice that it selects the whole series. See that? If you want to do something
with one bar only go back and click on that one bar and you will deselect the others in the series.
But what I wanted to show you is that if I go ahead and select these bars I can go up and play
with what’s called the Shape Fill and that’s going to be the color or whatever you’d like inside
the bars that you’ve chosen.
Why don’t we go ahead and stop the video here and let’s go ahead and go over into part two and
talk a little bit more about some of the other options when you’re editing your charts.
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Video: Editing Charts – Part 2
Cindy: We are working in module eleven and we’re talking in this module about how to work
with charts. We just completed section three – part one. There were more options as far as
editing charts so I wanted to go ahead and create this part two for you so that we could continue
to see the rest of the options.
One of the things we just did in the previous section was we changed our color inside of our
German division or the German series and we did that by using the Shape Fill option right up
here. In addition to just having a plain color I might decide that I want a picture. That would be a
file that’s already in my computer somewhere and I could pull it in and have a picture inside of
each of those bars. A gradient would allow me to have a variation of the colors. And then I have
an option to actually go through and choose a texture. And you can’t change the color of these
textures but you could use one of these textures if you wanted.
Any time you have a shape you can also change the line around the shape and that’s what Shape
Outline allows you to do right up here. Let’s say I’d like to have this darker color around the
edges. I can just choose that. Now you may not be able to see it very well because it’s very thin
but there is a line around each of these.
Shape Effects, this is going to allow my shape to have a shadowed effect if I’d like. You can
have some where the shadows kind of lay on the ground like you see back here. You might have
a glow around your objects. You can kind of see those right back there. You might even have
what they call soft edges, a beveled look or a 3-D rotation, and any of these would work.
Now we’ve changed some of the options for our actual German division but let’s talk about the
plot area back here because that’s also something we can change these options for. The same
options back here. We can go to Shape Fill, for example, and let’s say that we’d like to have one
of these colors, maybe a lighter blue color. Maybe we want an outline around our shape. We’ll
use this purple right here. And then let’s say we want to have a shape effect. Maybe we want to
have a glow around ours. We could do that as well. Lots of different options and you have to get
in there and just play with these.
I want you to notice a couple of other things you can do. there are Shape Styles. If you don’t
have time to play with the different options like we did you can go through and pick some of
these various styles and just use those instead of manually changing all of the shapes. I’ll just go
up and actually undo that.
Like I said, there area ton of options. You just have to get in here and play with them and really
enhance your charts.
What I’d like to do now is we’re going to go ahead and go over into the next section and I want
to show you in the next section how you can actually use graphics to enhance your charts.
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Video: Using Graphics to Enhance Charts
Cindy: Now that you know that there are all kinds of options you can use to actually enhance
your charts you can actually take this even further by using pictures or maybe some sort of
graphic that you draw to make it even more pleasing. It could be something like you draw some
arrows to a certain piece of the pie or maybe you circle something on your chart. I want to show
you how to use the drawing tools and use those to actually draw attention to certain places in
your chart and make them more visually appealing.
This is actually section four of module eleven where we’re talking about charts.
Using some of the drawing tools in the Microsoft Office products is a great way to draw
attention to certain areas in your file and you have these drawing tools available in PowerPoint,
Word, Excel, and Access. Let me show you how these actually work.
If you go up to the Insert tab you’ll notice here under the Illustrations we’re going to start with
Shapes. They actually call these Drawing Tools.
Here are different shapes that you can actually draw. You’ll notice they’re in categories. You’ve
got the most recently used ones at the top but there’s categories of lines, there’s basic shapes,
there’s arrows, flowcharts, stars and banners. You can kind of see all of these. Let’s say that we
start with a simple what we call circle or an oval and that’s going to be this one right here.
Let’s say that I want to circle the highest total which happens to be Germany. That’s in F7.
Notice my mouse looks like these black crosshairs. I can actually click and drag to draw that
oval. If you just click your mouse and let go you’ll have a teeny tiny one that you really won’t be
able to work with. So when you go to do this click and drag and don’t let go of the mouse until
you get it about the size you want it. Now what I can do is if I need it to be a little smaller I can
use these control handles around the edges to change the shape just a little bit.
Now the shape is laying on top of the work we’ve done. I can’t see that $10,800 through this. If I
choose this shape you’ll notice that you have a new contextual tab called Drawing Tools. There
are tons of things under here and we’ve looked at a couple of these already but one of the things I
want to do is go ahead and take all the color out of this so I can see through it. What I’m going to
do is use the Shape Fill option but I’m going to say No Fill and now you’ll notice that it looks
like I circled the $10,800.
Now let me go ahead and make that line a little bit thicker. I’m going to do that with the Shape
Outline option here. We were able to choose different colors from here. So let’s say I wanted red,
for example, but I also want to make a little thicker. That’s going to be the weight. Let’s say I
come down and pick 4.5. There you go. You can see it looks a lot nicer. It really brings attention
to that $10,800 right there.
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Now let’s say that I want to draw an arrow from this $10,800 down to the German piece of the
pie which happens to be this blue piece down here. What I’m going to do is go back to the Insert
tab, back to my Shapes and I’m going to find an arrow. Now those are under the Lines option
usually. I’ll just choose this one right here. And I’m going to just move the mouse over this circle
and you see these glue points as they’re called? You can actually glue where your starting point
is and draw your arrow way down here to the German piece of the pie just like that. And if you
need to move it around feel free to click on one of the circles on the edges and just move it up,
down, left, right. And I want to make that a little bit thicker as well just so that it will stand out.
I’ll choose that same red and I’ll go back to Shape Outline and change the weight. And now you
can see that this really enhances what I’m talking about in my chart.
Let me go back to Insert and just mention a few other things that you might be able to do. Like I
said, you can put in pictures. These would be pictures already in your computer. You would have
to go find that file. You could also put in an online picture. This will actually search the web for
you and then find some pictures that have the creative commons license and actually return those
so that you could actually use those. You would just type in what you’re searching for here and
then it would find it for you.
And that’s just a quick way that you can use what we call some of the different graphics options
in Excel to enhance your charts. I would even be able to do that over on the Chart All Quarters
the same exact way. It doesn’t have to be the ones that are set up like the chart data like this.
We’ve got one more thing in this particular module I want to talk to you about real quick and
that’s how to link your chart titles back to the data. I will see you over in section five.
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Video: Linking Chart Titles
Cindy: We’re working in module eleven and we’re all the way down now to the last section in
here, section five. I want to briefly talk to you about linking your chart titles.
You have the ability to link your chart titles back to the titles or any data back over in the data
itself. You can actually write a little formula so that when you update the data over in the Excel
spreadsheet it updates the chart title as well for you. Let me go ahead and flip over to Excel and
show you how to link these chart titles back to your data.
In this exercise the actual title for all of this information is Quarterly Sales Report. And what I’d
like to do is if I flip over to any of my charts, we’ll just use the chart Quarters 1 & 4 as an
example, I’d like you to say the same thing right here where it says Chart Title. Now I can
certainly type it in there but I want to link these so that if I change it over on the chart data sheet
it changes here automatically. We’re going to write a little formula in order to do that.
You want to start by having your title selected. Make sure you don’t click in here and do this.
We’re not trying to do that. We’re just trying to click around the edges so that we see our
placeholder or our box show up around it.
All you have to do now is hit the equal sign on your keyboard, click on the chart data sheet and
then click in the cell that you want it to link to. And you can see right there it says Chart Data,
the name of my sheet, it’s got the exclamation point, and then it’s got cell B3. And that’s all
we’re going to do. We’re going to hit the Enter key and now you can see it has the exact same
title, Quarterly Sales Report.
Let me do that one more time just to make sure you’ve got it. I’m going to hit the Undo up here.
You want to start by having your title selected, type in the equal sign, go to the Chart Data sheet
and click in the cell that you’re trying to link it to. Then you hit the Enter key and they are
linked. You can see it says Quarterly Sales Report.
Now let me show you if I go to the chart data sheet and I change this how it will change over on
the chart as well.
What if I want to say Quarterly Sales Report for Books and Beyond? Now if I hit the Enter key
you see it changes it right here but let’s go see what it looks like over here. And there it is. And
that’s how you link your titles back to your data when you’re working with charts.
Well that’s pretty much all we have as far as charts are concerned right now. Let’s go ahead and
move over into module twelve. We’re going to totally change focus and talk about the Names
feature that Excel has.
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Video: Module 11 – Practice Exercise
Cindy: We have finished working with charts now in module eleven and we went through quite
a few things with charts. I wanted to make sure that you can make some charts on your own so
I’ve got this little exercise set up for you.
I want you to go ahead and make some embedded charts. Remember embedded charts appear on
the same sheet as the data. Also I’m going to have you create a chart on a separate sheet. And
remember there was a quick way to do that.
Once you go ahead and do that I’m going to let you edit these charts a little bit and then we’re
going to use some of the drawing tools we talked about to enhance some of these charts.
Go ahead and look at the Word doc that’s attached so you have all the instructions and remember
charts are super easy. Little hint, to put in your chart sheet hit F11 on your keyboard. I’ll see you
over in module 12 once you’re done.
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Module 12 – Working with Names
Video: Creating Range Names
Cindy: We are now working in module twelve and in this module we’re going to talk about
working with the Names feature that Excel has.
You have the ability to take a cell or a group of cells and give them a name. And that way if you
needed to use them in a formula you could, maybe you need a quick access to those particular
sections in your workbook. You could actually just jump to those names very quickly. Let me go
ahead in this first section and talk to you about how to create range names.
There’s a couple reasons you would want to use the Names feature. One reason is if you have a
larger file then you might have certain tables or certain sections in the file that you want to jump
to quickly and having names set up would allow you to do that.
The other thing is when you start writing formulas you’ll actually be able to use names in place
of ranges and then that way you’ll know what you’re looking for, what you’re looking at when
you’re looking at when you’re looking at a particular formula.
Let’s go ahead and take a peek at how the exercise is set up and then we’ll dive right into this.
This is our company Books and Beyond. This is the international sales meeting and it looks like
they’re tracking all four divisions of the company. You can see there’s Australia, they’ve got
Europe, South America and Canada down on A51.
Now it looks like for each of these they’re also tracking the sales people for that particular
division, their figures for January through August here and they’ve got totals over in column J. It
looks like row 13 they’ve actually decided to total each month, then they’re averaging each
month in row 15 and 17 they’re figuring out the highest number for each month. And they’ve
done the same thing all the way down.
And real quick while we’re here, if you notice these green indicators in the top left corner of
these cells, that indicates that Excel thinks there might be a problem with the formula. You
always want to check those out if you see those. Let’s go look at this.
It looks like it says the formula omits adjacent cells. This particular formula is missing row 27.
Let’s just fix that real quick and then we’ll hit the Enter key and then we can copy that across.
That’s pretty easy to fix. This is probably the same thing. Let’s go look at it. It looks like it’s
missing row 27. We’ll fix that, we’ll hit the Enter key, and then copy that across and then we’ll
do the same thing down here. We’ll hit the Enter key and copy that across. And that way we
won’t have any problems when we start working with our different divisions of the company
here.
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Let’s see if there’s any names already set up. Remember this is the Name box right here. Right
now all you know it does is takes you to a particular cell. But notice that there is a dropdown
right here on the Name box and here’s the word European. These are where the ones that are
already set up basically live. If I click on European notice it takes me to the European division of
this company.
Now Excel didn’t know that. Someone actually had to select that range and then give that range a
name. I’m going to show you how to do that. We’re going to use Canada in our example here so
we’ll scroll down. I’m going to select the entire division. In this case it’s A51. I’m going to hold
the Shift key and click on J63. Now all you have to do to name a range is click in the Name box
and type whatever you want to name that range. I’m going to call it Canada and make sure you
hit the Enter key. If you do not hit the Enter key it won’t be on the list.
Now when I create these I don’t just see that they’re on the list. I actually click to make sure they
work because it’s very easy to be clicked somewhere else when you name your range. Let’s see
if I can go to Europe and then flip back to Canada and it works perfectly. All right let’s scroll
back up to the top.
Let’s say I’d like to name this one Jan. all I’m going to do is select the range, put in the word
Jan, hit the Enter key and now that one’s on the list as well. You can name as many ranges as
you’d like.
A couple things to know about naming your ranges. First of all you’re names cannot have spaces.
If you wanted to say South America you could but you couldn’t have a space in there. If you
wanted that little separation you could use a dot, you could use an underscore. It does not work
with a hyphen. If you happen to type a hyphen there you’ll notice that name just won’t even be
on the list.
Now let’s say that I’d like to name this one February, this one March, this one April, all the way
across. We could name them individually but Excel will actually do this for you. Let me show
you how this works.
I’m going to start by selecting the word February and I’m going to go all the way down to I11.
Now when we create these names it’s not going to include row 7 but I selected it so that it knows
that is the name that I want to name the range below.
All you have to do is when you have these selected go to the Formulas tab, you have a whole
grouping here for names. What we want to do is Create from Selection. Notice that top row is
checked in this window and that’s because it recognizes there’s text in the top row and that’s
what it’s going to name each one of these. All you have to do is click OK and now they’re done.
If I go back to my names list you can see they’re all on the list here.
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Now this list is alphabetical. It’s not going to be set up by the way the months happen, just know
that. You cannot change how that list is setup. But it works great. If I click July you’ll see I go to
July and it doesn’t include the word July there.
Now I can also do this left to right. If you think about it this is Alice Long and this one here is
Lawrence Olsen, all the way down. I’m going to select from the word Alice Long, which is A8
all the way over to I11. I’m not including the totals because that would actually double my
figures. But all I’m going to do now is come up to where it says Use in Formula, Create from
Selection, notice this time it says Left Column and that’s checked. I’m going to click OK and
now those should be on the list. And you can see that these actually have two underscores. The
reason there’s two is one is for the space and then one if you look at this, they had a comma and
range names can’t include commas either. Again I’ll be able to use these and go to any range that
I would like.
Now let me show you something else. Range names are always absolute values. If I went to
Sheet3 and then I come to my Names list and I choose Jan for example Jan will always mean
Sheet1, the absolute value of the range B8 through B11. Always. It’s not going to take me to
Sheet3 B8 through B11. It’s always, always, always an absolute value. Keep that in mind when
you start writing your formulas.
What I want to do now is talk to you a little bit about how to manage these names because you
may want to do delete some of these names, it could be that you want to change what a range
name refers to. There’s a lot of different reasons for managing the list of names. Let’s go over to
section two which is the Managing Names section.
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Video: Managing Names
Cindy: We’re working in module twelve and we’re talking in this module about working with
the Names feature. We’ve already gone through section one and talked a little bit about how to
create range names and I mentioned to you that there will be times when you need to delete one,
maybe you want to change what it refers to. Those are things you might want to do in the
Manage Names feature. We’re going to go ahead and flip over to Excel. This is section two of
module twelve, Managing Names.
Once you start creating range names you’re going to find that you’ll need to edit these names.
Maybe you misspelled one. Maybe you’ve moved the range that a name actually refers to.
Maybe there’s one you just want to delete entirely. You’re going to be able to do all of that in the
Name Manager.
One thing to keep in mind is when you create a range name it’s in this file only. It’s not in
another file. You’ll have to be in this file to actually make those changes.
Make sure you’re on the Formulas tab and then you’re going to see the Name Manager right
here.
This is a listing of all the names that you have set up in this file. You can see the values in the
cells that it refers to and you can also see exactly which sheet and which cell or cells that the
range name refers to over here. If you needed to delete one totally all you’d have to do is select it
and click Delete right up here and it would be gone and you wouldn’t be able to get it back
unless you did Undo.
You can also edit. Let’s say that you wanted to edit the range that Jan refers to. Maybe you’ve
moved those cells. If I click Edit here I can actually come down and select everything right here
where it says Refers To, I can hit the equal sign and then let’s say you’ve moved it over here
somewhere. You would just click and drag through that new range and you can see it’s reflected
right there. And then you’d just click OK.
Now let’s say that I name a single cell and I name it South America. I’ll come down to A36. I’ll
go up to my Name box, I’ll type S, underscore, America (S_America), and I’ll hit the Enter key.
And now you’ll see that one is on the list.
Now if you notice I totally misspelled that and I’d like to go change that. All I have to do is go to
the Name Manager, find that South America name and Edit, and I can change that right here. All
I have to do is spell it correctly now and go ahead and hit OK and now that one’s in the list
spelled correctly and it should go to A36 and it does when you click on it.
Well that’s a quick way to work with managing the names that you have in this particular file.
We need to do one more thing in this particular module. We need to talk a little bit about how to
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use range names in formulas. That’s going to be very beneficial when you can look at a formula
and see exactly what it is that you happen to be adding, for example, instead of just seeing a
range of cells. Let’s go over to section three and I’ll show you how to use range names in
formulas.
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Video: Using Names in Formulas
Cindy: Okay we’re in the last section of module twelve. We’ve been talking in this particular
module about the names feature that is built into Excel.
One of the things you have the ability to do is when you’re writing a formula in place of using
actual ranges you’ll be able to use a range that you’ve already named. You’ll be able to see that
name in your formula and that way it’s much easier to actually see exactly what it is that you’re
working with. I want to go ahead and show you how to use these range names and then we’ll
actually set some up and use them in our formulas.
One of the things that we did was we named B8 through B11 Jan and I want to show you how to
use it in a formula. When I look down at B13 and I double click you’ll see that this particular
formula says add B8 through B11. What if I took B8 through B11 like this and replaced it with
the word Jan? Let’s see if we get the same exact answer. And we do because Jan always means
Sheet1, the absolute value of the range B8 through B11. Now keep in mind that when you do this
you have to keep Jan in the parenthesis still. All ranges have to be in parenthesis.
The only disadvantage to doing something like this is let’s say you didn’t have any of these and
you wanted to actually use your fill handle and copy this across. If you did this you’ll notice that
it just puts 830 in all of these cells and that’s because it’s always the absolute value of the range
B8 through B11. So you will not be able to use your fill handle to copy your answers across like
that.
Now let’s say we’re on another sheet. We’ll go to Sheet3. And I’m over here writing some
formula and this time let’s say I’ll do max. I’m trying to reference that same range. Now I forgot
that I named it Jan I could always look up here under my Formulas tab and you’ll see that right
here where it says Define Names there’s this Use in Formula option. Notice it’s the only one
available. What most people tend to do is they want to come over here to where they think the
name list is and notice that’s not the names anymore because we’re actually in the middle of
writing a formula. So now we’ll have to go to it this way. I can pick Jan from the list, hit the
Enter key, and I get 300. If I flip back to Sheet1 let’s see if that’s the correct answer and it is. It’s
300. That’s a good example of actually using a name in a formula.
I’ve got another really good example. Let me go ahead and open another file we’ve already
worked in and show you how this works.
We worked in this file a little bit earlier when we were talking about absolute values. Just to
refresh your memory, this is the name of each sales person and what we want to do is pay them a
commission rate of 15% up here. And we’ll base that 15% on their total. All we’re going to do is
come over here to H8 and I’m going to put in the equal sign and I’m going to say take this,
which is their total, and multiply it times the 15%, which is in G3. And then we talked about the
fact that we could copy this down and we would get zeroes because this is that relative reference
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we talked about. So remember I told you that you’ll need to insert dollar signs in front of the G
and in front of the 3. And as long as you’re clicked there you can also hit F4 on your keyboard to
insert those for you. But now that I have that in here I’ll copy that down and we have all of our
commissions.
I did mention to you that there were three things you could name and we’ve talked about naming
a range, we’ve talked about naming an individual cell, now let’s talk about this way to use
names. I would like to still pay each person a 15% commission but I don’t want to show this
anywhere on the screen. A lot of people would actually put this on another sheet and you could
certainly do that but let me show you how you can use a name to accomplish the same thing. I’m
going to hit Delete here and you can see now that everything is zero because I deleted my
number that I was multiplying by.
What I’m going to do is I’m going back to formulas and I’m going back to the Name Manager
because I’d like to actually create a new name. Now I’m going to actually abbreviate this. I could
leave it Commission but that’s a lot to type in. I’ll just call it COM. And down here COM is
going to refer to, and you have to put in your equal sign, 15%. So this time instead of it referring
to a cell it’s going to actually refer to in this case 15% and then I’ll click OK. And now you’ll see
that one is setup.
I’m going to close this and here’s how it’s going to work in our formula. Instead of saying
dollars, G, dollars, 3 ($G$3) here I’m going to say COM. 1175 times 15% is what this formula
now says. I’m going to hit the Enter key and you can see I have my 176.25.
And I’ll be able to do that with any of these. I’ll go ahead and use the fill handle and copy this
down and you can see I have all of my answers.
So all I did was I went back up to the Name Manager, I chose the New option, I’ll just Edit in
this case, I named it COM and it refers to 15%. Don’t forget the equals sign there. And I just
clicked OK. And now you’ll see those are three ways to use names in your formulas.
Well that’s going to wrap up module twelve. We’ve talked a lot about working with names.
What I want to do now is totally change focus and move you over into module thirteen where
we’ll talk a lot about sorting and filtering when you have longer lists of information.
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Video: Module 12 – Practice Exercise
Cindy: In module twelve we talked a lot about the names feature that Excel has. We talked about
how to create range names, we talked about how to go in and delete them or edit them if you
need to, and also how to use them in formulas.
What I’m going to have you do in this exercise is go ahead and open this file called Names and
the first thing I’m going to have you do is name each of the divisions. You’re going to go ahead
and select like this and give that division a name. And I’ve put the ranges over in the Word doc
for you so you won’t have to guess at those.
Once you have all the names selected and named then I want you to go ahead and name each
month up in the Australian division. That way you can come down to cell B13 and write a
formula using the name that you created to add all of January all the way across.
Once you get that done I’m going to have you go down here where you see these green symbols
in the corner and I’m going to have you edit each of these formulas so that they are correct, and
then make sure you copy that across all the way through August.
It doesn’t seem like a lot but there is quite a few things on this little exercise I want to have you
do just to make sure you’re okay with working with names.
Once you’re done with that let’s move over to module thirteen where we’re going to talk about
the sorting and filtering options in Excel.
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Module 13 – Sorting and Filtering
Video: Remove Duplicates
Cindy: We’ve now made it all the way down to module thirteen and in this particular module
we’re going to talk about sorting and filtering. This is great when you have longer lists that
you’re working with because you’re going to be able to go through the list, you’re going to be
able to go through and remove any duplicates you might have, you’re going to be able to sort the
data, you might want to sort it alphabetically, numerically, by date, and then there might be
certain data that you want to see and other data that you don’t. So you can go through and filter
out that data.
I want to show you in this module how all of this stuff works. We’re going to start right now
with section one and I’m going to show you how to remove the duplicates when you have longer
lists of data that you’re working with.
One of the things that will happen when you’re working with a longer list like this is you might
end up with duplicates for various reasons. It could be that you typed someone in twice
accidentally, it could be that you maybe exported some data from another software program and
when you brought it over it duplicated it. There’s a lot of different reasons why you might end up
with duplicates. One of the things you can do is have Excel find those duplicates for you and that
way you can get those out of here, you can actually delete them.
Now before we actually start working with this let’s talk for a little bit about how files like this
should be set up properly in order to remove duplicate, sort, and filter.
The first thing you’ll notice is that on row 4 here these are the headers for each of your columns.
We call this your Header Row. One of the things that has to happen with your header row is that
it has to have one format that’s different from the data below. If it doesn’t what will happen is
when you go to sort it will sort the headers in with the list and you don’t want it to do that.
Capital letters don’t count. Okay? It has to be something like a different font size, a different
font, different color, things like that. So that’s the first thing is you’ve got to have a header row.
The second thing is no blank rows in your table. If you have a blank row it will stop. It won’t
know that there’s anything below it. You can have blank cells, like you’ll see a few of those
here. But no entirely blank rows.
The other thing is when you start typing your data in you want your data to be consistent. And
what I mean by that is if you’re typing 40 here and then you type in another cell F-O-R-T-Y
those two are not the same. You need to actually be consistent. Do you want the numbers or do
you want the actual text? So just keep those things in mind when you’re working in these
different lists like this. Let’s get on to talking about removing your duplicates.
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What I want to do first is let’s go ahead and sort column A and that’s going to be a quick way
that we can bring our eye to the duplicates. A quick way to do this is click anywhere inside the
table, as long as you’re under row 4 then it’ll be fine. All you have to do is to go your Data tab
and you’ll see this button here is your Sort Smallest to Largest. We’ll go ahead and click on that
and now you’ll see it’s sorted by this number over here. Now that it’s sorted I can see I’ve got a
couple of duplicates. There’s Sara. Let’s see if we’ve got anyone else down here. It looks like
we’re going to have a couple of them, I think. Here’s Christina. She’s at row 68 and 69 there.
And there’s going to be several more in here as well. It’s kind of hard to go down the list and
eyeball this because we’ve got a lot of these and it’s very time consuming. Let’s have Excel do
this for us.
Now before we do this let’s see how many rows of information we have. We have 104. All right.
Let’s go back up to the top. What I’m going to do is I’m going to actually be clicked in the
particular column that I want Excel to look for the duplicates in. And what I’m going to do is go
ahead and go to the Data tab and you’re going to see right over here where the Data Tools
grouping is there’s a button that says Remove Duplicates. I’m just going to click on that and
you’ll notice it selected the table for me and also notice that these are all of my column headings.
If you ever come in here and it says Column A, Column B, Column C then you’ll know it didn’t
recognize your headers, but ours did in this case. And notice that it looks like it’s going to look
through all of the columns of information.
What I’m going to do is Unselect All and I’m going to have it look in the number column and
I’m going to click OK. And you’ll see it says there were 11 duplicates and it went ahead and
removed them. That leaves 91 that are unique values. Let’s go ahead and look down this list and
see how many rows of information we have now. And it looks like we have 94. So 11 of these
are actually gone. It went ahead and deleted them. That’s a great way to go ahead and have Excel
remove those duplicates.
Now here’s the thing. Excel did a great job but I didn’t get to see which ones were actually
duplicated because maybe they really weren’t. Maybe they had the wrong number over there. I
want Excel to actually show me which ones are duplicates and then I can choose to delete them
or not. Let me go ahead and Undo and that should bring back all 104 rows and it did.
Here’s what we’re going to do. I’m going to go ahead and put a blank column in here to the right
of column A. So I’ll just right click on B and say Insert. And I’ll make this a little wider so we
can see it here. What I’m going to do is write a little formula that will tell Excel to put the word
Duplicate anywhere that it sees that column A has a match. Now I’m going to write a formula
that’s a little more advanced than we are right now but that’s okay. Later on we’ll kind of go
through this. But this is what’s called an If Statement.
We’re going to tell Excel that If these two are duplicates go ahead and write the word Duplicate.
All I’m going to do is go to the Home tab, I’m going to use my Insert Function and remember I
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could also get to this from the Formulas tab if I wanted. I could use Insert Function here. I’m
going to look for If in this list. I’ll just click here and type I to get down there. I’ll click OK. And
here’s what I’m going to do. An If statement basically has three parts to it. It has a test, what to
do if the test is true, and what to do if the test is false. Now what I’m going to have it do here is
I’m going to say if this equals this, so that’s going to be my test. Tell me if that’s true. If it is I’m
going to have it put the word Duplicate here. If it’s not I’ll just have it return a zero. Now let’s
click OK and we’ll see how many duplicates we actually have. I’m going to actually copy this all
the way down and let’s see how many it came up with. There you go. There’s several of them.
This one’s a duplicate, that one’s a duplicate, there’s another duplicate right there. Perfect.
Now I can look through these if I need to because it could be that the number is wrong but the
date is right in the rest of the columns. You would have to look through each one of these to
make sure.
That’s a great way to have Excel find your duplicates for you.
Why don’t we go ahead now and go over into section two and we’ll talk a little bit about sorting
your data.
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Video: Sort Data
Cindy: Welcome back. We’re working in module thirteen and in this particular module we’re
talking about sorting and filtering your data.
Sorting data is going to make it much easier to find some of the different things that you’re
looking for. You’re going to see that you’re going to be able to sort your data multiple different
ways. You’ll be able to sort alphabetically, you’ll be able to sort numerically, you’ll be able to
sort by date, and also by what we call custom list which we’ll get into a little bit later. But let’s
go ahead and flip over to our exercise so I can show you how to get some of this data sorted.
If you have a list of information and you plan to sort or filter that data you need to make sure the
list is set up a certain way. The guidelines that we referred to over in the first section when we
talked about removing duplicates apply when you’re sorting and filtering. Keep in mind that you
want to make sure you have a header row, just like you see here in row 4. That header row tells
Excel what type of data is below. That header row must have one format that’s different from
than the actual data or when you go to sort that column it’ll sort the header in with the list of
information.
The other thing is make sure you don’t have any blank rows in your data. If you have a blank
row Excel will stop there and it won’t recognize that it needs to go on to whatever is below that
blank row. You can have blank cells but you don’t want entire rows that are blank.
The other thing is you want to be consistent with how you type in your data. You want to make
sure if you’re typing numbers, for example, that you type 4-0 and not F-O-R-T-Y. You can
actually do it either way but just be consistent with how you do it.
As long as you keep all those things in mind then you shouldn’t have any problems when you go
to sort your data.
Now I mentioned there are four different ways to sort. You’re going to be able to sort
alphabetically, A to Z, Z to A. You will be able to sort numerically, 1 to 10 or 10 to 1. You could
sort by date and you can also sort in here by custom list that we’ll talk about when we get to that
particular point. But let’s start with a super simple what we call a single level sort.
Let’s say that you would like to sort the numbers over in column I where the hours are. As long
as you’re clicked in the column you’d like to sort by underneath the header then you’ll be fine.
Your sorting options are going to be under the Data tab and you’ll see a whole group called Sort
& Filter right here.
Now the easiest way to do the single level sort is use this A to Z, which will currently say sort
smallest to largest since you have numbers in that particular column. All you do is click on it and
now you can see these are all sorted numerically. If you wanted to sort the opposite you just use
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the button that says Z to A, in this case meaning sort largest to smallest and now you can see
they’re sorted the opposite direction. If I go back over to column A where the numbers are I can
go back and sort this A to Z and now you’ll see it’s sorted numerically. That’s the first way
you’ll be able to sort. Let’s talk about alphabetically.
Let’s look over at the division column for example, column E. I’ll do the exact same thing. I’m
going to choose the A to Z and you’ll notice this time it says Sort A to Z and now you’ll see that
all of the division that is Australia’s together, all of Canada’s together, Germany is together and
so forth.
The third way you can sort is by date and I’m going to click over in column G and let me just
mention something about sorting by date.
You might type the date of January the 1st as 1, slash, 1, slash, 18 (1/1/18). To you that’s January
the 1st of 2018 but to Excel it’s just numbers and slashes. Even if you want it to look that way
make sure if you plan to sort by date that you select that entire column and remember how we
talked about formatting in a previous module, you could format your dates. You’ll just want to
make sure this is formatted for dates so that you can sort properly. And this is in this particular
case. I’ll just go use my A to Z again and now you’ll see that it’s sorted by year, month and day
all the way down the list.
There will be times when you want to do a double sort. Let’s say you’d like to do something like
this. I’d like to sort the last names and if the last names are the same I’d like to sort the first
names. In order to do that you’re not going to be able to use your single level sort buttons. You’ll
have to actually go into the actual Sort option right here. I’m going to go ahead and click on that
and notice because I was clicked in the table before I started it selected the table for me.
The first thing you’ll notice it says is Sort By and here’s where my column headings are listed. If
I come in here and it says Column A, Column B, Column C that’s how I know that it doesn’t
recognize my headers but it does in this case.
I’m going to sort by Last and then I’m going to add a level. Do you see right here it says Add a
Level? I’m going to sort by Last, then by First. This says sort on the cell values. Notice your
other choices are you can sort by cell color, font color, or conditional formatting icon. And you
can also sort A to Z or Z to A or by custom list. Let’s go ahead and click OK and let’s see what
we’ve got.
If I look at the last names it looks like they are sorted alphabetical. You can see there are four
April’s right here. Now notice the first names. All of these are sorted alphabetical as well. So if
there are duplicates in this column then it will sort the next one. And that’s the way you want a
double sort to work.
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There will be times when you want to do a triple sort. Let’s say you wanted to sort by last name,
if the last name’s are the same sort the first names, and then also sort the division. Let’s go back
up to our sort option and we’re going to add another level. Now let me just mention that when
you first come into this window you’re clicked on the first level here. If you automatically just
say Add a Level notice how it put one in between these two. You can certainly go there and
change this to say first and then you’ll be able to add the other one that you’d like to use, then by
division. Now I’m sorting by last name, then I’m sorting by first, and then by division and I’m
going to click OK.
If I look at this you’ll see the last name’s are sorted alphabetical. That’s good. If there’s a
duplicate the first names are sorted alphabetical so that’s good. But does division look sorted at
all? In order to sort the next column the previous one has to have duplicates. Do you see any
duplicates among these four? And the answer is no so there’s no way it could sort the division. If
you’re needing a third sort like that sometimes just rearranging the way it sorts works perfectly.
If I had said sort by division, then last, then first it would work perfectly. I’m going to go back
and sort by division first, then I’ll sort by last, and then I’ll sort by first and let’s see what it looks
like this time.
So now you’ll notice all the divisions are sorted. So here’s all of Australia. Of those notice the
last names are sorted alphabetically. And if there’s any duplicates here, like the Binga’s then it’ll
sort the first names. So it will do a triple sort. You just have to sometimes rearrange the order in
which you tell it to do the sort for you.
The other thing I want to point out is you have the ability to do what we call a Custom Sort. Let
me give you a good example of this. Let’s go down to the sheet that says Café Beyond at the
bottom. This looks like they have a little café and it looks like they’re listing each of the types of
items that they sell and some other information but I want you to notice column G is the month
of highest sales and column H is the day of highest sales. And you’ll notice that neither of these
lists are in the order in which they actually happened but I’d like to put them in that particular
order. And let’s start with the month of highest sales.
If you remember back in module ten we talked a little bit about working with custom lists and
what we’re going to be doing here is comparing this list to the custom list that’s set up and then it
will sort based on that.
All I’m going to do is go back to my Sort option. I want to sort the month of highest sales but
this time where it says Order let’s choose Custom List. And this should look familiar. Since these
are the months of the year and they’re spelled out I’m going to choose the same one where the
months are spelled out and I’m going to click OK at the bottom and click OK again. And now if
you look the months are in the order in which they actually happen.
Let’s do the day of highest sales. We’ll do it the exact same way but we’ll sort by day this time.
I’ll go back to Sort. This time I want to choose the column that says Day of Highest Sales and
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when I go down here to Custom List I want to make sure I choose the one where the days are
spelled out because they’re spelled out here. I’m going to click OK and click OK again and now
you can see these are actually in order as well.
So those are the four different ways you’re going to be able to sort. Sorting is actually very easy
to do.
Let’s go ahead and move over into section three and I want to talk to you in section three about
how to filter your data. You can go in and tell Excel exactly what data you’d like to see and it
will hide everything else.
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Video: Filter Data
Cindy: We’re working in module thirteen and we’ve been talking in this module about sorting
and filtering options in Excel. In section one we went over how to remove the duplicates from
your list, in section two we talked about sorting and now we’re down to section three where I
want to show you how to filter your data.
Filtering basically means that you’re going to tell Excel the criteria that you’d like to see and it
will hide everything that doesn’t match that criteria. Let’s flip over to Excel and I will show you
how to start filtering your data.
We’ve got this long list of payroll information and there’s a lot of information I’d like to just pull
out and look at separately instead of looking at the whole list and that’s where the filtering comes
in.
In order to actually turn on the filter option you want to start by clicking in your header row. It
doesn’t matter which column, just click anywhere in the header row. On your Data tab you’re
going to see right here the option that says Filter. And now you’ll see these little arrows that are
dropdowns next to each one of your column headings.
You’ll notice that when you click the down arrow and you look down at this section it’s going to
list each item in that column one time. Everything is checked. That means you’re showing
everything. Let’s say you just wanted to see anyone in the children’s department. All you’d have
to do is uncheck the Select All, check next to Children’s and click OK. And now you’ll notice
everything in this list is only for the children’s department.
The rows that did not meet the criteria have not been deleted. They’re just hidden. You’ll notice
if you look at your row headings on the left the blue indicates they’re part of a filtered list and
you’ll see that rows 10 and 11 are hidden, it looks like 13 and you can go down the list and see
all the ones that are hidden.
If a column has a filter applied you’re going to see this little icon right here that indicates a filter.
And just click on that and you can either clear the filter or select all, either one, and that will go
ahead and show everything in the list again.
Now let’s say you’d like to see anyone in the children’s department who’s also in the Australian
division. You would go back and first filter by department. We’ll go ahead and uncheck Select
All, we’ll check Children’s and click OK. That narrows our list. Now I’ll go to the Division
column, uncheck Select All and choose Australia and click OK. And now you can see that only
four people met that criteria.
You can keep adding more filters if you want but let’s say you wanted to take all of these off.
Instead of going to each one of these individually and saying Clear the Filter you can actually
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clear all the filters at the same time by going up to your Data tab and next to Filter you’ll see this
Clear. And if you click on Clear that clears all the filters.
Let’s talk about filtering over with some numbers in column I. This is a listing of the hours that
the employee worked this week and I really want to get a list of anyone who worked overtime.
That means more than 40 hours. If I click my down arrow I’m going to uncheck Select All and
the easiest thing to do is check the one that says 42. But what if you had some people that
worked 41 and some people that worked all the way up to 50. It’s probably not a big deal to go
check all those off but I want to show you another way to work with number filters.
Do you see right here it says Number Filters? Over here you’ve got different options you can
apply and we’re looking for anyone who worked more than, which would be greater than in this
case, and then we’ll put 40 here. I’ll go ahead and click OK and now you’ll see all the people
that met the criteria. We have four people that worked over 40 hours. Okay let me clear that filter
again.
Let’s say this time we’d like to get a list of anyone who worked between 35 and 40 hours this
week. From the dropdown what you don’t want to do is go and just click all of these. Now you
could but think about if you’re working with thousands of pieces of information it might be way
too much work. Another way to do this is use the Number Filters.
One of the options you have here is Between. If you click on Between it takes you back to this
Custom AutoFilter window and notice it says Hours is greater than or equal to and this is where
we’d put 35 and then it also says it is less than or equal to 40. Now you’ll notice there’s an And
and an Or here. These are called Conditions. An And condition means it has to meet both
criteria. Or means it meets one or the other criteria. We’re going to say And in this case and go
ahead and click OK and let’s look down the list and see if all of these are between 35 and 40.
And it looks like all of these are, all the way down. That’s how you would do what we call a
Between function.
Now let me go back to the list. I’m going to clear the filter and now I’m showing everyone again.
Let’s go over to column H and look at this one for a moment. This is the column that represents
the benefits the employee has. An employee can have any combination of dental, retirement
and/or hospitalization or they may have none. Some of these are blank because maybe they
didn’t have any benefits and that could have changed and maybe you want to see a list of those
so that you can go fill those in. Notice when you’re looking at this list I can select all of the
blanks. Then I can take this list and go research and make sure they really don’t have any
benefits.
Now let’s say this. I’ll clear this filter. I’d like to get a list of anyone who has dental insurance.
Maybe their rate is going up and I’d like to send them a letter. If I click the down arrow you
could go through and click all of the ones that have a D in there and in this case there’s only four
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but think again if you have thousands of these you’re working with that may not be the best way
to do this. I want you to notice that because you’re in a text column you have text filters. And
look at the options here. I can say give me anything that equals the letter D. But if you said
equals the letter D that means you’re leaving out the people who have dental and hospitalization
or dental and retirement. So what you’d like to do here is get a list of any cell that contains the
letter D. Now when you look down the list you’ll see that the letter D is in any of these cells and
the employee can have any combination of these that they like.
You can see that you can keep going on with filters forever. I’m going to go ahead and actually
clear these. I’ll say Select All and click OK.
There are some other things you can do with filters. What if I asked you, for example, to give me
a list of anyone who’s in the Canada and art department and also anyone in Germany children’s?
You would not be able to do that with the dropdown list here. You would have to create what we
call an Advanced Filter. I’d like to show you how advanced filters work so let’s go ahead and
move over to section four and talk about advanced filters.
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Video: Advanced Filters
Cindy: We’re working in module thirteen and we’re all the way down now to section four. I
want to talk to you a little bit about advanced filters.
In section three we went through and learned how to filter out our data. We learned that we could
tell Excel what type of data we’d like to see and it will hide everything that didn’t meet the
criteria. But there will be times when just using the dropdowns will not work to give you exactly
what you want and that’s where an advanced filter comes in. I want to show you how to create an
advanced filter.
It’s really nice that we can click the dropdown arrow and get a list of the different things we like
but sometimes you’re not going to be able to use the down arrows to get the exact criteria that
you like. One of the things we saw earlier was that if we wanted a list of anyone who was in the
children’s department we could do that and then also we wanted that person to be in the
Australian division. We would just go over to division and choose Australia and click OK. But
now I’d also like to add to that anyone in the arts department who’s also in the German division.
Notice there’s none of that criteria in the existing data so there’s no way I can get that. I call this
a Double Or Condition. The filter has to look at each cell and make sure it matches all of the
criteria. It’d have to look in the division column and make sure it meets Australia or Germany
and then it’d have to look in the department column and make sure it meets children’s or art.
This is where an advanced filter comes into play. I’m going to go ahead and clear all of this and
what I’m going to do is over on the right somewhere I’m going to make a Criteria Table for
Excel to look through.
Now what I have to do first is put in the names of the column headings I want it to look through.
I want to use department so I’ll just copy that and I want to use division. I’ll just copy that over
here. And the reason I copy it is because sometimes if you type Department, for example, you
might type D-E-P-T-period and then there wouldn’t be an exact match, it couldn’t find that
column and you wouldn’t get all the data you’re looking for.
So let’s say that for department I want children’s and art. So I’m going to pick children’s and I’m
also going to pick art. Now if they’re in the children’s department I want them also to be in the
Australian division and if they’re in the arts department I also want them to be in the German
division. So you can see I just copied these is all I did. And by the way instead of right click and
copy the way I copy is I point around the edges of the active cell, hold down the Control key and
then drag. Make sure you let go of the mouse first, but that’s a quick way to copy something.
Now I have two tables. This is my list range that Excel is going to look through. This is my
criteria range that I want it to match the criteria to. You’re going to start by clicking in the list
range anywhere. The next thing you’re going to do is if you notice under your Sort & Filter
grouping here’s an advanced option. And what happens here is went out selected the table I was
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clicked in so it knows the list range over here. But it doesn’t know the criteria range. This is
where we have to tell Excel that. Now all I’m going to do is just move this out of the way a little
bit, make sure I’m clicked where it says Criteria Range and I’m going to select in this case from
M1 through N3, and that’s all you have to tell it. I’m going to click OK and now we have our
list. If you wanted to see if this really works the best thing to do is sort either division or
department. I’ll go ahead and sort department. I’ll just sort it A to Z. Now if you notice everyone
who’s in Germany is also in the art department and that’s exactly what we wanted over here.
And if you look at Australia they’re also in the children’s department, and that’s exactly what we
wanted over here. That’s how you create an advanced filter. I could add as many sets of criteria
as I would like. I could even add another column if I’d like and it would have to meet all three
criteria across if that was the case. And that’s how advanced filters work.
Filtering is a great feature to pull out data you’d like to see and hide everything else.
Well that’s going to wrap up module thirteen. I want to move now over into module fourteen
where we’re going to talk about outlining and subtotaling in Excel.
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Video: Module 13 – Practice Exercise
Cindy: Well we’ve completed module thirteen now and in this module we talked a lot about
sorting and filtering your data. The big things I want you to get out of this is I want you to know
how to do single level sorts. If I asked you, for example, to sort by last name you would know
how to do that. I want you to know how to do double sorts. What if I asked you something like
sort by division and then last name? You could do that.
I want you to be able to filter your data as well. Remember filtering means that you want to give
it the criteria you’d like to see and it will hide everything else. We’ll do a couple of filters in here
and then I’m going to have you clear the filters.
And that’s really the big things here in this particular module.
Let’s go ahead and do the exercise and once you’re done head on over to module fourteen where
we will be talking about outlining and subtotaling in Excel.
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Module 14 – Outlining and Subtotaling
Video: Creating an Outline
Cindy: We’re actually starting on module fourteen now and in this particular module I’m going
to show you how to create an outline and also how to do some subtotaling.
Sometimes you’re going to have a lot of information and you might need all that information in
your spreadsheet but maybe you only want to show the most important numbers that are in there.
You can actually create an outline and have different levels of organization and you show or hide
certain levels. Let me just show you a real quick way of how to create an outline in one of your
Excel files.
We’ve got this file here that lists all of the sales for the company and you can see that these are
grouped by books and also by CDs and tapes. That tells me how old this file is. But if you notice
we’ve got it also broken down into different types of books. They have fiction, nonfiction,
children’s literature. And as far as the CDs and tapes they’ve got jazz, classical and R&B. Notice
there’s also a total sales down here at the bottom.
From left to right they’re showing each month of the year and the total for each of these and then
they’ve got the quarters. So you’ve got Quarter 1 after March and Quarter 2 after June, all the
way to the end where you’ve got some annual totals. Let’s look at this up and down.
If I asked you what the most important number up and down is the answer would have to be the
total sales down here in B15. The second most important numbers would be this one here and
this one here. And then the third most important would be the individual numbers that make
these up.
Now let’s talk about where these levels come from. The levels come from formulas based on
other formulas. Let’s take a peek at the total sales. If you look they’re just adding two numbers.
They’re adding this and they’re adding this. If I look at either one of those, let’s say the 875
that’s not even a number. That’s a formula. That formula is based on these three numbers. And
the same thing would be up here with this 350. That’s a formula based on three other numbers.
So any time you have a formula based on other formulas you’ll have another level. You can have
up to ten levels in Excel.
Now let’s look at this across. The most important thing across would obviously be the annual
totals over in column R. Then I would consider Quarter 3, Quarter 2, Quarter 1, and Quarter 4
back here to be my second level. And then these would be my third level. It’s coincidence in the
exercise they have three levels up and down and three across, but it’s not always that way.
Sometimes you’ll have one up and down and ten across. It really just can be totally different in
every file.
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We have the ability to take this and turn it into an outline and this is how you do this.
You want to go to the tab that says Data and you want to go all the way to the Outline grouping
at the end here. Now in order to turn on the outline what you’re going to do is you’re going to
click the arrow under Group and you’re going to turn on Auto Outline. This is the outline you
see up here and over on the left. So if you’ve ever seen that in a file you’re working on that’s
what it is. It’s an outline.
Now you’ll notice there are two sets of levels, one, two, three up and down and one, two, three
across. And this may sound backwards but the way you want to look at this is the ones that goes
up and down when you’re looking across you’re going to use those. The numbers that go across
you’re going to use that for the up and down. So it’s kind of the opposite.
Let’s say that across this way I only want to see my quarters and my annual totals. That means I
want to see levels two and one only. What I can do is click on the up and down numbers, the
two, and notice how it hides everything that’s not level one or two. And if you printed this would
look exactly like this. So think about this. We needed level three to get these totals but then we
don’t want to show them.
Now if you look above each one of these you’re going to see a little plus sign. If I happen to be
looking at this 400 here and I say you know I wonder what made that up I can click the plus sign
right above that column E there and show just that one little section only. And now I have a
minus sign there I can use to fold up that little section. That’s all I have to do there. If I wanted to
show only level one I would click on the one and if I wanted to show all three levels I’d click on
the three.
And I can have any combination of these. What if I want to show only levels one and two across
and one and two up and down? I could certainly do that.
And that’s a quick overview of how the outlining is going to work.
Now if you wanted to turn the outline off you would just come over here under Ungroup and say
Clear the Outline. And before I clear it I just want to mention that if you save your file this way it
stays this way. You don’t lose your outline at any point. I’m going to go ahead and clear the
outline and now you’ll see it’s back to the way it was originally.
Now when we do other functions in Excel, like we’re getting ready to talk about subtotals in a
minute, you’ll see that subtotals when you turn on the option it actually will turn on the outlining
for you. You’ll see that a lot of times when you’re working with different formulas.
That’s a quick overview of how outlining works. I want to take you over now into section two
and show you how the subtotal feature works.
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Video: Subtotals
Cindy: Hey there. We’re working in module fourteen and in this particular module we’re
looking at the outlining and the subtotaling features that Excel has. We’ve already gone through
section one where I showed you how to create an outline. Now we’re section two where we’re
going to talk about the subtotal feature.
If you have a list of information there might be times when you want to divide that list up maybe
by a particular repeated value that’s in a column and maybe you want to put in some subtotals for
each of those once those values change. We can actually do that in Excel so let me flip over and
show you how the subtotaling feature works.
This is the same file that we used over in module thirteen when we were talking about sorting
and filtering our data but I’d like to again tell you what we’re looking at here. This is that
company Books and Beyond we’ve been working with and this is their payroll for a particular
pay period ending. And they’ve got different columns of information here. You can see that
column A says Number, B and C are the first and last name, and just looking all the way across
we’ve got division, department, and all the way over to gross pay which is the last column.
Let’s say I’d like to know per division what the total of the gross pay is and I want to know this
for each division.
The first thing you want to make sure that you do is sort by division. I’m going to click anywhere
in column E as long as I’m below my header row, which is row 4, and I’m going to the Data tab
and I’m going to do a simple A to Z sort. And that way I’ve got all of the division together.
You’ll notice there is a point where Australia ends and Canada begins and that’s where we’re
going to have Excel put in a blank row and add up the gross pay for us. If you didn’t know how
to do subtotals this is probably what you would end up doing. You would probably go ahead and
select row 27 and then right click and insert a blank row. Then you’d probably come over here
and write a formula that tells Excel to add up all the gross pay here for the Australian division.
That would work but I’ve got several more I need to do the same thing with so it’s very time
consuming.
Also when I’m done I’d like to have a grand total at the bottom. It’s going to be much easier if
you use the subtotal feature in Excel. I’ll just go ahead and delete that blank row.
Now that I have this sorted, as long as I’m clicked anywhere in the table, I’ll be able to go to the
subtotal feature.
When you’re under the Data tab you’ll see under the Outlining group there is a Subtotal option.
I’m just going to click on that and notice how it went back and selected my table because I was
clicked in the table when I clicked the Subtotal option.
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The first thing it asks me is at each change in. When you drop the list down you’ll notice that
these are all the column headings. Remember if you come in here and it says Column A, Column
B, Column C that means it doesn’t recognize your headers. I want every time the division
changes. So when it goes from Australia to Canada over here. Then I want it to use the function
Sum, meaning add. But notice there are other functions I can use here as well.
These are my headers again and notice gross pay is checked. The only reason that gross pay is
checked is because it’s the last column here. You want to make sure that you have the correct
column chosen that you want it to subtotal.
I’m just going to click OK and now if you look, we’re going to go down and look at row 27, for
example. Here’s where Australia ended and Canada began. So notice it put a row in for us and
over here it’s totaled the gross pay for Australia. But notice it’s also gone down and done the
same thing for Canada on row 43 there. It’s done the same thing for Germany and also the same
thing for Great Britain in row 102. Notice it also added a grant total on row 103 here for us and
that’s the $48,278 that you see right there.
Something else I want you to notice that happened. If you remember us talking about outlining
over in the first section of this module. Look, here’s an outline. There are three levels of
information here, the most important one being level one, which is the grand total. If I click the
two that’ll show me levels one and two and you can see each of these. And then three will show
me everything.
So again number two is going to show me each of my division totals, three shows everything and
one shows the grand total. This will print exactly like this.
What if you wanted to know, for example, why Canada’s number was so low? You could go to
the plus sign to the left of row 43 and when you click on that it will expand just Canada so that
you can look at that. Now I can go back and click the minus sign next to row 43 and fold that
information back up again. We call that Collapse or Expand. I’m going to go ahead and expand
and show all three levels again.
Let’s say this time I’d like to see a count. I want it to count the number of employees that were
paid that particular pay period. I’m going back to Subtotal, I’m going to say each time the
division changes but this time I’m going to use the function Count and click OK. Now if I scroll
down you can see that there were actually 22 employees paid for Australia, Canada had 15 and
then you could go down and see the rest of these. You’ll notice my count replaced the Sum
function that was in here previously.
What if I wanted to see both the Sum and the Count? When I go back to the Subtotal feature I’m
going to come down and uncheck this box that says Replace current subtotals. Count is already
in here so this time I’ll go ahead and choose the function Sum and click OK. And because I’ve
unchecked the box now they’ll both show up. And you can see that for each of the divisions.
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Now let’s say I go back to Subtotal. I wanted to show you that you also have an option to put a
page break between the groups. I’m going to click OK and show you what I’m talking about.
Let me go ahead and go back to Subtotal and I’m going to go ahead and replace current subtotals
and I’ll just have it add. So we’ll choose Sum. I’m going back to the Subtotal option and you’ll
notice there’s an option that says Page Break between groups. As long as you’ve checked this
and clicked OK when you go down and look you’ll notice there’s a line underneath each of your
totals. There’s Australia, you’ll see there’s Canada, and all the way down there’s Germany and
so forth. If you don’t want that page break you can go back to Subtotal and you can uncheck
Page break between groups and click OK.
The last thing I want to show you is what if you’d like to actually turn off the outlining? All you
have to do is when you go back to Subtotal choose the option to Remove All. And when you
click on that you’re going to see that you’re back to the original way your file was set up. It does
not leave your totals in there or anything and now you can see all of your data.
That’s a quick way to work with subtotals in Excel.
Now that we’ve done the outlining and subtotals let’s go ahead and move over to module fifteen
and talk about working with some of the different views that Excel has built in. I’ll see you
shortly.
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Video: Module 14 – Practice Exercise
Cindy: Now that we’ve completed module fourteen, Outlining and Subtotaling I’m going to
have you do a couple of quick exercises for this particular module.
I’m going to have you start with an outline and I’m going to have you open the file called Book
Sales.
In this file you’re going to turn on the Outlining feature and then there’s a couple of different
levels I’m going to have you show me and you’ll see those again in the Word doc.
Then I’m going to have you flip over to this file called Subtotals and in here you’re going to
figure out a couple of different subtotals for me.
The first thing I’m going to have you do is tell me the gross pay per department. Then I’ll have
you add a Count feature to that and then you can actually use the Outlining feature to show me a
couple different levels in this particular exercise as well.
Once you get that done you’ll be good with the outlining and subtotaling.
Next we’ll move over to module fifteen and talk about working with different views in Excel.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Module 15 – Working with Views
Video: Arranging Files
Cindy: We are working now in module fifteen and in this module I want to go over all the
options with having to do with views in Excel.
There are many different ways to arrange your files, to look at new windows, there’s custom
views you can set up, and also what we call scenarios and that’s all the stuff I want to go through
in this particular module. This is section one and I want to talk to you first of all about arranging
files. There will be many times when you need to work with more than one file at the same time
and you need to know how to arrange those so that you could properly see them and do what you
need to do to get your work done a little bit more efficiently. Let’s go ahead and flip over to
Excel and I’ll show you how to arrange files.
Right now I don’t have any files open in Excel but I do have four I’d like to open. I’m going to
click on the File tab, the Open option, I’m going to hit Browse, and then I’m going to look for
those files.
The files I would like to open are Hanover, Jaen, I’ve got Monder, and Summary. You can see
how I was able to click to the left of each of these and check those off. That way I can open all
four at the same time. I don’t have to open them one at a time and that’s a big time saver.
When they’re all open you’re only going to see one on the top of the stack. What you want to do
is if you want to open a different one that you know is already open, you just want to flip to it,
you can go up to the View tab and you can see an option that says Arrange All. You’re probably
going to want the Tiled option but let me just show you a couple of these other ones. I want to
show you what horizontal looks like. Not you’ll see all four files are horizontal on your screen.
You can click on the one you’d like to work with. But if I go back to View on any of these you’ll
see the Arrange All again and you can choose Vertical or Cascade. I’m going to choose Cascade
just to show you what that looks like and you can see all the titles are cascaded up here at the top.
You could click on the one you’d like to go to.
I’m going to go back to Arrange All and just choose Tiled and click OK. And this is the one that
allows you to see everything on the screen at the same time. You can see that if you have a lot of
files open that you may not be able to see much of each of these but you can click in the one
you’d like to work on and do whatever it is that you want to do.
Let’s say, for example, you were trying to copy something. Maybe you were trying to copy this.
You could actually just right click and choose Copy and then you could right click somewhere
over here and just paste it in. That makes it super easy to work between files when you have
them arranged like this.
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If you want to close your files that are arranged you can close them one at a time and then you
choose if you want to save these. When you get to the last one make sure that if you don’t want
to close Excel that you go ahead and say File, just close this way. That way you leave Excel open
and you don’t have any files open in Excel.
That’s pretty easy to do, arranging your files, so that it’s much easier for you to work. Let’s go
ahead now and flip over to section two and I want to show you about the new window option
that Excel has under the View tab.
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Video: New Window Option
Cindy: Hey. Thanks for coming back. We’re in module fifteen and in this module we are
working with Views in Excel. We’ve already gone through section one where I showed you how
to arrange your files so that if you’d like to see multiple files on the screen at the same time you
can. Now I want to talk to you about the new window feature option that Excel has.
Excel has a feature where if you’d like to actually see in a single file the same sheets on the same
screen then you can actually use the new window option to actually do that. Let me show you
how the new window option works.
You can see that I’m working in this file called Payroll and if you look at the sheet tabs at the
bottom it looks like I have pay period ending 2/12 and I have another sheet for the pay period
ending 2/19. Now these are basically the same except that the hours may change or someone’s
rate may have changed and I want to compare these.
Right now if you notice I have to click back and forth between the sheets to look at these. But
what if I could see them both on the screen at the same time? And that’s my goal with the new
window option. Here’s how this works.
It doesn’t matter which tab you’re on and where you’re clicked if you go to the View tab and
click on New Window. Now what you’ll notice is if you look at the name of your file it now says
Payroll but it says colon-2 at the end. And what that’s letting me know is that I’m in a second
copy of my file. Now let me just make this a little bit bigger so we can see this. Same file, I’ve
just got two copies of it actually open.
Now remember we talked about in section one how you could go to the View tab and you can
arrange your files. Let’s say I arrange them and I arrange them vertically. That means when I
click OK I’ve got one on this side and one on this side. Now what if on the left I look at the sheet
dated 2/12 and on the right I look at the sheet dated 2/19 and then of course I can scroll over and
look at whatever information I’d like, but now I can see them both on the screen at the same time
and do my visual comparison. And this is a great way to actually work with a file that has
multiple sheets and you need to see the sheets at the same time.
You can save this. This is one file. It’s just that I’m seeing two copies. It doesn’t matter which
one you save. You can actually even close one of these and you’ve not closed the file itself and
now you can maximize and you’re back in your original.
And that’s really all there is to working with the new window option.
Let’s go ahead now and go over into section three and I’ll show you how to use the Custom
Views feature that is in Excel.
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Video: Custom Views
Cindy: Welcome back. We’re working in module fifteen now and this is the module where
we’re talking about working with the different views that are in Excel. We’ve already talked
about arranging files, we talked about using the new window option, and now I’d like to talk to
you about the Custom Views option.
The Custom Views option will allow you to take a list that you have in Excel and if you’d like to
extract certain information and just see that one bit of information you can do that by using
what’s called a Custom View. Let’s flip over to Excel and I will show you how this works.
Let’s take a look at how the exercise is set up before we start creating some views. You’ll notice
that over in column A they’re actually tracking each item that they sell. It looks like they sell
fruits and vegetables. You’ve got apples, peaches, pears, plums. You can see the list. Also they
are tracking their figures for January through March. They’ve got some figures over in Quarter 1
where they’ve totaled up January, February, March. Then they’ve got April, May, June, Quarter
2, all the way across to the very end where they actually have some yearly totals here.
If you look at this up and down you’ll notice that it looks like they’ve totaled their fruits on row
six, they totaled the vegetables on row 11 and then on 12 they have the total of all the produce,
everything they’ve sold.
We saw an exercise very similar to this in an earlier module when we did the outlining, but I
want to show you now how to create what they call Custom Views.
You’ll notice if you’re on the View tab that here’s the Custom Views option. The first thing you
want to do is make sure you create a view called Original because if you have to go back to it
then you haven’t lost everything. When you get into the Custom Views window you’ll notice on
the right you have a button that says Add. And if you add this is where you can name your view.
I’m going to call this one Original and you want to leave these checked. Go ahead and click OK.
Now let’s say that I’d like to have a view that only shows the fruits. What I’m going to do is
select rows 7 through 12 and I’m just going to right click and hide those. I’m not going to delete
them. Okay? And now you can see just the fruits. If I’d like to pull this up at any time I’m going
to create a view called Fruits. I’ll go back to Custom Views, I’ll choose Add and I’ll name this
one Fruits, and click OK. Now I’d like to flip back to the original so that I can show the
vegetables. I’ll click on Custom Views and this time you’ll notice that I have them both listed.
I’ll choose Original and click Show. This is why I created the original view, because I can now
go back to the original one and hide all the fruits if I want.
So you’ll notice I hid rows 2 through 6 in this case. I’m going to right click and hide those and
I’ll also right click and hide row 12. And now you can see that’s just the veggies. I’ll create a
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custom view. I’m going to add and I’m going to call this one Veggies and click OK. You get the
idea? Now I’ll go back to Custom Views and you can see I have all three of those there.
Let’s say I show Original again and now I see everything that I sell. I could even do this left to
right. Now let’s say we turned on the outlining feature, if you remember that from earlier. Let’s
say that I go back to the Data tab and I go back over here to Group and I turn on the Auto
Outline. If you remember when we did this we were able to hide or show certain levels. Let’s say
that from left to right I want to show just my quarters. So you can see now that I’ve clicked the 2
I’m showing everything that I sell and just their figures for each quarter and the totals at the end
of the year. Now I can save this as a view. I just go back to my View tab, Custom Views, and
let’s say this time when I add I call it Quarters. Now when I click OK and then go back and show
all the views again, I’ll just go back and show the original. Here’s the original. Now I’ll go back
into Custom Views and this time I’m going to show Quarters and you can see there you go. You
could even create one where you hide the quarters and show just the yearly totals. There’s just a
zillion different ways you can use the custom views.
Remember that once you’ve turned the outlining on you do have the ability to turn it off.
Remember go back to the Data tab and you want to go over to the Ungroup option and choose
Clear the Outline. That does not have anything to do with the views. It just cleared the outline.
So if you wanted to go back to one of the views you would just go back to your View tab and
choose the view that you’d like to see.
Notice over here that you can also delete a view. If for some reason you don’t want it, for
whatever reason, just select it and choose Delete.
When you close the file all of this is saved with that file.
That’s really all there is to working with custom views.
Well that’s going to wrap up module fifteen, working with views. Why don’t you go ahead now
and go over into module sixteen where we will talk about linking files.
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Video: Module 15 – Practice Exercise
Cindy: Now that you know how to work with the views in Excel I’m going to have you do a
quick little exercise for me. We’re going to open a file called Views and you’ll notice in this file
that you have two tabs at the bottom. You have one for fruits and veggies and one for books and
music. You’re going to be working with both tabs.
On the fruits and veggies tab I’m going to have you create several different views. You’re going
to create one for the veggies, you’re going to create one for the fruits, and also one for the
original. Remember always create the original view first.
Once you’ve done that I’m going to have you actually create a second copy of this file. And on
that second copy what I’m going to have you do is put them vertically on your screen so that you
can actually see the fruits and veggies on the left and you’ll be able to click the books and music
on the right and that way you can see both sheets at the same time. And that’s really all there is
for working with your views.
Once you’ve got that down then go ahead and move over to module sixteen and we’ll talk about
linking files.
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Module 16 – Linking Files
Video: Creating Formulas Between Files
Cindy: We’ve made it all the way down now to module sixteen and this is the module where I’d
like to talk to you about linking files.
One of the things that I told you way back when we started writing formulas was that you had
the ability to write formulas and put the answers on the same sheet as the data, on separate
sheets, or in separate files. And that’s where we are now. We’re going to talk about creating your
formulas between files here in section one. Let’s flip over to Excel and we’ll get started.
I want to go ahead and open several files to work with. I’m going to click on the File tab and go
down to Open. I’ll Browse and the four files that I’d like to open are Jaen, Hanover, Monder, and
Summary. Notice I just click to the left of these and I’m going to click Open. That way they all
open at the same time and I don’t have to do those one at a time.
Jaen, Hanover, and Monder are sales people for this company and I want to show you how their
files are actually set up. If you look at each one of these you’ll notice that they are tracking each
of the item codes, the price of that item, the quantity that they sold, you’ll have the sales here,
and the commission. The sales is a formula that takes the item price times the quantity to give
you the sales.
Now this is the Jaen file. If I want to flip to another file I just go up to the View tab, go over to
the Switch Windows option and I can flip to Monder. This file is set up the exact same way. It’s
just there is a different quantity in this particular column. And then of course the other one is set
up the exact same way.
Now let me show you the Summary file because that is the one where we’re going to add all of
our total sales from each sales person and have the answer appear here and then we’ll add up the
total commissions and have the answer appear here.
Here’s what we’re going to do. Remember when you’re writing a formula you want to click
where you want the answer to be. We want the answer here in the Summary file in A5 to start
with. We’re going to add up the total sales.
Now what we’re going to do is we’re going to start with the equals sign and we can’t have a
range so we’re going to have to do these individually. And it doesn’t matter in which order you
do these. I’m going to click on the View tab and I’m going to switch windows and I’ll start with
Monder.
The sales happen to be in cell D15 so I’m going to click there. You’ll notice that it put the name
of the file here, then the name of the sheet, and then the name of the cell. And notice it’s an
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absolute value. Now because I have another file to add I’m going to hit the plus sign and now
I’m going to flip over to Jaen. I’ll click in D15 and notice now that file is there with the sheet and
the cell as well. I’m going to hit plus because I have one more and I’ll switch to the Hanover file
and click in D15. And that’s all I have to do. I’ve just gone to these one at a time, clicked in cell
D15 and if I have one more to add I’ll hit the plus sign.
I’m going to Enter right now because I’m done and now you’ll see that I have my total sales of
$10,124.60 here.
Now let me go ahead and do the same thing for the commissions. I’m going to start with the
equal sign. In no particular order I’m going to start with Monder, click in E15, plus, I’m going to
switch windows again and go to Jaen. I’m going to click in E15, plus because I have one more
and I’ll go over and pick up Hanover, click in E15 and since I’m done I’ll hit the Enter key. And
now you’ll see that I have all of my totals there. And you can see for each one of these if you
double click you’ve got this sheet, you’ve got the file name, and notice the file names in the
square braces there always. It’s always followed by the sheet name and remember the
exclamation point tells it to change from a sheet to a cell and then you have the absolute value of
that particular cell. And that’s really all you’ve done.
You’ve actually now created links between these files.
Now all of these files are linked to Summary. They’re not linked to each other. So here’s what
this means. Let’s say that I close any of these files. I’ll go ahead and close this one and I will
save it. I’ll go ahead and close Hanover and I’ll save that one. I’ll go ahead and close Jaen. I’ll
go ahead and close Monder.
Now let’s say that all during the week I’m opening each one of these files and changing their
sales. I’m going to go ahead and open Hanover and I’m going to change Hanover’s quantity for
item code one to ten. Obviously that changes his sales and his commissions. I’m going to save
this and I’m going to close it.
Now let’s try one more. Let’s go back and I’m going to open this time, let’s open Monder and
I’ll change item code five to 13. Obviously again that changes his sales and the commissions. I’ll
save it and go ahead and close it.
Now I’ve done that all week long and now I’d like to go ahead and open my Summary file to see
where I stand. If I go ahead and open it what’s going to happen is it’s going to pop up and tell me
that my workbook has some links and that they need to be updated. Notice that these numbers
have not changed right now. As soon as I say Update, and notice I don’t have to, but as soon as I
say Update now you’ll see my total sales and my commissions have changed and that’s how
links work. I could close this, make sure I save it, and keep doing the same thing as long I need
to.
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What I want to do now is you know how links are created. Let’s go ahead and move to section
two. I’m going to show you all about how to work with these different links and different things
that you can do. I’ll see you over in section two.
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Video: Working with Links
Cindy: We are working in module sixteen and in this module we’re talking about the linking
files feature that Excel has. We just got through talking about how to actually write some
formulas between files and remember when you do that you’re actually linking some of those
files together. There are a lot of things you can do with links and I’d like to take you through
some of those different options right here in section two, Working with Links.
If you remember in section one where we talked about creating formulas between files we were
actually working with these four files right here. We were working with Jaen, Hanover, and
Monder which were sales people for this company and the Summary file that you’re looking at
right here. This is the one where we wrote a formula to calculate the total sales and the total
commissions from each of those files. Remember that I told you that Jaen, Hanover and Monder
are linked to this Summary file but they are not linked to each other. And a couple of terms just
to be familiar with, in Excel when you’re working with links you can have dependent files and
you can have source files. Jaen, Hanover and Monder would be your source files because they
have the data that you need to get these answers. And then Summary would be your dependent
file. It has no answers on its own. It’s dependent on Jaen, Hanover and Monder to get those
numbers.
Now that you’ve created some links let’s talk about how to work with those links. That means
you would have to be in the dependent file, in this case the Summary file.
You’re going to find the links up under the menu under Data and then you’re going to see right
here it says Queries and Connections and then you’ll see here the links. It says Edit Links.
When you’re looking at this Edit Links window this shows you the three files that are linked to
Summary. And you’ve got a couple different things you can do with them.
The first thing I want to mention is this Update Values over here. Now right now if I close Jaen,
Hanover and Monder and then open them back up and make some changes then what happens is
they automatically update Summary when the Summary file is opened. But what if the Summary
file is already open? Then you can just have Excel go and update the values and if there were any
updates that needed to be made these numbers would change right over here.
The next thing you can do is change the source. What if Hanover leaves the company and you
don’t want to link Hanover to this file anymore? Well you can actually do a couple of things. If
you’re going to replace it with a new file you can say Change the Source and then just go tell it
the new name of that new source file. But if you just want to break the link, you just want to take
Hanover away from this all you have to do is click on Break Link right here.
The other thing is you can open the source. If you wanted to open Hanover from here you could.
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Down at the bottom the other thing is there is a startup prompt and what that basically means is
when I open the Summary file remember how it didn’t automatically just update the answers? It
actually had a message asking if we’d like to go ahead and update those. And that’s what this
message is over here. You can have the user choose to display the alert or not, you can say don’t
display it and don’t update or you can say don’t display the alert and go ahead and update the
links. And you notice the first one is chosen automatically. That’s what that option happens to
be.
And I just wanted to show you that because that’s how the links are going to work here in Excel.
You’re going to see a lot of different links in a lot of different places. We’re getting ready to talk
in section three about consolidating your data and there’s another place that you’re going to see a
lot of the links that we’re talking about here.
Let’s go ahead and go over to section three and I’ll show you how to work with consolidating
your data.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Consolidating Data
Cindy: We’re down on the last section of module sixteen now. We’re talking in this module
about consolidating data.
There is a feature in Excel called Consolidation and what it allows you to do is go ahead and
consolidate numbers from multiple files into a dependent file. You could actually just write
formulas to get those numbers but we’re going to take this even further. When you consolidate
you’ll be able to see where the numbers came from instead of just seeing one total, and that’s the
beauty of working with consolidation. Let’s go ahead and consolidate some data over in Excel.
One of the things you’ll want to do before you get started is make sure you have all of the files
open that you’re going to be working between. That means you want all of the source files open
and you want your dependent file. In this case I’ve opened a file called Consolidation and what
I’d like to do is go ahead and select the range C5 through C14 and I’m going to have Excel go to
the files called Jaen, Hanover, and Monder that we’ve been working with and consolidate all the
quantities into this file so that we can see the totals.
One thing you’ll want to make sure of is that all your files are set up exactly alike. If you notice
this consolidation file it’s set up exactly like the Jaen, Hanover and Monder files we’ve been
working with. I’ll switch over to one of these, I’ll just pick Monder, and you can see that it looks
the exact same. Column C is where the quantities are. It’s the range C5 through C14.
I’m going to switch back to Consolidation and here’s how you’re going to start this. You’re
going to the Data tab and you’ll notice there’s a grouping called Data Tools and you want
Consolidate right above that.
The first thing it asks is which function would we like to use. We are going to be adding so we’ll
leave the function Sum but just notice from the dropdown the other functions that I could use.
The next thing I’m going to do is click where it says Reference and then in no particular order
I’m going to flip to each file and select the same range. I’m going to go ahead and start with
Jaen. I’ll select the range C5 through 14 and now you’ll notice that it’s got the name of the file
here, the name of the sheet, and also the absolute value of the range C5 through C14. I’m going
to hit Add so that it puts it in this bottom part of the window here. Now I’m going to do the next
one which is Monder. I’ll do the exact same thing. I’ll drag through that same range, I’ll hit Add.
And then one more. I’ll flip over to the Hanover file, select the same range and add that one.
Now that all three of the references are right here I’m going to click OK. If I flip back now to the
Consolidation file you’ll see right here that it has consolidated all of the quantities so now I
know the total quantities which has also changed my sales and my commissions over here.
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You’re probably wondering a couple of things. First of all, couldn’t I just write a formula like we
did in section one that would add up those numbers? Yes, you could but you’re going to see in a
minute that consolidation is going to give you some additional options.
The other question is how do I know how much of this is Jaen’s and how much is Monder’s and
how much is Hanover’s? I can’t tell that right now. I just know the total. Well let me show you
another little thing that you can do in that consolidation window. I’m going back to the Data tab,
Consolidate. Do you see this checkbox Create Links to Source Data? This is going to be the key
to everything working out really cool here. I’m going to hit OK and now what I want you to
notice is your Outline is on over on the left over here. Let’s take C8 where it says 24. If I hit the
plus sign to the left of row 8 now I can see each number that made up that 24.
The other thing is notice when I’m clicked on one of these I can see which file that came from.
Monder has two of these, it looks like Jaen has 12 of these, and 10 of them belong to Hanover.
That way you can see the breakdown. And you can see that for each of these. I can hit the minus
sign to collapse that and fold it back up. And let’s just say I went to row 28 and I did the same
thing here. I’d be able to see that 48 of these came from Jaen and Monder had two of these and
the last seven belong to Hanover. And that’s what consolidation allows you to do. In addition to
just coming up with an answer you can see all the numbers that make up those quantities.
That’s pretty much going to wrap up module sixteen. We’ve been talking about linking files
here. Why don’t we go ahead now and change focus and jump over into module seventeen where
we’re going to talk a little bit more about writing formulas, we’ll look at some advanced formula
creation.
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Video: Module 16 – Practice Exercise
Cindy: Okay we did a lot in module sixteen with linking files. What I want you to do for me is I
have four files I’d like you to open. You’ve got Jaen, Hanover, Monder, and Summary. When
you get those all open make sure you’re on the Summary file because you’re going to figure out
the total sales and the total commissions for all three of those sales people and the answers will
be on this Summary sheet. That’s where you’re going to create a file that links all of these to the
Summary file. Remember that summary is a dependent file. It has no answers on its own. Jaen,
Hanover and Monder will be what we call Source Files. They have the information to feed into
the Summary file.
Then after you do that I’m going to have you save and close it for me and then you’re actually
going to flip over to a file called Consolidation. And what you’re going to do here is you’re
going to select the range C5 through 14 and then I’m going to have you consolidate all of those
quantities from the Jaen, Hanover and Monder files onto this Consolidation file.
Remember when you go in and do this I want you to go ahead and actually create the links as
well. And then that’s all I’m going to have you do. Just save and close it and you will be good to
go for module sixteen.
Once you get finished go ahead and move over to module seventeen where we’ll talk about some
advanced formula creation.
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Module 17 – Advanced Formula Creation
Video: If Statements
Cindy: Hey there. Thanks for coming back. We are all the way down now to module seventeen.
In this particular module I want to look at some of the more advanced formula creation options
that Excel has available, like If statements, VLOOKUPs and what we call Data Validation. Let’s
go ahead and jump right in to what we call an If statement. This is section one.
What an If statement allows you to do is create a little test. And if that test is true then you do
one thing and if it’s false you’ll do something else. Let’s go ahead and get started and I’ll show
you how to create an If statement.
Before we actually start writing our If statement I want to take a quick peek at the exercise so
that you’ll know exactly what we’re trying to accomplish here. You should be familiar with this
exercise. This is a company called Benjamin of Brussels. We’re looking at their international
chocolate distributors. You’ll notice they are tracking each sales person over in column A, their
numbers of April, May and June over in column B, C and D, and then column E is where they’ve
actually just totaled across. In column F, if you notice, they’re paying each person a commission.
And it looks like right now that commission is based on this 18% that you see over in J3. There’s
also a bonus column, that’s column G. when we go to look at our VLOOKUPs in section two
we’ll be comparing those with this bonus table over here on the right.
One of the things I want to do in this exercise is I don’t want to give everyone a commission. I’m
only going to give them a commission if they meet their quota. Let me go ahead and delete all of
this and then when we put it in we’ll put it in a little bit differently.
Now before we get started I want to see if there are any names already set up in the exercise. I’m
going to go up to the Name box and it looks like there is one. There’s the Com Rate. Let’s see
where that goes. It looks like it goes over to J3 where they have 18%. That’s the commission
rate. I’m going to go ahead and name J4. That’s the quota. I’ll go ahead and name that one
Quota. And then I’ll name one more thing so that when we get section two it’s already done. I’m
going to go ahead and name the range I8 through J10. I’m going to call this one Bonus,
underscore, Table (Bonus_Table). Awesome. Now I have all three of those. Remember that
when you create the names always click to make sure that they go to the correct place because
it’s very easy to accidentally be clicked over to the side somewhere and you’ve named the wrong
cell or the wrong range of cells.
Let’s go ahead and start our If statement. I’m going to click in F6. An If statement actually has
three parts. There is a test, the second part is what to do if that test happens to be true, and what
to do if that test happens to be false. Let me tell you what I want to do here.
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I want to look at each person’s total and I want to know if that total is greater than or equal to
this quota over here in J4. That’s the test. Is it greater than or equal to my quota? If it is we’ll go
ahead and take that total and multiply it times the commission rate which is in J3 and they will
get that commission. But if it’s false, meaning they don’t meet or exceed the quota, we’re not
going to give them a commission at all. We’ll have it return a zero. Let me show you how to set
this up.
The first thing you want to do is always start with your equal sign and I’m going to go ahead and
put in the word If. Now I could go ahead and type the rest of this formula but if you’re not sure
how to do that the best thing to do is let Excel go ahead and type all the stuff in for you. You just
kind of plug in the variables. I could if I didn’t want to put the If in here that way, I could go
ahead and use my Insert Function which is here or remember if I go to the Formulas tab I’ll see it
here as well.
In the Insert Function window I’m looking for a function called If. Remember that if you’ve
recently used it it’ll show up on the most recently used, if not you’ll have to click on All and then
you’ll have to go down to where the I’s are in the list and look for If that way. But look at the
definition. It checks whether a condition is met, which is the test I mentioned, returns one value
if it’s true and another if it’s false. I’m going to click OK and now we’re in the Function
Arguments. And there’s the three things that I just mentioned.
The first thing is the test. Here’s what I want to do. Now notice that instead of just typing in there
I’m going to click the cells. It’s a little bit easier that way. I want it to tell me if E6 is greater than
or equal to, and I’m going to click where this $60 is and notice that the word Quota is in there
because it knows that cell is named. The reason that I wanted to name that is because I could
have put J4 in there and it would be been correct but when I get ready to copy my formula down
the other answers would not be correct because it would go to J5, J6, J7 just like that. Notice that
it tells me this is true already so I’m going to go ahead and do the second part. What do we want
Excel to do if this is true? Well I’m going to have Excel take my total in E6 and multiply it times
my commission rate which is in J3. This is another one that was already named in the exercise. I
could have put J3 but then again I would have to make it’s an absolute value.
The third part is what to do if it’s false. We’re going to return a zero. It just looks better when
you have numbers in a column. But know that you could put text in there as well. If you want it
to say “Did not reach the quota” or anything you could put any text at all in there.
If you don’t put anything in that field what will happen is you’ll see the word False in there and
that will look really funny when you have a column of numbers like this. I’m going to go ahead
and click OK and you can see that now I have 19.
Now I want to go ahead and copy this formula down so I’ll just drag it all down. And you can
see that three people did not meet their quota. If you notice Monder only had 52 for his total.
Simmonds has 39 and Peruzzi has 56. So you can see this is exactly what I wanted from this.
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Now I want to go back and double click on F6. I want to just show you how this formula is set
up.
We know we start with equals and we’ve got the word If there. Here’s the part that I wanted you
to see because that’s the test. There’s where we said E6 is greater than the quota and notice it has
a comma because then there’s another field. Here’s the second one where we said that if it’s true
you want E6 to be multiplied times the commission rate and then the last one where we put the
zero in is right there. So really the three fields we filled in are in the parenthesis here and they
just have commas between them. Like I said, I could have typed that but it was just much easier
to let Excel fill that in for me. I’m going to go ahead and hit Enter there and that’s a quick way to
do what we call an If statement.
Well now that you know how to do an If statement let’s go ahead and talk a little bit about how
VLOOKUPs work. Let’s go over to section two of module seventeen, Advanced Formula
Creation, and look at the VLOOKUP option.
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Video: VLOOKUPs
Cindy: Hey there. We’re all the way down now to module seventeen and we are talking in this
section, which is section two, about what we call a VLOOKUP or a Vertical Lookup. You also
have the ability to create what they call HLOOKUPs and an HLOOKUP is a Horizontal Lookup.
Basically what a VLOOKUP or a Horizontal Lookup is, is you can tell Excel to look at a
particular cell and then compare it to a table. In that table it can look up a value vertically or
horizontally and pull out something in the same row. Let me show you a little bit about how
VLOOKUPs work and this will make a little bit more sense to you.
This is the exercise we used in section one when we were looking through our If statements.
We’ve gone through and we have a total for each of our sales people in column E, column F is
where we figured out their commission, and now I want to figure out a bonus for each one of our
sales people.
The way we’re going to figure out the bonus is we’re going to have Excel look at each person’s
total over in column E and then they’re going to compare it to this bonus table that you see right
here and they’re going to use the first column to compare it. We’re going to have it look for the
closest number without going over and then return a value over in the second column on the
same row.
When you’re going to work with a VLOOKUP you’re telling Excel to vertically look in a table
that you have somewhere. You do not have to have the table on this sheet. It could be on another
sheet if you want.
The one thing you’ll want to do before you start writing your formula is go ahead and give your
table a name. I’m going to go ahead select in this case from I8 through J10. Notice I’m not
selecting the word Total or Bonus because then it will want to look through that column and look
through the cell that contains the word Total and we just it to look through the numbers here.
Now I’m going to go back and name this. I’m going to go to the Name box and here I’m going to
put in Bonus, underscore, Table (Bonus_Table), I’m going to hit the Enter key and remember I
told you when you create a range name to go ahead and check it out and make sure it goes to the
right place before you start actually doing something with it and you can see that it does. It
works perfectly. Now I don’t have to name it but if I didn’t when I’m actually setting up my
criteria then I’d have to make sure I saw the absolute value of the range I8 through J10. And that
can be a real pain and you can forget the dollar signs and all that. So it’s just easier to go ahead
and name it before you start.
I’m going to column G and I’m going to just delete all of these and let’s start with Hanover in
G6. I’m going to start with my equals sign. Now if I type VLOOKUP then I have to know how
to type the rest of the formula. It might be a little bit easier for you if you leave out the word
VLOOKUP right now and just go ahead to your Formulas tab and use the Insert Function to put
© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019
it in that way. If you’ve recently used VLOOKUP you’ll see it in this list. If not you might have
to go to the category called All and look for it that way.
Now if you read the definition with me it says it looks for a value in the left most column of a
table. It’s going to look in this first column for the value that we specify, which will be each
person’s total. Then it’s returning a value in the same row from a column that you specify. For
example, if I look at this 52 for Monder then what’s going to happen is it’s going to look in this
first column, it’s going to find the fact that Monder is over 50 but below 68 so he will get a two
bonus. By default the table must be sorted in ascending order. This column right here has to be in
ascending order in order for this to work properly. Now I’m going to click OK and here’s where
I put in what we call the Function Arguments.
Notice the first three are bold because you have to give it that criteria but the bottom one you
don’t have to and I’ll explain that in a minute.
The first thing it asks you to do is to tell it what you want it to look up. We’re going to start with
Hanover so I want it to look in E6 where we have 103. That’s all it wants to know is where is the
value you want me to look up.
The second field says where’s the table you want me to look through. We can do a couple of
things. We can start typing bonus table here, we could select the range here, but remember if it’s
on another sheet that may not be the best way to do it. You could also under the Formulas tab
come up to where the names grouping is and choose Use in Formula. I’m going to choose the
bonus table and you can see it plugged it in and it already puts all the values there.
The next one says Column, underscore, Index, underscore, Number (Column_Index_Number).
And that basically means which column in the table do you want Excel to actually pull the value
from. When you talk about the table it does not recognize this first column as I and the second
one as J. It sees it as column 1, column 2, and so forth. We know we can’t pull from the first
column because that’s the comparison column. So in this case we can only pull from column 2 so
that’s all that is.
Now this last one, here’s why it’s optional. You have the ability in Excel when you’re doing a
VLOOKUP to have it find the closest match like we’re doing or to find an exact match. If you
type in this field the word True or nothing at all it will find the closest match. If you want it to
find an exact match you have to type the word False in that particular field. I’m going to leave it
blank and click OK and now you can see that Hanover gets a bonus of eight.
Let’s go ahead and do one more. Let’s do Monder. I’m going to start with my equal sign, I’m
going up to the Insert Function, I’m going to choose VLOOKUP and click OK. The first thing it
wants to know is which cell do you want it to look up. In this case it’s going to be E7. The next
thing it wants to know is where’s the table you want it to look through. Remember this is where
I’m going to choose the Use in Formula option and pick Bonus Table. And the third thing it
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wants to know is which column in the table do you want it to pull from. It’ll be a number two in
this case. We’re going to leave range lookup empty since we’re not looking for an exact match
and I’m going to click OK. And now you can see he’s got a two. His total is 52, which is after 50
and before 68 so he gets a two bonus right there. And that’s how a VLOOKUP works. Let me go
ahead and copy the rest of these down and they should all be correct.
Keep in mind, like I said, there are also HLOOKUPs. Instead of looking through a column of
information you might want it to look through a row of information. And you can have as many
columns and as many rows in your table as you’d like.
Well that’s how a VLOOKUP works. Just practice that a little bit and you’ll find that they’re
pretty easy to do.
I want to take you now over into section three and let’s talk a little bit about what we call Data
Validation.
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Video: Data Validation
Cindy: We are in module seventeen. We’re talking about advanced formula creation. We are all
the way down to section three and this is the section where I’m going to talk to you a little bit
about what Excel called Data Validation.
There might be times when you have columns that you’d like others to be able to put data into
and instead of actually letting them freely type you can actually set up some dropdown lists with
some messages to tell them what to put in the cell and things like that. And that’s called Data
Validation. Let me give you a quick example of how this would work.
We’ve got this product list here and if you notice in column A they’ve got the item code, column
B is the price, and then we have column C, a place where others can come and put in the color of
that particular item. Let’s use blue as an example. What’s going to happen if multiple people use
the same file is one person may type Blue with a capital B, another person may use a lowercase
B, someone may come along and misspell it, someone may not type anything in there at all and
you just end up with all kinds of just junk in that particular column and it makes it almost
impossible to either sort or filter your list when it’s all messed up like that. What we can do is
create a dropdown so that someone has to pick an item from the dropdown list and that keeps
everything in that particular column consistent.
Now in order to do this you have to have a list somewhere in your file. You can put it over to the
side if you want, you can put it on another sheet. It’s probably best to put it on another sheet
because then you can go through and hide that sheet and others can’t go in and actually mess
with the list and maybe rearrange it. But let’s start off just putting our list over to the side
somewhere.
Let’s say that over here we just put in a couple of colors. We’ll do Blue, we’ll do Green, we’ll do
Red, and we’ll do Yellow. Okay and I’m going to go ahead and make the list left aligned there so
it matches. You don’t have to put the list in alphabetical order but it’s probably best because
people expect to see that when they’re picking from a dropdown.
I’m going to go ahead and start over in column C and I’m going to go ahead and select from C5
through C14. Where we want to go is under the Data tab you’re going to see a group called Data
Tools and right above it here it says Data Validation. You want to choose the very first one, Data
Validation.
Under the first tab which says Settings here’s where you could tell Excel what types of things
you’d like to allow in these cells. Notice your choices. You might have numbers and you might
say just whole numbers, decimals. You might have a list, which what we’re going to do. Notice I
might have dates in here. I might have text. Maybe you have a particular text length. You only
want it to be 20 characters. There’s tons of different options you can pick. Ours is going to be a
list that people pick from.
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Now you’ll notice if I choose List I don’t have to pick anything here. It’s grayed out. But I do
have to tell it the source. Where is the list. I’m going to go back here and select it like this and
you see that that range is now an absolute value. I’m just going to click OK and now you’ll
notice there’s a little dropdown next to each cell when you click there. So if I click there and
drop the list down there’s my list and I can choose whichever colors I’d like to pick for that list.
And you can see now that this is keeping everything very consistent. I’ll be able to sort very
easily. So let me just randomly pick a few more things from this list here. We’ll do Red here,
we’ll do maybe Blue here, and one more. We’ll do another Blue.
Now let’s look over at the column that says Colored Number. Let’s say that when someone types
a number here it has to be between 100 and 200. What we’d like to happen is we want the user to
see a message before they start typing that tells them that it has to be between 100 and 200. And
we’ll also talk about how to set up an error message so if they happen to type a number outside
of that range it prompts them.
I’m clicked over in the Color Number column, that’s column D. I’ll go ahead and select all the
way from D5 through D14. I’m going back to Data Validation. I’ll choose the first one again.
This time we’re going to say we want a whole number. Now you’ll see that it pops up and says
Between, but notice my choices. It might be that I want to pick a whole number that’s greater
than a certain number that I tell it, less than a certain number. We’re going to say the minimum
number is 100 and the maximum number is 200 and then click OK.
Now what you’ll notice is that if I come over here and type in, let’s say I type 150. Well that’s
obviously within our range but what if I type 250? Since that is outside the range that I told it it
gives me an error message that says the data value doesn’t match the restrictions defined for this
cell. And the individual can go and retry.
Now we didn’t tell them that ahead of time. They didn’t know that. So let me show you how to
set up these little messages so that the user knows exactly what you’re wanting from them. If you
go back to Data Validation then what you’re going to see is there is an Input Message. You do
have to give all of your messages a name. I’ll go ahead and just say Input. And down here I’m
going to say “Must enter a number between 100 and 200.” And I’ll click OK and now you’ll see
that that cell when you’re actually clicked on it tells the user exactly what they have to do.
Now you’ll notice I only did that one cell. So now I’m going to have to copy that down to all the
cells if I want that message to appear when I click on any of these cells. I also don’t have it on
the first cell so I’d want to copy it up there. And I’m going to go ahead and fix this because it
will drive me crazy if I don’t. That is a bottom border. Now let’s say I type in 150 which is in my
range and let’s say that I type in 300 again. So I know what I type in there but I still don’t have
the error message I’d like the user to see.
So that’s the third thing I want to show you is I’ll select the range again and when we go back to
Data Validation we can also have an error alert. I will need to put a title here. I’ll call this Error
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Message. And then down here I’ll actually put the message. “The number you typed is incorrect.
It must be a whole number between 100 and 200.” I’ll click OK and let’s try it out.
I’m going to type 250 here and there’s the exact message that I just told it I would like my user
to see. And that’s really all there is to Data Validation. I could go ahead and create another list
over here for the departments if I wanted and then I would have a dropdown list for that column
as well.
I did mention to you earlier that you probably want to have these lists on another sheet. Then go
and hide that sheet and that way no one can go in and actually rearrange your list or add
something to the list. Something to be really careful about if you don’t actually protect the list
and have a password somebody who knows that the sheet is hidden can go in there and unhide
the sheet and then change the list. Just be aware of that.
That’s really all I wanted to tell you about Data Validation. Let’s go ahead and move into section
four and we’ll talk about formula auditing.
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Video: Formula Auditing
Cindy: Welcome back. We are all the way down to section four of module seventeen. We’ve
been talking about advanced formula creation in this particular module. This last section,
Formula Auditing, is all about formulas that you might have in a file and being able to find those
formulas, which cells are referenced in those formulas or vice versa. I want to go ahead and
show you a little bit about how to work with some of the formula auditing tools that Excel has
available.
There are several things I want to show you in here in reference to the auditing feature. First of
all you’ll notice there’s several error messages right in here and I want to tell you what these
actually mean because you’ll see these from time to time.
The first one that says number sign and it says DIV, slash, zero, exclamation point (#DIV/0!),
because it has the word DIV in it that tells you there’s a division error in here. If I open this up
you’ll notice it’s trying to figure out the average of the range D11 through G11. Average
includes a part of math where you actually divide. There is nothing to divide. You can divide a
zero by a zero but you can’t divide absolutely nothing by absolutely nothing. And that’s what
that means. If I put in any cell in that range just a zero, it could be any number, you’ll notice
immediately I have my answer over here and the formula is correct. So any time you see the DIV
there’s something with division going on that it doesn’t like. I’ll go ahead and plug these in.
This one here that says Number Name this is a very common one that you might see. We’ve
been talking a lot about range names and if you look on our dropdown here we’ve got Rivena.
And if you notice that’s this person’s last name. And it refers to D12 through G12.
If I look at the formula over here it looks like they’re trying to average Rivena but they
misspelled the name. That’s why. There’s no name R-I-V-N-A. His name is actually R-I-V-E-NA and that’s how we had set it up up here when we originally had looked at this. Let me hit
Escape. There you go. R-I-V-E-N-A and this one is spelled R-I-V-N-A.
You can fix this by spelling the name correctly. If I drag across this I can certainly type it but I
could also go to my Formulas tab and choose that name from the Use in Formula option right
here. And now that it’s spelled correctly when I hit the Enter key that name will disappear. Now
this one actually has another error because there’s division that goes on. As soon as I plug in the
zeroes like you see here you’ll see that now the error is gone. So those are two very popular
errors that I wanted you to be aware of.
Now let’s say that I click inside of a cell that has a formula. This could be any cell here. On your
Formulas tab when you come over to the Formula Auditing section here you’ll see a couple of
things. Like I want you to be aware of this Show Formulas button. If I turn this on I can see all of
the formulas that are actually in my file here. And this will print just like this. This is very handy
if you’re trying to create a formula very similar to one here and maybe you’re in another file you
© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019
can look at what you did previously. There’s several different reasons for wanting to actually see
these. If you don’t want to see them you can go back and turn off your Show Formulas and
you’re back to where you were.
I also want to point out the Trace Precedence and Trace Dependents right here. If I’m clicked in
a cell with a formula I can trace the precedents. These are going to be all the cells that are used in
this formula. You can see in this case that it’s using D7 through G7.
If you ever wanted to remove these arrows there is an option right here that says Remove
Arrows.
If you click in a cell that is not a formula that’s called a Constant. I have the ability to see which
formulas this cell was used in. That’s the option Trace Dependents. It’s looking for the
dependent cells, the ones in Formulas that are dependent on this one to get an answer. You can
see this cell is used in it looks like a couple of formulas. It’s used over in H14, it’s used in I14,
and you can see down here it looks like F22. So that’s another good thing you’ll want to know
from time to time.
Again to remove these I can come over to the Remove Arrows and turn that off.
Now notice there’s a dropdown here because sometimes you don’t want to remove all the
arrows. Sometimes you want to remove just the precedent arrows or just the dependent arrows.
Either one would work for you.
That’s just a quick overview of some of those Formula Auditing tools that I wanted you to really
be aware of here.
Let’s go ahead and wrap up module seventeen. We’ve been looking at some advanced formulas
and now I want to go ahead and take you over into module eighteen where we’re going to
discuss pivot tables.
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Video: Module 17 – Practice Exercise
Cindy: We finished module seventeen now and in this module we were talking about some of
the advanced formula creation options that Excel has available. We looked at If statements, we
looked at VLOOKUPs and also we did some Data Validation and Formula Auditing.
I’m going to have you for you practice exercise open this file called Chocolate Sales and you’ve
got quite a few things you’re going to do in here.
First of all you’re going to create some names. I’m going to have you name your commission
rate, your quota, and this bonus table here so that when you write your formulas to figure out the
commissions and the bonuses you’ll already have those names available and you can use those in
your formulas.
Once you get all that done I’m going to have you do a little bit of data validation. You’re going
to go over to Sheet2 which is just a blank sheet and create a list and then you’re going to come
back in and create a new column for column B and in that column you’re going to have
dropdown arrows so that people can pick their department from the list.
I’ve got all of that on the Word doc ready to go. So make sure you go back through these linking
files videos if you forget how to do some of this stuff.
When you’re finished going through this exercise go ahead and go over to module eighteen and
I’ll show you how to use pivot tables in Excel.
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Module 18 – Pivot Tables
Video: Pivot Tables
Cindy: Welcome back. We’re now in module eighteen and we’re going to talk briefly in this
module about pivot tables. This is section one and I want to show you in this section how to
create a brand new pivot table.
Some people call pivot tables Interactive Worksheets because they allow you to take some raw
data that you couldn’t write formulas for to get certain answers. And a pivot table will allow you
to get those answers. Let me go ahead and show you an example of one and then I’ll go ahead
and show you how to create one.
What we have here is just some raw data. If you notice they’re tracking the store name, the
product name, the units, and the sales rep. And when I look down the list there are no formulas,
nothing in here. It’s just raw data.
What if I asked you some questions like this? I would like to know for each sales rep which store
they were in and the products that they sold. What if I wanted to know something like for each
sales rep how many units of each product did they sell? Those are questions you can’t have
answered by just putting in a formula and that’s where a pivot table becomes very handy for you.
Let me give you an example of what a pivot table looks like. I’ve got one set up down here on
this second sheet called Pivot Table. And this is an example of a pivot table. Notice they have
listed on the left each of the stores, the products that were sold in that store, the sales rep, and
how many of each product they sold. You can also see some grand totals over here and there’s a
lot of other types of information we can get out of this, but this is an example of a pivot table.
Let me go ahead and flip back to the data sheet and we’re going to create our own pivot tables
from this data.
A couple things to remember when you’re setting up the raw data itself. Make sure Excel
recognizes the header rows at the top. Also there’s no formulas in here, no blank cells, none of
that. It’s just information.
When you start your pivot table you want to be clicked anywhere inside your data here. You’re
going to the Insert tab at the top and we’re going to insert the first one. It’s called a Pivot Table.
Excel will ask you to select the range that you’re wanting it to analyze and because you were
clicked in the range it already knows that. You can see it has the sheet name and the absolute
value of the range. It also asks you down here where would you like to put this pivot table. You
can put it in a new worksheet or an existing one that you would have to go and tell Excel what
the location is. Let’s put it in a new worksheet and click OK. And this is a blank pivot table.
Now let me just zoom in a little bit so you can see this a little bit better.
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What you’ll notice is this is the blank pivot table over here and over on this side you actually
have the column headings from your data. You are able to drag and drop these into the table
wherever you want to get information that you couldn’t get with the raw data.
The first thing I want to mention is this pivot table fields window if you happen to close it like
this and you go, “Oh, how do I get it back?” Usually you have to click in the table, provided that
you didn’t turn it off, but if you actually turned it off notice now you’re actually on the Pivot
Table Tools contextual tab. If you’re under the Analyze tab under that you can come over to the
right and show the field list and that will bring this back up.
Here’s a couple of things I’d like to know. Let’s say that I would like a list of all my sales reps
and I’d like them as what we call row fields over here. See how I’m just dragging and dropping
this into the pivot table and now I see all my sales reps? And if you notice it actually put them
down here where it says Rows. Some people have to visually conceptualize this. This is why
they drag it into the pivot table itself. Other people just know and they’ll drag this all the way
down here and get the same result. Whichever one works for you.
Now let’s say that I’d like to see all my stores across the top here where it says Drop Column
Fields. Now there’s all my stores. What I’d like to know now is for each sales rep how many
units they sold per store. I can take the units and drop that in the middle where it says Drop
Values Fields Here and now I have that information. You can see that Andrews was in the
Rochester store and he sold 186 and his total is 186.
Now let’s say that I want to take this a step further. What I want to know is the same information
but I want to look at it by product as well. I can take this product and drop it at the top where it
says Drop Report Filter Fields here and now what I’m seeing is this total represents all of the
products but I could drop the list down and here’s the different products that are sold. And let’s
say I just want to know the floppy drives. I could click there and click OK and now you’ll see
that only a couple of people sold floppy drives and they’re in the Buffalo store, the Rochester
store, and the Utica store and then there’s the totals. Isn’t that cool?
And you can see this is a filter. So if you said, “No, I was really wanting to know how many hard
drives they sold” you could change it out and now you have that number per store.
The other thing you can do is that if you decide that you want to go ahead and clear some of this
information out all you have to do is start dragging these fields out of your pivot table like this.
As long as you drag them all the way out, like this. The other thing you can do is just uncheck
them from here. Either one of those would be perfect.
Here’s some other scenarios that we could do. Let’s say that I want to make the store a report
filter field. I’ll just drop that up at the top. And then let’s say that I’d like to see all the products
that I sell, and I’ll drop that over on the row fields. And then I want to see this by sales rep. I’ll
drop that up here. And then we’ll look at the number of units. I’ll drop that where it says Drop
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Value Fields Here. Now what I’m looking at is here’s all the products that I sell and I can see for
each product how many Andrews sold. I can see that Augustine sold 40 hard drives. It looks like
Augustine also sold ten keyboards. And that’s for all of my stores. If I only want to look at one
store I can drop the list down and let’s say I pick the Syracuse store and click OK. Now I can see
each product for the Syracuse store, each sales person and how many they sold. You can keep
coming up with all kinds of different scenarios here to get some information out of just raw data.
And that’s the whole idea of a pivot table.
A couple of other things you’ll notice is right here in A3 it says Sum of Units. If I’m going to
print this out and be really professional about that I really don’t want it to say that. If I go back
up to my Pivot Table Tools contextual tab over here you can see that the active field, the one I’m
clicked in, is called Sum of Units. There are field settings for this. For example, I’m actually
adding. But what if I said give me a count? The same information but I want a count or an
average. You can see that you can pick some of these different functions that we’ve talking
about. If these are numbers you’ll notice that we’re assuming these are dollars but they could be
a number like an amount that we sold, but let’s just say they represented dollars. Then I could
come over here where it says Number Format and I could tell Excel that these represent currency
and then pick my choices. And when I click OK now these are all currency. I’m going to undo
that. I could also, by going back to my field settings, go to the Show Values As over here and
right now there’s no calculations but I might want to show these as a percentage of the grand
total. I might want to show these as a difference from something, a percentage of a difference.
There’s just all kind of options you can pick here as well. I’m going to go ahead and cancel that
but those are some of the options under your field settings there.
Now the other thing is, like I said, if you want this to be more professional you may not want to
say Sum of Units. You can actually rename what that field looks like. So what I might say is
Number of Units Sold. And what’s going to happen is when I click Enter you’ll see this changes
and it now represents the number of units sold.
Those are a lot of different things you can do there. There’s also some things that have to do with
pivot charts that we’re going to do here shortly. I want to go ahead and stop the video now and
we’ll talk about pivot charts over in section two.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

Learn Excel 2019

Video: Pivot Charts
Cindy: We’re working in module eighteen and we’re talking about pivot tables in this particular
module. We’re on section two now. I’ve already showed you how to create a pivot table. Let’s
talk about how to create a pivot chart.
A pivot chart is basically the information that you have in your pivot table, just in a chart format.
Let’s go ahead and see what a pivot chart looks like.
If you decide you also want a pivot chart you have to create that based on the pivot table data
information. So you have to have the pivot table done already. Start by clicking anywhere inside
the pivot table.
When you go up to the Pivot Table Tools contextual tab you’re going to see right over here it
says Pivot Chart. And if you click on that then you’re going to see a chart pop up. If you
remember we talked about regular charts in a previous section. Here’s where I can decide which
type of chart that I would like to see and I’ll just say a regular column chart like this. And when I
click OK here is a pivot chart created on the data from the pivot table back here. If this pivot data
changes back here that changes the chart.
The other thing is this data here, these numbers come from my actual data. So I’d have to go
back to the sheet that the data is on down here at the bottom, change these numbers, then that
would actually in turn change the data here on the pivot table and that would change the data on
the pivot chart. So you always have to go in that particular order. But what’s really cool about a
pivot chart is if you notice here I’ve got a dropdown where it says Product. Currently I’m
showing all of the products. So you can see that floppy drives are this blue color, hard drives are
this orange color and so forth. If I click the down arrow and just want the keyboards, for
example, then I can click OK and now I’m showing just the keyboards for each of the sales reps.
I might want to show a couple of different products. Maybe the keyboards and memory boards,
for example. And now you’ll see I can see two products for each sales person.
I can also go in and filter this out by sales person. Maybe I just want a couple of these different
people to show up in the list. There’s just multiple ways that I can filter out the products I’d like
to see and the sales reps.
And remember in this one we also had the stores. So I could take this one step further and just
show the Albany store and you can see obviously there are no products that meet my criteria
here. So I would go back and choose a different store maybe or choose All and if you wanted to
choose multiple you could check this box and uncheck the ones you don’t want.
The bottom line is that you can come up with all kinds of information in a chart format here form
that data from the pivot table.
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That’s all I wanted to show you about that right now. That’s a pivot chart.
Let’s go ahead and move over now into module nineteen. There’s a lot of little miscellaneous
features that I want to go over with you. That particular module is called Additional Excel
Features.
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Video: Module 18 – Practice Exercise
Cindy: We’ve gone through and completed the module eighteen which is all about pivot tables.
Now you know how to create pivot tables and also pivot charts from those tables.
In this exercise I’m going to have you open a file called Pivot Table and here you’ll see all the
raw data that you’re going to use to create your pivot table. You’re going to go ahead and create
it. Make sure you put it on a new sheet. And then if you open the Word doc that gives you the
instructions for the exercise you’ll see a couple of examples of what I want yours to look like.
Make sure that you go through and format it when you’re done so that all of your numbers
represent dollars and then you can go ahead and save and close the file.
Remember if you have any questions go ahead and go back through the videos and then when
we’re done we’ll go ahead and go into module nineteen and talk about some additional Excel
features.
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Module 19 – Additional Excel Features
Video: Slicers
Cindy: We are working in module nineteen now and in this particular module I’m going to go
over some of the additional features that Excel has. Some of these are just little small things but
they’re really helpful when you need them. I want to go ahead and start here in section one with
what we call Slicers.
A Slicer is basically a way to filter your data visually. And you’re going to filter that data from
pivot tables you’ve created. Let me show you how Slicers work.
Like I mentioned, your Slicers are just a visual way to filter your data but the data has to already
be in a pivot table. That’s the little key here. I’m going to go ahead and click inside my pivot
table and when I click on the Insert tab you’ll notice that over here is a grouping called Filters
and there’s a Slicer option right here. If you click on that you’re going to get this dialog box that
pops up that says Inserts Slicers.
This is a list of all of your fields or your column headings from your data. You click on the ones
that you’d like to create a slicer for. I’ll choose the Store and the Sales Rep and click OK. And
these are what we call Slicers.
Now you might notice that they came in on top of each other. This is just an object so if you’d
like to move it you just get up in this area here and click and drag it wherever you’d like it to be.
Notice you could also change the size of these if you needed to or if you didn’t want to change
the size notice I can scroll since this one has quite a few sales reps in the list.
Here’s the general idea of how slicers work. If I wanted to see one store and all the sales reps in
that one store I could click Buffalo, for example, and now I’m seeing that Kent and Pulaski are
the only two reps in the Buffalo store. You can see this one has a filter applied. I can hit the X if
I want to take the filter off and then I’ll see everyone again.
Let’s say I want the Rochester store. I can see there are two people in the Rochester store. And if
I hold the Control key and click Syracuse you can see now there are four sales reps between the
two of those. Holding Control let’s you choose more than one store, in this case. If you want to
clear your filters you can hit the X and clear your filters.
You can arrange the slicers in any way you’d like. I’ve got these side by side by let’s say that I’d
like to arrange them maybe one on top of another like this or maybe they’re not lined up just the
way I want and I want to line them up there’s several things I can do.
What I’m going to do is go ahead and go to the Slicer Tools contextual tab again and right
underneath that you’ll see several things. For example, if I want to align these I can hold the
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Shift key and click them both and then I can choose to align and let’s say I align the tops. Now
they’re perfectly lined up on the top here.
Let’s say I do want this one to sit on top of this one and then I changed my mind and say I’d like
to bring the Store forward. As long as I’m clicked on Sales Rep I can send it backwards. If I
choose the Send to Back option that sends it all the way to the back of the stack versus the other
option would have sent it one layer at a time. And we only have one layer in this case. My point
is there are multiple ways that you can actually work with the look of how these are set up on
your screen here.
The other thing I want to mention is that you have the ability to go in and change the styles.
You’ll notice here it says Slicer Styles and you’ll want to dropdown your scrollbar because I
might want this one to be green or I might want this to be one of these orange colors. You can go
in and just change the style what you’d like your slicers to look like.
One of the things if you get really advanced with Excel you’ll learn how to create what’s called a
Dashboard. Basically a dashboard is when you open the file you would see a screen that shows
you maybe some charts, maybe some slicers, just a visual representation of the data in this file.
And one of the things people do there is they create slicers so they show up when they actually
open the file.
That’s just a quick overview of how slicers work. Why don’t we go into section two and talk a
little bit about working with the Goal Seeker.
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Video: Goal Seeker
Cindy: Welcome back. We’re working in section two of module nineteen now, Additional Excel
Features. This section has to do with the little feature Excel has called a Goal Seeker. The Goal
Seeker is very handy if you know that maybe you want to make a big purchase but you don’t
know things like what should the interest rate be or what could the term in months or what will
the monthly payment be. Those types of things if you know some of the variables Excel can spit
out the other variables for you. Let me give you a good example of how the Goal Seeker actually
works.
For this loan workbook you can see that I know the principle amount is $18,000. I’ve got the
interest rate set at 12%, the term in months at 60 and that makes my monthly payment $400.40.
if I click over where the monthly payment is there’s actually a formula here that basically says if
you change any of these numbers go ahead and change the monthly payment and you’ll see that
it changes.
Now let’s say as an example I go over here and I change the interest rate to 6%. That obviously
changes my payment to $347.
What if I know that I can $375 a month but I don’t really know what interest rate that would
allow? Well Excel will actually tell me this if I use the Goal Seeker feature. The Goal Seeker is
part of a group of features we call the What If Analysis grouping. I’m going to go ahead and
click on the monthly payment for a moment. If you’re under the Data tab you’ll notice that over
here where it says Forecast there’s a group of options under What If Analysis and one of these is
called Goal Seek. Now here’s how the Goal Seek works.
I’m already clicked in F4 where my formula is. That’s how it knows which cell it’s going to
change the value in. It wants me to tell it in the second one what the value should be. I’ve
decided it’s $375. This third one wants to know which cell should it change to set F4 at $375 and
we’ve decided it’s going to be the interest rate. I’m going to hit OK or Enter and now it tells me
that to get to $375 with the other variables staying the same my interest rate has to be 9.2%.
That’s how the Goal Seek works.
Now I could do the same thing if I wanted to keep the interest rate but maybe change the
principle. I can change any of these variables.
The next little feature I want to talk to you about in section three is called Text to Columns. Let’s
go ahead and flip over there and I will show you how that option works.
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Video: Text to Columns
Cindy: We’re in module nineteen and we’re all the way down now to section three, Text to
Columns option. There is an option in Excel where if you have information that’s in one column,
like a first and a last name for example and you want to actually separate those you can do that
using the Text to Columns feature. Let’s go ahead and flip over and I’ll show you how to
separate those names.
Sometimes you might end up with information like you see here all in one column when it
should be separated into multiple columns. Think about his list here. If I wanted to sort the list by
last name I could not do it the way it’s set up because it’s all in the same cell. You should always
think smallest meaningful value when you’re going to sort or filter and that means you want Mr.
or Mrs. in a column, you want first name in its own column, middle initial in a column, last name
in a column, and so forth.
You can get Excel to just separate this for you so you don’t have to manually go through this list
to do it.
I’m going to go ahead and select all of these and under the Data tab you’re going to see this
option right here that says Text to Columns and I’m going to click on that.
The first thing in this little wizard asks you to choose the file type that best describes your data
and usually I’ll choose the top one, Delimited. But it wants to know how my data is separated.
So you can see it mentions characters such as commas or tabs or even separate fields. Now in our
case they’re separated with a space in between and it doesn’t mention that here but if you just go
ahead and hit Next then you’ll see that here you can choose the Delimiter or how your text is
separated. In this case there’s a space there. And then this is a little preview. So this is how you
can see if it’s going to work.
Then you’ll choose Next and it asks you to choose the Column Data Format. Do you want this to
appear as general text, which we do, but notice if it was a date or time there’s different
formatting options you could have for that as well. In this case we would just hit Finish and now
you’ll see that your data has been separated.
Just a little FYI. If you ever needed to condense the data or put it back you can actually use a
function called Concatenate and you would get to that using your Insert Function button.
That’s pretty much how the Text to Columns option works. It’s a little tiny feature but it means a
lot when you need it. Let’s go ahead and go to section four and we’ll talk a little bit about the
Watch Window.
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Video: Watch Window
Cindy: We are in module nineteen and we’re all the way down now to section four where we’re
going to talk about the Watch Window.
There might be some cells that you need to kind of keep an eye on in case maybe the answer
changes and you can turn on this little watch window and have it sit on your screen no matter
where you are in the file and that way you can watch those cells that you’ve set up in the Watch
Window. Let’s go ahead and flip over to Excel and I’ll show you how the Watch Window works.
Let’s say you have this little table here which shows the name of the individual, the amount that
they owe you, if they’ve made any payments, and the balance due, and they even have some
totals at the bottom and really the big number is this one here, the total balance that’s due to you.
Let’s say that you want to watch that window in case it happens to change. Maybe you share the
file with other people and they might go ahead and post some payments which might change this
balance due while you’re working on another sheet.
All you have to do is select the cell or the range, it could be a range you’re trying to watch, and
then you can go to the Watch Window and you add a watch. And you get to the Watch Window
by going to the tab that says Formulas and way over here you’ll see the Watch Window.
All you have to do is click on Add Watch and if you were already clicked in the cell you want to
watch you don’t really have to do anything but if you weren’t then you would select the range or
cells you’re wanting to watch and hit Add. And you can add as many of these watches as you
like. Notice that you can go in here and you can actually move this around if you need to. It does
tell you the name of the file that you’re watching, the sheet name and the cell and the value.
You’ll notice that if I click over on the Sales sheet at the bottom the watch window stays. So
wherever I happen to be I’m going to see that watch window right there.
Now the watch window is saved when you save the file. However sometimes it doesn’t
automatically appear when you open the file so you would have to navigate back to your
Formulas tab to turn it back on right here. And that’s very handy when you need to keep an eye
on a certain cell or a range of cells.
That’s how the Watch Window works. Let’s go ahead and flip over to section five and talk a
little bit about customizing your Ribbons and your tabs.
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Video: Customizing Ribbons and Tabs
Cindy: We are working in module nineteen and we’re all the way down now to section five,
Customizing Ribbons and Tabs. You have the ability in Excel to add some buttons or some tools
that aren’t on your Ribbon at the top. You can also add tabs so that you can add specific tools or
buttons to those tabs. Let me show you how to customize the Ribbons and tabs in Excel.
We already know we can do a little bit customization with our Quick Access Toolbar right here
at the top. We can drop the arrow down and maybe add some buttons that aren’t there currently.
But let’s go ahead and hit the File tab and go down to the Options here.
At some point you may want to look through all these options and just see what’s available but I
want to go to the Customize Ribbon option right here and tell you what you’re seeing in this
window.
This is a list over here of the popular commands. If they’re on the right that means they’re
currently on a Ribbon or tab in your version of Excel. You have the ability to edit this by maybe
adding some buttons or there might be something you don’t want you can delete it. But let’s say
you’re looking for a particular option and you don’t see it here. Pull this list down and go to All
Commands and that way you’ll see everything.
Let’s say that I’d like to add a button called Hide Columns and I want to add it to my Home tab.
These are in alphabetical order so when you look through these you’ll be able to do quickly to
them. I’m going to go look for Hide. Notice there’s Hide Sheet Rows, there’s Hide Columns
right there.
Excel will not let you add them to an existing group. If I want to put this on my Home tab the
first thing I’m going to have to do is go ahead and create a new group down here. You’ll notice it
now says New Group and I can go in and rename that group whatever I’d like to call it. I’ll just
call it My Group. And you also can pick little pictures and things like this that you’d like to use
as well. I’ll click OK and now it says My Group. I can now take Hide Columns and add that to
My Group. Now I’m going to click OK and you’ll notice I’m on the Home tab and if I go all the
way to the right there’s a new group and it actually has the button called Hide Columns.
Let’s say we want to hide these few columns here. I’ll select them, click the button, and you can
see now that they are gone. And that’s pretty much how you’re going to work with this.
Let me go back into File, back to Options. I want to go back to the Customize Ribbon and let’s
say that you decide you don’t want this group anymore or the Hide Columns. Just select it and
notice at the bottom that you have the option to go ahead and reset. And you can go ahead and
reset all of your customizations or just on the selected tab you’re on. And by doing that you’ll
see now that My Group has gone and when I click OK it is not there anymore. And that’s a quick
way that you can kind of work with customizing your Ribbons and your tabs.
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Let’s go ahead now and we’re going to move over into module twenty and talk about some Excel
shortcuts that you will want to make sure that you know.
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Video: Module 19 – Practice Exercise
Cindy: We just completed module nineteen, Additional Excel Features. There were several
things in here that we discussed that I’d like to make sure you’re okay with, starting with the
Goal Seeker. The file you’re going to open is called Goal Seeker and it looks like this.
And what I’d like you to do is tell me what does the interest rate need to be in order for the
monthly payment to be $350.
Once you’ve figured that out using your new interest rate go and ahead tell me what the principle
would need to be for the monthly payment to be $375.
Once you’ve done that and go down to the Names sheet at the bottom and you’ll see there are
several names here and I’m going to have you go in and just separate these so that the first name
and the last name are in individual columns. Don’t type this. I want you to go ahead and use the
Text to Columns feature to actually do this.
Once you’re finished go back to the sheet Terms of Loan and I want you to create a watch using
the Watch Window for cell F4 so that any time the monthly payment changes you can see that
and you’ll be aware of it.
When you get through just save and close the file and that will wrap up module nineteen. We’ll
go ahead and go to module twenty and talk about shortcuts when you’re done.
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Module 20 – Shortcuts
Video: Excel Shortcuts Every User Should Know
Cindy: Well we’ve gone through all of these different videos and you’ve gotten a lot of different
information and I wanted to give you a list of some of the different shortcuts that I have learned
over the years that will hopefully make life a little bit easier for you as well. I’m going to go
through each one and hopefully when you’re done you’ll be an Excel expert here. Let’s get
started.
Tip number one, creating multiple sheets at the same time.
We had worked with this exercise in one of the previous videos and this is the one where each
division of the company was set up on a different sheet tab. If I click on the first sheet tab,
Australia, you can see that they are tracking each item that they sell and the figures for quarters
one through four and they obviously have some numbers that are just for Australia and then
some totals down in row nine.
What if you have multiple sheets like this that you need to set up at the same time? The reason
you would want to do that is because first of all it would save a lot of time but when you start
creating one sheet and then you copy and paste to another a lot of times in that paste you lose the
column widths and you just lose the ability to make the sheets all look exactly the same. There is
a little trick to help you do this all at the same time.
We’re going to go ahead and create a new file and I want to use four different sheets here so
what I’ll do is initially I’ll go ahead and hit the plus sign at the bottom to create these four new
sheets.
Now what I want to do is select all the sheets at the same time because whatever I type on one of
these will be on all of them. Let me flip back to that file we were just working in and I’ll copy
that information so that I don’t have to type it. I’ll just right click and copy here. Now I’ll flip
back and remember all four sheets are selected. On any of these I’ll just right click and paste and
you can see this is in here now. And if I click Sheet2 it’s there, Sheet3, and Sheet4. Now the only
thing I’d have to do is change whatever is in A1 because each division represents a different
name. And also I’d want to take all of this out. The quick way to do it again is make sure all the
sheets are sheets are selected, then just select those areas that you want to delete, like this, and
now you’ll see they’re all set up and they’re exactly alike.
Another little thing while we have all the sheets selected is these are pretty small. And if I
wanted to zoom in on all the sheets at the same time, again make sure they’re all selected, then
you’re going to go ahead and hit your Zoom at the bottom and when I zoom and go look at the
other sheet tabs they’re all the exact same size. Now I can go ahead on each division and put in
the individual numbers that I need and I didn’t spend hardly any time working on that.
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Tip number two, I want to show you how to quickly turn a range of cells into a table.
As you can see I have what I might call a table right here but in Excel it doesn’t see it as a table
as far as the formatting is concerned. You can quickly turn this into a table. All you have to do is
click anywhere in your range, hold down the Control key, and hit the letter T on your keyboard.
And you’ll notice because you were clicked in your range that the Create Table window pops up
and it already has the absolute value of the range in here. Notice it also says my table has
headers, which it does. I’ll click OK and now you’ll see it’s turned it into an actual table in
Excel. Now all of your table functions are available, you can use your Table Tools contextual tab
at the top, you might change the style of your table. There’s just a lot of different things you can
do here. But again the quick way is Control and the letter T.
Tip number three, select and format an entire sheet.
Let’s say I’m looking at this sheet and I realize that every cell here is size 1. You can see that
right up here. I’d really like everything to be size 14. I could actually select all of these cells that
have data in them and make them size 14 but what I really want to do is set up the whole sheet so
that every cell I type in the text is already size 14. To do that we would need to select the whole
sheet before we change our size.
The quick way to do that is take your mouse and point to the box that’s to the left of column A
and above the one and click. And that will select your whole sheet. Now if I go up and make this
size 14 I have formatted every cell here. That means if I’m in a blank cell anywhere and I type
something there it’s automatically size 14. And you can see that right here. And that’s how you
select and format an entire sheet.
Tip number four, I want to show you how to clear your formats all at once in your spreadsheet.
As you can see in this particular exercise we’ve got some indenting going on, some bold and
italics, we’ve got some colors, some borders. Let’s say that you wanted to take this and just take
all the formatting out. All you’d have to do is select the area that you’d like to remove the
formatting from and on your Home tab if you come all the way over here to your Editing
grouping you’ll see this option here that says Clear. If you Clear All you clear everything. That
would be text, numbers, everything. You would have a blank sheet. So you don’t want that one.
You would want the Clear Formats option. And now you can see it’s back to the original
formatting.
Tip number five is navigating multiple sheets.
Sometimes when you’re working with a file that has a lot of sheets in it you’re going to spend a
lot of time going back and forth by hitting this arrow to find the sheet tab you’d like to go to. A
quick, easy way to see a list of all the sheets, if on these arrows in the bottom left you right click
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you’ll see a list of all of your sheet tabs. If I know I want to go to Sheet14 I choose it from here
and click OK and that’s a quick way to navigate through your sheet tabs.
Tip number six, quick way to print.
Let’s say that I’m finished working in my workbook and I’d like to print this. Normally you
would take your mouse and go up to File and you’d come down to Print and go through all of
this and that’s fine, but if you know that all of that’s fine and you just want to print it do what’s
called a Quick Print. Just hold down Control on your keyboard and hit the letter P for Print and
that’ll take you right to this Print window and you can actually hit Print right here.
Tip number seven is the Quick Analysis Tool.
Let’s say that I want to create a chart out of some of this data. I’ll go ahead and select from A5
through E9.
Now we learned in a previous module that we could hit F11 to create a chart. We could also go
up to our tabs at the top and insert an embedded chart, but what a lot of people don’t see is when
you have a range selected this little box on the bottom right of your selection there called the
Quick Analysis Tool. And what this one does is let’s you quickly analyze some of your data.
You’re going to be able to add some formulas right from here if you want to add some stuff. You
might be able to create a chart right from here, do some color coding. Let me click on that and
show you what your options are.
I’ve got several tabs in here I can look at. The first one is Formatting. You can go in and create
some conditional formatting options. If you go to the Chart option here’s where you could put in
a chart. Let’s say I put in this first one, the Cluster Chart. See how much easier that was? And it
was right there. All I had to do was click on the Analysis Tool to get to that.
Now let’s say I’m going to delete that. Let’s say that I didn’t have these quarterly totals here at
the bottom like this. I’ll just delete them. But I’d like to get those totals. We know that we could
go ahead and write a formula and then copy it across but let’s say that I’ve selected all of these
numbers like this. There’s my Quick Analysis Tool. Notice that I have the option here that says
Totals. And if I choose the Sum all I have to do click on it and there’s the sum of each one of
these columns. Much easier than going ahead and writing a formula by hand.
A couple of other options you have there just to mention them, is you can put in a table from
here. You can also create what we call Sparkline. That’s how your Quick Analysis Tool actually
works.
Tip number eight, send email from Excel.
This next tip only works if you’re using Outlook for your email.
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Let’s say that you wanted to email this file to someone. Normally what you would do is you
would save this file, you would close it, you would go over to Outlook, open it up, create a
message, attach a file. There’s like six, seven, eight steps there. The easiest way to do it is do it
right from within your file. All you have to do is go up here to your Quick Launch Toolbar and
you should see an Email button. If you don’t see it click the down arrow and then choose Email
from the list and then you’ll see it appear right here. If you choose that it’s going to open
Outlook for you and it’s going to have the file already attached. All you’d have to do now is
address it, put your message in and send this on. A great little tip and this works from inside any
of the Microsoft Office products.
Tip number nine is a quick way to save a file.
A real quick shortcut if you want to save your file, just hold down Control and hit the letter S on
your keyboard and that’s your Save option. That keeps you from having to go up to a Save
button here or from going to File, Save or Save As this way. Control-S will save your file.
Tip number ten is Hyperlinks.
Let’s say that you’re giving a presentation and what you’d like to do is when you’re finished
talking about this particular file you’d like to link over to another file. Well instead of telling
your audience to wait a few minutes while you go up to File and you go to Open and you
navigate all you have to do is create a link and you can link from an object you have here
somewhere or if you had a particular cell you wanted to link.
All you have to do is right click on that cell or object, choose the Link option, and here is where
you would insert a Hyperlink.
All you’d have to do is find the exiting file that you’d like to link to, we’ll say it’s Chocolate
Sales, click OK, and now you can see that this is blue and that’s a hyperlink. When I’m ready to
go to Chocolate Sales I’ll just click there and it’ll open that file for me.
The other thing you can do if you want to link somewhere is you can link to a website.
Let’s say that I choose in this case G11 and that’s where I want to create this link. I’ll just right
click and choose Link again. This time instead of choosing a file I’ll come down here where it
says Address and I’ll choose a particular website. We’ll just say Google in this case and we’ll go
ahead and click OK and it’s going to link me to Google when I actually click there.
That’s really all there is to the links.
Those are ten really great tricks that will help you out when you’re working in Excel. Let’s go
ahead and go over to the conclusion and we will wrap up these Microsoft Excel videos.
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Module 20 – Closing
Video: Closing Video
Cindy: Well we’ve completed all of the videos required for this Microsoft Excel 2019 course. I
wanted to take a few moments and just tell you how much I really appreciated spending time
with you. I also wanted to make sure that you understand everything that we’ve covered. So feel
free to go back through all the videos as many times as you need.
As always if you have questions on anything or have any comments we’d love to hear them.
Please feel free to email us at any time and we’ll get right back to you.
Again, thank you so much and I will see you in a future set of videos.

© Copyright 2008-2020 Simon Sez IT, INC.. All Rights Reserved.

